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_ALL THE WEATHER YOU NEED TO KNOW FOR... 

VACATIONS FARMING COMMODITIES SPORTS EVENTS FLYING 
BUSINESS TRIPS GARDENING INDUSTRY OUTDOOR CONCERTS CONSTRUCTION 

PICNICS SAILING TEACHING INSURANCE UTILITIES 

-~ Now, you can log on to the 
~~world’s largest on-line 
weather service— 

eres se by network TV stations, radio 
forecasters and major U.S. newspapers. 
The Accu-Weather Forecaster’ includes 
a customized account name and password. 

ACCU-WEATHER IS... 

POWERFUL 
Access all the information the weather 

pros utilize displayed exactly as they use 
_jt or in our “Home Use” mode for easier 

viewing. Hourly weather conditions from 
thousands of locations around the world. 
All official forecasts, warnings, watches, 
and advisories and live lightning strikes, 
satellite pictures and radar displays. Plus 
over 25,000 other products, off-line 
analysis mapping and graphic of data. 

FUN 
Get a forecast from the pros or create 
your own! Watch storms as they move 
across the country toward you. Create 
your own customized Color Contour Maps. 
Choose the weather stations you would 
‘like to view and select temperature, baro- 
metric pressure, visibility, or any one of a 
dozen different data types. You may also 
zoom in on your maps and zoom out 
again—ALL-OFF-LINE! 
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THE SOFTWARE TOOLWORKS 

60 Leveroni Ct. « Novato CA 94949 © 
(415) 883-3000 FAX (415) 883-3303 

u-Weather®...the weather = 

EASY 
Fully automated telecommunications and 

access. Menus let you select the informa- 
tion you want, then sit back and watch 
the information roll in. Use Graph View to 
analyze data with ease, as you plot dew 
point versus time over the last 24 hours 
and overlay a plot of cloud base on the 
same graph. 

EXCITING 
See the location of lightning strikes even 
before you hear the thunder! Access dam- 
age reports from tornadoes, hail, severe 
thunderstorms exactly as reported by 

Actual unretouched screen shots 

police and other emergency response 
agencies. Get the inside scoop on 
National Weather Service internal 
discussions! 

INFORMATIVE 
What does it look like out the window? 
Let the Accu-Weather Forecaster show 
you with the Picture View. Where are the 
hottest and coldest places right now? 
Find out with List View. Sort the weather 
stations from highest to lowest pressures, 
from windiest to dead calm, or by any 
other data type. 

FANTASTIC GRAPHICS 
Full color graphics in rich detail, sophisti- 
cated graphs and charts, and Accu- 
Weather’s proprietary high resolution 

Advanced Map Plotting System™ 
(AMPS™ give you unlimited display 
capabilities). 

INEXPENSIVE 
You predefine your request; get the data 
and graphics, then disconnect-—all further 
graphic display and analysis is done with 
no additional connect time. And Accu- 
Weather provides discount rates to users 
of this software. 

Copyright © 1990 Metacomet Software, Inc. Copyright © 1990 The Software Toolworks, Inc. All rights reserved. Accu-Weather 

is a registered trademark: Accu-Weather Forecaster and Advanced Map Plotting System are trademarks of 

Accu-Weather Inc. 
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| Technical Support 

For technical support with the 
Accu-Weather Forecaster: 

Software Toolworks, Inc. 
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(415) 883-3000 

For technical support with the 
Accu-Data weather database: 
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THE SOFTWARE TOOLWORKS LICENSE AGREEMENT 

This is a legal agreement between you, the end user, and The Software Toolworks, Inc. ("Toolworks"). BY OPENING THE 

SEALED DISK PACKAGE CONTAINING THE DISK(S), YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS 

AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, PROMPTLY RETURN THE UNOPENED 

ENVELOPE WHICH CONTAINS THE DISK(S), DOCUMENTATION, PACKAGING AND ALL OTHER ITEMS INCLUDED WITH 

THE SOFTWARE ("TOOLWORKS PACKAGE") TO THE TOOLWORKS AT THE ADDRESS INDICATED BELOW. ; 

TECHNICAL SUPPORT. If you are having any problems with the Toolworks Package, or if you have any questions 

concerning this agreement, contact the Software Toolworks’ Sales and Service at 60 Leveroni Court, Novato, CA 94949, or 

call (415) 883-3000. : 

THE TOOLWORKS SOFTWARE LICENSE 

1. GRANT OF LICENSE. Toolworks and its suppliers grant to you the right to use one copy of the software program 

("Program") which is included with the Toolworks Package. You may not network the Program or otherwise use it on more 

than one computer or computer terminal at the same time. 

2. COPYRIGHT. The Program included with the Toolworks Package is owned by the Toolworks or its suppliers as set forth 

in the Program or associated documentation and is protected by United States copyright laws and international treaty 

provisions. You may not copy the Program except as provided in this Agreement. You must treat the Program like any 

other copyrighted material (e.g. a book or musical recording) except that you may either (a) make one copy of the floppy 

disks, if any, on which the Program is recorded solely for backup or archival purposes, or (b) transfer the Program on floppy 

disk to a single hard disk, provided that you keep the original floppy disk solely for backup or archival purposes. You may 

not copy the written materials accompanying the Program. 

3. OTHER RESTRICTIONS. You may not rent or lease the Program, but you may transfer the complete Toolworks Package 

on a permanent basis, provided that you retain no copies and the recipient agrees in writing to the terms of this Agreement. 

You may not reverse engineer, decompile or disassemble the Program. 

4, DUAL MEDIA SOFTWARE. If the Software Package contains both 3 1/2" and 5 1/4" disks, then you may use on the disks 

appropriate for your single-user computer. You may not use the other disks on another computer or loan, rent, lease, or 

transfer them to another user except as part of the permanent transfer (as provided above) of the entire Toolworks Package. 

5. YOU MAY NOT USE, COPY, MODIFY, OR TRANSFER THE PROGRAM OR ANY COPY IN WHOLE ORIN PART, EXCEPT 

AS EXPRESSLY PROVIDED IN THIS LICENSE. ALL RIGHTS NOT EXPRESSLY GRANTED ARE RESERVED BY THE 

TOOLWORKS OR ITS SUPPLIERS. 
LIMITED WARRANTY «: 

LIMITED WARRANTY. The Toolworks warrants that with respect to the Program contained in the Toolworks Package, the 

media upon which the Program is recorded shall be free from defects and workmanship under normal use and service for 

a period of thirty (30) days from the date of purchase. Any implied warranties on any Program is limited to thirty (30) days. 

Some states do not allow limitations on duration of an implied warranty, so the above limitation may not apply to you. 

CUSTOMER REMEDIES. Toolworks’ entire liability and your exclusive remedy shall be, at Toolworks’ option, either (a) the 

repair or replacement of the specific Program and diskette that does not meet Toolworks’ Limited Warranty and which is 

returned to the Toolworks with a copy of your receipt; or (b) a refund of the price, if any, which you paid for the individual 

Program and diskette. This Limited Warranty is void if failure of the Program has resulted from accident, abuse, or 

misapplication. Any replacement Program will be warranted for the remainder of the original warranty period or thirty (30) 

days, whichever is longer. : 

. R WARRANTIES. WITH RESPECT TO THE PROGRAM AND THE ACCOMPANYING WRITTEN MATERIALS, THE 

TOOLWORKS, METACOMET SOFTWARE INC. ("METACOMET") AND ACCU-WEATHER, INC. ("ACCU-WEATHER’) DIS- 

CLAIM ALL WARRANTIES, OTHER THAN THE ABOVE WARRANTY BY THE TOOLWORKS, EITHER EXPRESS OR IMPLIED, 



INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. THE SOFTWARE TOOLWORKS, METACOMET AND ACCU-WEATHER MAKE NO EXPRESS OR IMPLIED 
WARRANTIES, GUARANTIES OR AFFIRMATIONS THAT WEATHER WILL OCCUR OR HAS OCCURRED AS THE REPORTS, 
FORECASTS, GRAPHICS, DATA OR INFORMATION ACCESSED AND/OR DISPLAYED BY THIS PROGRAM REPRESENT 
OR DEPICT AND THEY SHALL HAVE NO RESPONSIBILITY OR LIABILITY WHATSOEVER TO USERS OF THIS PROGRAM 
OR TO ANY OTHER PERSON OR ENTITY, PARTIES AND NON-PARTIES ALIKE, FOR ANY INCONSISTENCY, INACCURACY 
OR OMISSION FOR WEATHER OR EVENTS PREDICTED OR DEPICTED, REPORTED, OCCURRING OR OCCURRED. THIS 
LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHERS, WHICH VARY FROM STATE TO 
STATE. : , : 7 : 

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. IN NO EVENT SHALL THE TOOLWORKS OR THE PUBLISHER OR 
OWNER OF THE PROGRAM BE LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, 
DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION, LOSS OF INFORMATION, OR OTHER PECUNIARY LOSS) 
ARISING OUT OF THE USE OF OR INABILITY TO USE THE PROGRAM, EVEN IF THE TOOLWORKS, METACOMET OR 
ACCU-WEATHER HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT 
ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE 
LIMITATION MAY NOT APPLY TO YOU. ) | 

U.S. GOVERNMENT RESTRICTED RIGHTS | oe 
The Program and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the 
Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer 
Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software Restricted 
Rights at 48 CFR 52.227-19, as applicable. The Contractor/manufacturer is The Software Toolworks, Inc., 60 Leveroni Court, 
Novato, CA94949. ; 3 are : 3 : | 

This Agreement is governed by the laws of the State of California. | 

COPYRIGHT NOTICE | | ; ; 
Copyright c 1988-1990 Metacomet Software, Inc. 
Copyright c 1990 The Software Toolworks, Inc. 
All rights reserved. | | 

TRADEMARKS = — | | | | enh Accu-Weather is a registered trademark and Accu-Weather Forecaster, Advanced Map Plotting System, Accu-Weather Said 
it Would and Accu-Data are trademarks of Accu-Weather, Inc. _ oe , : : 
Apple and Apple Macintosh are registered trademarks and ImageWriter and LaserWriter are trademarks of Apple Computer, 
Inc. : : 3 ; : | 
Hayes is a registered trademark of Hayes Microcomputer Products, Inc. Bee | : 
IBM, PC-DOS, PC/XT are registered trademarks and PC/AT and ProWriter are trademarks of International Business Machines 
Corporation. as : : : abe : hice | . 
Microsoft and MS-DOS are registered trademarks of Microsoft Corporation. 
Okidata is a registered trademark of Oki America, Inc. 
Diconix is a trademark of Eastman Kodak Company. , 7] : 
Epson is a registered trademark and FX, MX and LX are trademarks of Epson, Inc. | 
Hewlett-Packard is a registered trademark and Laserjet Plus and Laserjet Series Il are trademarks of Hewlett-Packard 
Corporation. eee : is oe Sap a 4 
Lattice is a registered trademark of Lattice. Inc. - 

THE TRADEMARKS OF ACCU-WEATHER, INC. AND THE ACCU-WEATHER NAME SHALL NOT BE USED BY PURCHASERS 
OR USERS OF THE SOFTWARE IN ANY WAY, ESPECIALLY NOT AS A MEANS OF IDENTIFYING THE SOURCE OF THE 
UNDERLYING DATA SERVICE TO PUBLIC AUDIENCES OR CLIENTELE, AS THESE ARE THE SOLE AND EXCLUSIVE 
PROPERTY OF ACCU-WEATHER, INC. — ° : . 
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GETTING STARTED 



Introduction 

Samuel Clemens once made this weather prediction: 

“Probably nor’east to sou’west winds, varying to the southard and westard 
and eastard and points between; high and low barometer, sweeping round 
from place to place; probable areas at rain, snow, hail, and drought, 

succeeded or preceded by earthquakes with thunder and lightning. ” 

With the Accu-Weather Forecaster, you can receive — and make — weather 
forecasts a little more specific than that, although we have to admit that Sam 
Clemens probably was right. Through a direct connection to Accu- : 
Weather®, Inc., the largest private weather forecasting and data service in 
the U. S., the Accu-Weather Forecaster gives you access to current weather | 
information from any or all of the hundreds of National Weather Service 
stations across the country. 

With the Accu-Weather Forecaster, you can: 

¢ See weather conditions virtually as they happen anywhere i in the 
country 

e Automatically create your own weather maps | 
¢ Get up-to-the-minute forecasts and reports of weather conditions and 

changes 

e Watch storms, fronts, and weather systems develop and move 
e And more! 

The Accu-Weather Forecaster delivers far more weather information than 
you can get from radio, TV, telephone, or newspaper forecasts and reports, 
and you can have the information when — and from where — you want it. 

To get started with the Accu-Weather Forecaster, check the equipment 
requirements and follow the installation instructions on the next few 
pages. Once you have the program installed and running, section 2 of this 
manual (Using the Accu-Weather Forecaster) will help you learn the basic 
operation of the program. 



| oe Requirements 

a) Macintosh Plus, SE, SE30, or Macintosh II series computer with at least: 

e 1 megabyte of memory 

e 2 800K floppy disk drives or 1 anda hard disk 

b) modem 
¢ 300, 1200, or 2400 baud, Hayes compatible 

c) printer (optional): 
¢ ImageWriter or ImageWriter II 

e LaserWriter, LaserWriter Plus, LaserWriter II series or 

Personal LaserWriter 

d) System and Finder 

e System 6.0.4 (6.0.5 for Macintosh Portable) or later 

Apple’s latest System Software Package is available from your 

Apple Dealer. 



To install Accu-Weather to your Macintosh hard drive, make a new folder 
on your hard drive and drag all of the files from the original program disk 
into that folder. For more information on copying files, see your Macintosh 
manual. 

The package includes a second disk that has sample TV graphics images 
in two folders labeled “Sample Color Images” and “Sample B & W 
Images”. Depending on which type of machine you have, open the 
appropriate folder and drag all of the files from that source folder into the 
folder on your hard disk that has the program files. (Be sure you drag the 
individual files, not the file folder itself). 

If you do not have a hard drive, you can run the program directly from a 
copy of the original program floppy disk. However, you will not have much 
space on your floppy disk for additional data and images. You may want to 
remove the sample images (file names ending in “TV1” or “TV2”) to make 
additional space for new data. 



Setting Up the Program with Your Information 

In order for the Accu-Weather Forecaster to operate correctly for your 
particular situation, you need to enter and save some specific information 
about your location, your computer, and your telecommunications setup. 

This process is called Setup. 

Station Info 

Station Setup 

Nearest Station: BDL | 

| Text Forecast Station: 

Chart Forecast Station: [BDL | 

Time Zone: Daylight Savings: 

@) Eastern @® Yes 
© Central © No 
© Mountain 

© Pacific 
3 — 

| Cancel | ee Se 
eee 

Station Info refers to information about your home location (the above 
example is for someone who lives in central Connecticut). 

1. Nearest NWS stn — Refer to the National Weather Service Stations List 
in the Appendix to find the NWS station nearest you, and then enter the 

3-letter station code. Some stations operate 24 hours per day, while others 
report only during the daytime. You may have to choose between a 
nearby station that only reports during the daytime, and a more distant 

station that reports 24 hours day. 
2. Text Forecast Station — Not every station provides text forecasts. Refer 

to the National Weather Service Stations List (in the Appendix) to find 
the text forecast station nearest you. It may not be the same as the 

Nearest NWS Station. 



3. Chart Forecast Station — Not every station provides chart forecasts. 
Refer to the National Weather Service Stations List (in the Appendix) to 
find the chart forecast station nearest you. It may not be the same as the 
Nearest NWS Station or the Text Forecast Station. 

4, Time Zone — Select your time zone by clicking on the appropriate radio 
button. The time that appears in the Display Identifier is always your 
own local time. 

5. Daylight Savings Time — Clicking on the Yes button indicates that 
3 daylight savings time is used in your area. The program will 

automatically determine which days use daylight savings time, so just 
set this to “yes” if you ever use daylight savings time, regardless of 
whether you are currently in the daylight savings time of year. 

Telecom Info 

Telecom Setup 

Modem Type: @Hayes ODdther 

Baud Rate: © 300 @® 1200 © 2400 

ec) 

Modem Port: © ‘@) 

Phone Type: @® Tone © Rotary 

Auto-Send Password: © Yes er No 

Cancel 3%. 

Telecom Info refers to the type of telephone and Soden, you have, and some 
details about your Accu-Weather account. 



. Account name — The account name comes with your copy of Accu- 

Weather Forecaster. Consult the Accu-Weather Forecaster 
Subscription Procedures insert for more information. 

Password — For security reasons, the actual password will not appear 

in the dialog box after the first time you type it in; it will be represented 

by dots: “eeeee”, Your password will also not appear on the screen 

_ when logging on the Accu-Weather’s computer. oanciriae 

_ Phone #— This refers to Accu-Weather’s telephone number. This © 

number is provided by Accu-Weather and is listed on the Accu-Weather 

Forecaster Subscription Procedures insert. 

‘Some phones require extra digits or pauses in the dialing process. These 

can be included as follows: : 

e Extra digits: If, for example, you have to dial “9” to get an outside 

line, simply put a 9 at the beginning of the number when you enter it. 

e Pause: If your phone needs a pause in the dialing process, insert a 

comma at the point where the pause is required. 

Modem Type — Hayes modems (or 100% compatibles) are the only 

acceptable modems. The Apple Personal Modem is a Hayes-compatible 

modem. : : 

Baud Rate — Select 300, 1200 or 2400 depending on the speed of your 

modem. If you do not know which it is, please refer to your modem’s 

manual. | 

Modem Port — The modem can be connected to the “Modem Port” or the 

_ “Printer Port.” These are on the back of your Mac, and have icons to 

identify which is which. The modem is normally connected to the 

modem port. | 

Phone Type — Your telephone line is either touch-tone or rotary (pulse). 

If you do not know which type your line is, listen as you dial. If you hear 

“clicks”, you have a rotary phone. If you hear “beeps”, your phone is 

touch-tone. 
_Auto-Send Password — Set this to “Yes” to have the program 

automatically remember your password and send it to Accu-Weather 

during the log-on process. If you select “No”, the program will ask you 

for the password before attempting to connect with Accu-Weather. This . 

feature enables you to protect your account from unauthorized access 

when other people might be using your computer. 
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Easy Guided ' Tour 

Follow these step-by-step instructions to get an introduction to the 
capabilities of the Accu-Weather Forecaster. 

2 

Lesson 1 - Demo Data 

10 

© 

Once you've started the program, you first see the Software Toolworks, Inc, 
logo, and then the following screen: : 

Accu-Weather® Forecaster™ 
Version 2.0 

+ eat Fie Seat Sees peas ee ; a Ta a ee Some Came 4 000 @ovve 

Poe ge oe oe Rest Seowee Ses sordiocedeondesedosedecnmace easheocn dese cet restr esen eran Bae iia F sera ase aaa He ee Oa oer eat ae ae eet Reve 3 cae ee Sarl —~ ae aa} Ee eee oe fee ie sock ne fee mee aU gp Sb Se io 

.. Blizzard warning tonight... 

An intense low pressure system, c]| 
York, continued to bring heavy: sh 
western New York, Pennsylvania an 

The snow, however, was tapering o 

Pictures Forecasts. e 
©1988-90 by Metacomet Software, inc. 

Portions © by Software Toolworks, Inc. & © Accu-Weather, Inc. 
®Accu-Weather is a registered trademark of Accu-Weather, !n- 

Startup screen 

Notice that most of the choices on the menu bar are dimmed; you can’t select 
them (yet). The first choice you must make is indicated by the two buttons 
near the bottom of the screen: Use Real Data and Use Demo Data. Position 
the cursor on Use Demo Data and click the mouse button. This tells the _ 
Accu-Weather Forecaster what kind of information to use for this session. | 
Once you make your choice, most of the items on the menu bar become 
available. 



About the demo data: 

As explained in the Demo Data section of this manual, you have been 

transported in time to 9:15 p.m., on January 22, 1990. A major snow storm is 

attacking the Northeast. You will study the weather conditions from the 

perspective of someone living in central Connecticut. 

The data available on the Demo Data disk includes: 

¢ past 24 hours of data for Windsor Locks, Conn. 

¢ 8:50 p.m. data for all stations within 250 miles 

¢ 8:50 p.m. data for 100 major US stations 

Everything is now as it was then, except. . . you are there. 

11 



Lesson 2 - Graphs 

Pull down the Display menu and select Graph. A siti will appear on the 
screen: 

STATION: Vindsor 1 Locks, Conn *DEMD* INFO: lebpeaaties (deg F) 
DATE: Mon Jan 22, 1990 *DATA* TIME: ell 

t ! 
: consented neween oe} soveeces Severe oe] 

—— 3 codnes cof ons eeeees eoneed ae se rane re ae 

ae me BS eee 29 OSS Fw Moe CO 

conoetos 90 cod coness one: 

- 2 sp slsnicds 

a r ee arena wisesecbicrseere site seca eye 

eat ape cl eet cae ae was oe eos el a ee 
i 3 j H 

P.M. ( Graph Overla 

Graph of temperature in Windsor Locks, Conn. on January 22, 1990 

Display identifier: | : 

What does this graph show? Look for the part of the display that looks like 
this: 

STATION: Windsor Locks, Conn *Demo* INFO: Temperature (deg F) 
DATE: Mon Jan 22, 1990. | *DATA* TIME: all 

This is the Display Identifier. It tells you four things: 

Station: Windsor Locks, Connecticut 
Info: Temperature 
Date: January 22, 1990 
Time: all times Pe 



So, this graph shows “Temperature in Windsor Locks, Connecticut, for all 

times on January 22, 1990.” Notice that the temperature rises from a low of 

15 degrees to a high of 32. The temperature scale appears on the left edge of 

the graph. The times appear at the bottom of the graph. 

National Weather Service: 

‘Why Windsor Locks, Connecticut? Windsor Locks is a National Weather 

Service (NWS) weather reporting station. There are about 1,000 NWS 

stations throughout the nation. Every hour they take a standard set of 

weather observations. The data from these observations is collected by the 

National Weather Service, and then disseminated (virtually 

instantaneously) to weather forecasters all over the country. The Accu- 

Weather Forecaster uses these data for almost all of its displays. For our 

demo situation, Windsor Locks, Connecticut is the nearest NWS station. 

Change info: 

Now let’s look at a graph of barometric pressure. Pull down the Select menu 

and position the cursor on Info. Immediately you see a larger menu: 

Select 

Info 

Stations 

Dates > 

Times > 

Barom. Pressure 31 

“Temperature 32 

Dew Point — 363 

Wind Direction 34 

Wind Speed 5 

Wind Gust 366 

Visibility 387 

Precipitation 368 

Cloud Base ab 

Cloud Amount #0 

Fog 36 

Now select Barom. Pressure. Why barometric pressure? Technically — 

speaking, barometric pressure represents the weight of the air above a 
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partinuldr location. As you use this program oo — a few lessons 
about weather forecasting, so here is: 

Simplified Weather Lesson #1: 

“Low pressure corresponds to storm systems, high pressure corresponds to 
nice clear skies.” Looking now at the graph, what is happening to the 
barometric pressure? It’s falling; in fact it’s falling dramatically. A storm 
system is probably approaching. 

Precipitation: 

Now select Precipitation as the type of information. Notice that light snow 
started at noon, and the snowfall became more intense over the next few 
hours. A few hinte about precipitation information: 

1. N stands for no precipitation; S stands for snow; other precipitation 
codes are listed at the top of the screen. 

2. the heavier the precipitation, the higher the position of the code letter 
on the graph. 

Other Graph Stuff: 

Later on you'll learn about overlay graphs, which enable you to see two or 
three types of information on the same graph, but now let’s move to another 
type of display. 



Lesson 3 - Maps 

Pull down the Display menu and position the cursor on Maps. The 

following submenu will appear. You'll see three choices: Values Map, 

Shaded Contours, and Color Contours (if your Macintosh can only display 

black and white, Color Contours will be dimmed and unavailable). 

Display 

Graph 3G 
000 000 000000 000 000 00009000000000000 000000 000 000008 000000 000009 

Maps ® Values Map 3M 
sci siieleaieat caucus a oes Shaded Contours 385 

Picture #P| Color Contours 36K 

10 000 080 900 000 09900000000800000000000 000 000 000000090 988000 

List 36L 
120 ©00 000 020080 00800000 000000000800000 000000000000 000000000 

Forecast > 

TU Graphics 

The first thing you need to do is to select the way information will be 

displayed on your map, so select Values Map from the menu. 

Default values: 

To make life easy for you, each display begins with a certain type of 

information as a default. In the case of the surface map display, the default 

is temperature. This shows you the most recent temperature data for 100 

major stations throughout the nation. Other types of information are 

available by pulling down the Select menu and selecting Info. 
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one Poracastor SS 

STATION: USA--Major stns *DEMO* INFO: temperature (deg F) 
DATE: Mon Jan 22, 1990 *DATA* TIME: 8:50 PU EST 

| Map of temperature at 100 major stations throughout the US, 
on January 22, 1990, at 8:50 p.m. 

Each number on the map is a temperature reading. Try to find the lowest 
value (hint: it’s in the Northern Midwest). We’d ask you to find the highest 
value also, but we don’t want you to go blind, and there’s an easier way to 
study all those values. 



Contours: 

You are about to see one of the most powerful features of this program. 

Simply pull down the Display menu, position the cursor on Maps, select 

Shaded Contours from the submenu, and watch what happens: 

STATION: USA--Major stns *DEMO* INFO: temperature (deg F) 

DATE: Mon Jan 22, 1990 *DATA* TINE: 8:50 Pi EST 

(] -20--11 0-9 20-29 fii 40-49 fg 60-69 

(J -10--1 10-19 Bso-39 50-59 

TH 445444 HHH HH 4147 

ARR t AHH HHH 

Contour map of temperature, showing highest and lowest values 

All those numbers are now much easier to understand. Similar values are 

indicated by the contour lines. The highest value (61°F, in Miami) is the 

center of the warmest area (probably nice weather there). The low 

temperature center is in International Falls, Minnesota, where it’s -20°F 

(probably a lot of chills there). Any type of information can be displayed on 

a contour map, giving you a very visual way to examine weather patterns. 

Both Values and Contours: 

If you display a Contour Map, you can see the actual values displayed over 

the contours. Just click the Add Values button in the upper right corner of the 

window. Try mapping some other information. Choose Info from the Select 

menu, and then select temperature. The map now shows temperatures 

around the nation. After you’ve examined the temperature map, try some 

other types of information. 3 | 
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Change Station: 

Are you ready to zoom in for a closer look at the Northeast? Pull down the 
Select menu and position the cursor on Stations. This enables you to choose 
a different set of stations to be displayed. You now see: 

SOhiiitweee s Nearest Station 3 
Dates >| City... 
Times >| Station Code... 

© 0902080080000000000000000000000000000000 000000000000 0000 00000000000000000 

N 

USA-Majors §_%A 
Range... 36R 

Map... : 

Cities... 

States... 

Station Codes... 

Select Range: 

Range is a very easy station selection procedure to use. “Range” means 
select all stations within a range of miles from your home base. Enter “250” 
in the text box, and click OK. This means that you want all stations within 
250 miles of Windsor Locks, Conn. (your pretend home base). The new map 
that you see gives you a close-up view of the Northeast. 



HESS eS SS Forecaster BSR SE Be een aS ee I oS SE a 

‘| STATION: Map area selected . *DEMD* INFO: temperature (deg F) 
DATE: ton Jan 22, 1990 | *DATAS TIME: 8:50 PU EST 

Map of temperatures in the Northeast 

~ Of interest here is the fact that some stations are below freezing and some 

are above. 



Lesson 4 - Pictures 

Now it’s time to look out the window and see what the weather is like. Select 
Picture from the Display menu. 

~orecester 

STATION: Windsor Locks, Conn *DEMD* INFO: ell 
DATE: Mon Jen 22, 1990 *DATA® TINE: 8:50 Pa ESP 

a EERE EERE EERE EERE 

ii 
i t 

ig 

EE 
PELE 
EE 

: 
TET 
i 

Fog: Fog is present 

Picture view for Windsor Locks, Conn, on January 22, 1990, at 8:50 p.m. 

The Picture format is like a “snapshot” of a single moment in time at a 
single location. In this case, the Display Identifier tells us s that we are in — 
Windsor Locks, Conn., on January 22, 1990 at 8:50 p.m. 

“Window View”: 

The left side of the display is a en asigal, This is a window (the kind 
in a house, not a Macintosh window). Looking outside, we see clouds, snow, 
and a tree bending moderately in the wind. 

Wind Direction: 

The compass at the lower right shows that the wind is blowing from the 
northeast. (Notice that the wind blows from the tail to the head of the arrow). 



Weather Descriptions: 

To the left of the compass are five lines of text. They tell us: 

Clouds are “overcast” (100% cloud cover) 

Precipitation is ight snow 
Wind is blowing from NE at 16 mph 
Visibility is 2 miles 
Fog is present A ee ee 

Column instruments: 

In the upper right corner of the display are three column instruments. The 

first is a thermometer, indicating that the temperature is 33 degrees. The 

next instrument gives the dew point (a measure of humidity) as 31 degrees. 

The third instrument is a barometer, showing the barometric pressure to be 

: 28.85 inches. 

Change Times: 

Let’s see what it was like one hour ago. Pull down the Select menu and 

position the cursor on Times. You now see this menu: 

Select 

Stations > 
Dates » 
Times [= Most Recent 

Select Hour... 

Previous Hour %, 

Next Hour 

All Times 
Range... — 

Prev Hour: 

Select Previous Hour. It should be no surprise that the time is now 7:50 p.m. 

(one hour earlier). Among the minor differences are lower clouds, colder 

yA 



temperature ad lower visibility. Try Previous Hour a ior more times and 
notice the differences. 

Most Recent: 

To get back to the most recent time available cheats aelect Most Recent. 
Notice that you have returned to 8:50 p.m. 

Change Stations: 

Now let’s do some traveling, and find out what the weather is like in a few 
_ other locations. Pull down the Select menu and position the cursor on 
Stations. You now see this menu: 

) 
Nearest Station 3N/ Stations > 

Dates >| City... 
Times » Station Code... 

USA- Majors 988A 
Range... 36R 
Map... e 

Cities... 
States... 3 
Station Codes... 

- City name: 

First, let’s go to Boston, Mass. Select Cities. You see a list of all the sates 
(except flasha and Hawaii). Click on Massachusetts to select it, then click 
on OK. | 

You now see a list of all NWS stations in Massachusetts. Select Boston and 
click OK. Now the picture shows the weather in Boston, Mass. Notice that the 
weather is similar to Windsor Locks, Conn. except that the wind is stronger 
Ceuating to 43 mph). Try a few other locations. 



: Some Stations Aren’t Included i in nailic Demo Data: 

The demo data includes data from only about 200 stations. If you soles a 

station not included in that list, the program will ask you toselecta 

different station. 



Lesson 5 - Forecasts 

| If you review the actual weather information displayed during the previous 
“lessons”, you might be able to make a general forecast of your own for our | 
imagined home in central Connecticut. Because we are still in the grip of 
the intense low pressure area, we should expect precipitation to continue for 
a while longer. 

Simplified Weather Lesson #2: 

Weather generally travels from west to east, taking about 4 days to travel 
_ from the west coast to the east coast. bans 

Our national map showed us that precipitation covered a 1 broad. area nie 
around us. Therefore, we should expect the snow to continue overnight, 
probably stop sometime tomorrow, and then be followed by gradually 
clearing weather. The contour tedipenabure map showed that cold air would © 
be moving in behind the storm, so we would expect cooler temperatures. — 

Well, let’s see what the professionals say. Pull down the Display menu and 
position the cursor on Forecast and then select Station-Text (Another way to 
make this selection is to hold down the Command key and press “F”). | 

Pt EST THU JAN 22 1990 

- BLIZZARD WARNING TONIGHT. . 

. TONIGHT. ..BLIZZARD CONDITIONS WITH op intl FALLING ed BLOWING SNOW. 
FTING. LOW 20 TO 

Forecast for Windsor Locks, Connecticut 



As a matter of fact, they forecast a major snowfall (no surprise given all the 

snow that has fallen during the day and continues to fall all around us). 

They also forecast gradual clearing and colder temperatures. i, 

This forecast was prepared by the professionals of the National Weather 

Service. They used the same data that we have been looking at, but they also 

have access to a few more sophisticated tools, such as upper air data, satellite 

photos, radar information and much more. And they have professional 

training in meteorology. 

You can make your own forecasts simply by examining the data or you can 

refer to the professional forecasts that are available (when you learn how to 

get real data) from hundreds of stations all over the country. 



—— 6- TV and AMPS Graphies 

TV Graphics and AMPS graphics are ‘he fagheels sebaaee graphics | 
available in the Accu-Weather Forecaster. TV Graphics includes a number 
of types of images, from actual satellite color photographs to manually 
illustrated maps. AMPS stands for Advanced Map Plotting System, and 
includes both maps and graphs of surface, upper air, and computer- | 

generated forecasting information. TV Graphics images include many of 
the same images you see in televised weather forecasts — and many more 
striking images that you don’t get to see otherwise! 

Unlike the other displays available - in the Anca: Wenther Forecaster, TV _ : 
Graphics and AMPS graphics are not generated by your mene they're : 
simply downloaded “as-is” from Accu- Data. : 



“Tv Graphics _ 

Pull down the Display menu and position the cursor on TV Graphics, then 

select Chart 1 - Surf/Rad/Sat. The following dialog appears, allowing you to 

select from available radar and satellite images: 

Chart 1 -- Image Display 

Surface _ Satellite 3-D Sat it Radar Plus Radar+ SIR 

Current 07/11/90 i1p 

fe ee 24 Hour 

48 Hour 

Full US 

US West 

Atlantic 

Caribbean 

| Delete One Image | 

(Delete All Images } | | Show Image | 

To select any image for display: simply click on it and click the Show 

Image button. The TV Graphics window will appear on your screen, and the 

image you've selected will appear in that window. If you have a large- 

screen attached to your computer, the T'V Graphics window can be made 

; larger by clicking i in the zoom box in the upper right corner of the window. 

The images listed in Chart 1 include: 
1. Surface maps (hand-drawn national maps) 7 
2. Satellite images (enhanced photos from weather satellites) 

3. 3-D satellite images (satellite photos enhanced to represent the 

height of cloud formations) 

4, Radar Plus images (composites of results from numerous weather 

radar installations across the country - these images show intensity 

| of precipitation) 

5. Radar Plus SIR i images (the SIR stands for Snow, Ice, and Rain - 

these are radar composites showing type of precipitation). 



Now look at the second set of TV Graphics images by pulling down the 
Display menu, positioning the cursor on TV Graphies, and selecting Chart 

2 - Other Images. The following dialog will appear: 

Chart 2 ~- Image Display 

|... {Natl Motion 

Snow Cover 

Soil Moist. 
Lightning 
Severe Wx 

Tom. Sev Wx 

Tom. Heat 

School Wx 

AM Weather 

Tom. Lang. 

Wake Up NE 
Wake Up SE 

Wake Up NC 
Wake Up Sc ote 

Wake Up NW {| = |Tom. Tan Idx [| 
Wake Up SW - ; 

Delete One Image) — ae ee eee ee ™ 

Delete All images) [Show Image | 
. 

This chart lists a wider variety of images available from Accu-Weather, 
Inc. While many of these are maps, there are others, including the | | 

Almanac and Wx Trivia, that are not. Select an image by clicking on it, 
then click the Show Image button. Note that the new image you've selected _ 
fills the existing TV Graphics window on your screen; the image you chose 
from Chart 1 is replaced. You can only have one TV Graphics image on the 

screen atatime. _ a ete, ot eT zis. yt 

AMPS Graphics 

_ AMPS graphics differ from the images in Chart 1 and Chart 2 in several | 
ways. The first difference you'll notice, if you pull down the Display menu, — 
position the cursor on TV Graphics, and select AMPS Graphics, is that you 

select these through a list rather than a chart. This is because the Accu- 
Weather system offers such an immense variety of AMPS graphics that we 
couldn’t fit them all into any number of charts. In fact, as you'll find later 
on when you’ve set up your Accu-Weather account and logged on, you can 
design your own AMPS graphics! Therefore, the list you see when you select 



AMPS Graphics from the menu is a list of the images on your disk, not the 

images available from Accu-Weather. Choose an image from the list by 

clicking on it and clicking the Open button. The AMPS image will appear 

in its own window on the screen - not the TV Graphics window. You can 

select the window you want to be active by using the Window menu, or by 

~ clicking on some part of the window you want to make active. 

Named Images 

The last choice under TV Graphics on the Display menu, Load Named 

Image, works just like the AMPS Graphics choice. You'll see a list of TV 

Graphics images that you downloaded interactively through an Explore 

Accu-Data session (if you haven’t downloaded any images from Accu- 

| : Weather yet, the list will be blank; the program disk doesn’t include any 

| : ‘TV Graphics images that aren’t listed on the two charts). This choice is 

provided to enable you to download and display additional types of images 

from Accu-Weather, Inc. This process is explained in detail in the “Explore 

Accu-Data” section of the manual. 



Lesson 7% - You're On Your Own Now 

If We Had Time: 

We could expand your f Buided tour to include several more aspects of me 
program such as: 

1. List format 
2. Other ways to select stations 
3. Using Archive files 
4. And more! 

However, you have at least been introduced to the basic capabilities of the 
program. From here, you should be able to explore on your own without too 
much difficulty. , | 

Getting Real data: 

Obviously, the most exciting part of this program will come when you use | 
real data instead of the demo data. Please refer to the oe Real data” 
section of the manual to find out how to: , 3 : 

Activate your Sabéeription with Accu-Weather 
Connect your modem . 
Set up the program with your account name & Booed Mae 
Select the data to request | : 
Automatically get the data __ oP we Se be 

Once you get started, the process of getting the data is very easy. And then 
you will have the most current weather oeven available from all over 
the nation. see ps 2 , 



- DATA IN THE 
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Data in the Accu-Weather Forecaster | 

One of the most important things the Accu-Weather Forecaster does for you 
is to present weather data in a variety of ways. All of the other displays in 
the program are alternative ways to look at essentially the same 
information. TV Graphics and AMPS Graphics are exceptions; they’re not 
created by the Accu-Weather Forecaster from the raw downloaded data; 
rather, they're downloaded as full-screen images to be displayed on your 
Macintosh. 

This chapter presents the three types of data available in the program: demo 
data, real data, and archive data. Also covered in this chapter are the 
various ways to choose the data you want to see, as well as an explanation of 
how you can look at a particular sort of data: N ational Weather Service 
forecasts. 

Demo, Real, and Archive Data 

Demo Data are provided with the Accu-Weather Forecaster to give you a 
chance to explore the program immediately, before you set up your account 
with Accu-Weather, Inc. 

We recommend that you explore the basic operation of the Accu-Weather 
Forecaster using this demo data. To use the Demo Data, simply select Demo 
Data by clicking the button on the Startup Screen (or ee Demo Data from 
the File Menu). 

The demo data represent the evening of January 22, 1990, when a major 
storm was covering the Northeast with a good deal of snow. For the purpose 
of the demo, pretend that you live in central Connecticut, that it is 9:15 p.m., 
and that you have just received the very latest weather information, as 
follows:. 

¢ Windsor Locks, Conn. — hourly reports for the past 24 hours and the 
most recent forecast 

¢ All weather stations within 250 miles of Windsor Locks, Conn. — 
most recent hourly report 



¢ 100 major National Weather Service stations — most recent hourly 

report 

e National Weather Service’s most recent “US Summary” report 

Whenever you use the demo data, the program will automatically consider 

Windsor Locks, Connecticut to be your “Nearest Weather Station”. 

Real Data are the “live” weather data you get from Accu-Weather, Inc., 

when you set up your account and use the Accu-Weather Forecaster to define 

your request for information and download that information. 

To use Real Data, simply select Real Data by clicking the button on the 

Startup Screen (or select Real Data from the File Menu). Real data includes 

as many kinds of weather observations as you want from as many 

National Weather Service stations as you choose. There are over 900 

officially-reporting weather stations in the country, 12 different types of 

information available in each report, and up to 24 hourly reports per day 

from each station — or a potential total of over a quarter of million pieces of 

weather information per day! In other words, you can have a Jot of real 

weather data on your computer. To get real data, you have to download it 

from Accu-Weather, Inc. (refer to the Telecommunications chapter). Once 

real data are stored on your data disk, the Forecaster can show some or all 

of it to you in lots of different ways, as we explain below in the Selecting 

Data section. 

Archive Data are real data you’ve downloaded from Accu-Weather, Inc., 

and have stored for future reference. You store real data in an “archive 

file” by selecting Save to Archive... from the File menu. You can use 

archive data at any time by selecting Open Archive... from the File menu. 

Once you open an archive file, its contents become your active data, and you 

can choose to see it in various ways as explained below in “Selecting Data.” 



Selecting Data 

Choose from four items to specify what information you would like to see 
displayed from the data you already have on your data disk: Info, Stations, 
Dates, and Times. These are the choices under the Select menu. For 

example, you might have a map of temperature displayed, and want to see 
wind speed instead. The Info choice under the Select menu lets you do this. 
Other choices under the Select menu let you select data from a different 
location, such as Boston or San Francisco, a different date, or a different 

time of day. 

Selecting Stations 

“Stations” refer to the National Weather Service stations that take hourly 
observations. A full list of all NWS stations is in the Appendix. 

If the current type of display (such as a graph) allows for selection of only 
one station, you will see the following choices under the Select-Stations 
menu: | 

Nearest Station d3€N Stations > 
Dates >) City... 

>| Station Code... Times 

US#-Majors 35 R 

— Raage... 3ER 
Map... 

Cities... 

States... 

Station Cades... 

When the type of display (such as a map) allows you to select more than one 
station, all the choices in the Select-Stations menu will be available to you. 

For any of the selection procedures described below, you are limited to a 

maximum of 100 stations. Whenever you select more than 100 stations, the 
program will automatically reduce the size of the list by eliminating any 



station which is not a “Major Station.” The National Weather Service 

station list in the Appendix includes a map indicating the locations of the 

100 major stations. To see this map on your screen, select Demo Data from 

the File menu, then hold down the Command and Shift keys and press “/”. 

If you don’t get the correct “Nearest Station,” it’s probably because you didn’t 

set up the program to know which station is closest to you. Please refer to the 

Setup-Station section of the Manual, and the NWS Station List in the 

Appendix. 

e USA Majors — Because there are so many reporting stations in this 

country, it is impossible to display data from all of them at once. 
Therefore, this item selects a standard set of 100 major stations. 

e Range — selects all stations within any desired number of miles from 

your home base. You may enter any distance up to 500 miles. 
e Map — selects all stations within a particular rectangular region of a 

map. You define the region by drawing a rectangle on a map of the 
United States. | 

° Cities — selects cities by name. First you choose the state(s) from the 

state menu (as above). Then the program displays a list of all reporting 

cities within each state, from which you make your city selection(s). An 

asterisk next to a city name (e.g., “*Erie”) indicates that station is one 
of the 100 major reporting stations. Here is a sample city list: 

Select... 

Please _ select the City from the list below. 

Philedelphie/N 

Pittsburgh 

*Pittsburgh/Intl 

Reading — 

State College 

Tobyhanna 

1 Harrisburg Wilkes-Barre 

Johnstown Willow Grove 

Latrobe Williamsport 

}/ Lancaster 

Martinsburg 

H tiiddletown 

Philadelphia 

Pennsylvania { | NONE &. 

e States — selects all stations within a state or states that you choose from 

the list. Here is what the state list looks like: 



California-N 

California-$ 

Colorado 

Connecticut 

Delaware 

Florida 

Georgia 

Idaho 

Illinios 

Indiana 

Kentucky 

Louisiana 

Maine 

Maryland 

Massachusetts 

Michigan 

Minnesota 

Mississippi 

Missouri 

Montana 

Nebraska 

Nevada 

New Hampshire 

New Jersey 

New Mexico 

New York 

North Carolina 

North Dakota 

Ohio 

Oklaboma 

Oregon 

Pennsylvania 

Rhode Island 

South Carolina 

South Dakota 

Tennessee 

Texas 

Utah 

Vermont 

Virginia 

Washington 

Washington D.C. 

West Virginia 

Wisconson 

Wyoming 

[__OK__JJ (NONE &. 

Note: because of the large number of stations in California, that state is 
broken into two sections: “Cal-N” and “Cal-S”; northern California 
and southern California, respectively. Also, Alaska and Hawaii are 
not included because their geographical locations are not covered by this 

program. 
¢ Station Code — If you know the National Weather Service’s three letter 

station code (for example, Windsor Locks, Conn is BDL), you can select 
stations by entering the station code(s) directly. As you enter the code(s), 
the program will confirm whether or not each is a valid station code, © 
and will identify the full city and state name (refer to NWS Stations). 

Selecting Info 

“Info” refers to the type of weather information to be displayed (such as 
barometric pressure or temperature). When you want to change the type of 
information to be displayed (such as with Graphs and Maps), pull down the 
Select menu and position the cursor on Info. The following menu appears: 



Barom. Pressure 31 | 

: soe | : “Temperature #2 
ib ~— Dew Point — B35 | 

BPE be 4 Wind Direction %4 
Wind Speed 365 | 
Wind Gust 366 
Visibility — 967 
Precipitation 8 

- Cloud Base 99 
Cloud Amount #0] | 

Fog %- | 

These types of weather information are explained in more detail in the 

Reference section of the manual. 

| Selecting Date 

: Selecting one date: If the current ve of diuplay allows for selection of only 

one date, you wil see the following choices under the Select-Dates menu: 

Select : 

Info > 
Stations >| as 

Dates [2 ~=6 Most Recent 
Select Date... 

so Previous Date &; 

Next Date 

RE Dates 
Raage.., 

‘When the type of display allows you to select more than one date, all the 

choices in the Select-Dates menu will be available to you. 



¢ Most recent — The program will automatically find the most recent 
date(s). This is a real convenience if you don’t know what dates are on 
the data disk. 7 

e Select date — Select a specific date (month, date and year). 
e Previous date — takes the currently displayed date and changes it to the 

date previous to it. 
e Next date — takes the currently displayed date and changes it to the date 

after it. 
e All dates — All dates for which information is available will be 

included. 
° Range — Specify a starting date and a stopping date ae ee date and 

year). 

Selecting Times 

Selecting one time: If the current type of display allows for selection of only 
one time, you will see the following choices under the Select-Times menu: 

Select 

Info > 

Stations p> 
Dates > 
Times ‘a 6 Most Recent 

Select Hour... 

Previous Hour 3, 

Next Hour 

RH Times 

Raage... 

When the type of display allows you to select more than one time, all the 
choices in the Select-Times menu will be available to you. 

¢ Most recent — The program will automatically find the most recent 
time(s). This is a real convenience if you don’t know what times are on 
the data disk. 7 



Select hour — select one specific hour. You enter the hour only, using a 

24 hour clock; enter 1 p.m. as 13. (The selected time will be displayed as 

50 minutes past the hour, so 1 p.m. will be displayed as 1:50 p.m.) 

Previous hour — takes the currently displayed time and changes it to the 

hour previous to it. 
Next hour — changes the currently displayed time to one hour later. 
All times — All times for which information is available will be 
included. 7 
Range — Specify a starting time and a stopping time. 

Special Notes About Time: 

1. In all cases, the time displayed is your own local time, even if you are 
displaying data from a different part of the country. Although the data 
are stored on disk in Greenwich Mean Time (which is the National 
Weather Service’s standard time format), it’s automatically converted 
to your local time when displayed. 
If Daylight Savings Time is used in your part of the country, the 
program will automatically convert to Daylight Savings Time during 

the appropriate time of the year. 
In order for the above time conversions to take place correctly, you need 

to use the Setup menu to indicate your local time zone and whether or not 
you use Daylight Savings Time. You only have to do this once, when you 
first set up your program. 
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_ TEXT DISPLAYS 



Text Displays 

Forecasts 

A variety of forecasts are provided by the National Weather Service. As 

- detailed in the following pages, the Accu-Weather Forecaster gives you 

access to three types of reports: 

1) Text Forecasts 

2) Chart Forecasts 

3) US Summary 

The first two reports are available for approximately 250 stations throughout 
the country. The specific stations are listed in the NWS Stations List in the 
Appendix. 

Text Forecast 

S22 recta te SSSSSSaaaaa___=—_=_== 
STATION: Windsor Locks, Conn INFO: Text Forecast * DEMO * 

DATE: see below TIME: see below 

HACT-GREATER HARTFORD SPRINGFIELD AREA FORECAST 
NATIONAL WEATHER SERVICE HARTFORD CT 
4 PM EST THU JAN 22 1990 

...- BLIZZARD WARNING TONIGHT... 

. TONIGHT. ..BLIZZARD CONDITIONS WITH HEAVY FALLING AND BLOWING SNOW. 
ACCUMULATIONS OF A FOOT OR MORE WITH CONSIDERABLE DRIFTING. LOW 20 TO 

. NORTHEAST WIND 20 TO 30 MPH GUSTING TO 45 MPH. 
... WINDY WITH FLURRIES AND SOME OCCASIONAL SUNSHINE. HIGH IN 

WIND WEST 20 TO 30 MPH. CHANCE OF SNOW 40 PERCENT. 
.FRIDAY NIGHT...CLEARING. .WINDY AND COLD. LOW ZERO TO 10. 
.SATURDAY...PARTLY SUNNY...WINDY AND COLO. HIGH IN THE TEENS. 

The Text Forecast is a brief forecast for the region near the forecast station. 
It is prepared by the local office of the National Weather Service and is 

issued approximately four times each day. 



If you want to see a forecast for a different station, choose Station Codes from 
the Select-Station menu, and a list of all stations for which you currently 
have this type of forecast information will be presented in a dialog box. You 
can choose another station from this list by double-clicking or by nee 
lighting it and using the Select button in the dialog box. 

Chart Ligdieast 

_ eee Forecaster = St 

STATION: Windsor Locks, Conn IMFO: Chart Forecast 

DATE: Mon Jan 22, 1990 TIME: 7:00 AM 

PONoig—a Soe | TE aeons | Soe ED 
lpm 7pm lam Jam ipm 7pm lam Jam 

Precip Prob--¥ | --90-- | --90—— | --50-— | --20-~ | --5-—- | --2-—-| 
Precip Amt--Hndth in.| |--99--|--55--j 
Precip Type | -SHOF~ | --ZR-= | -SMOW- | 
Thunderstorm Prob--% | ----=+-20----~ | B--- = | -—-—----2 ----—- | 
Temp Min/Max--Deg F | ----Min=22-—— | -——-Maxa32-—- | ----Mine2 -—-- | 

Temperature--Deg F 9 
Dew Point - Deg F 
Wind Direction — 
Wind Speed--lHPH 

Clovd Amount--¥ 
Cloud Base--Thsnd ft. 
Visibility-—-tliles 
Fog 

The chart forecast is based on a computer model of weather conditions, as 
prepared by a National Weather Service computer. Meteorologists refer to 

this as the “MOS forecast” (Model Output Statistics). It contains a variety of 
forecast information for the following two days, broken down into 6 hour 

_ blocks. It is released twice each day, according to the Eo Owany schedule 
(add 1 hour for Daylight eect 

Eastern 

Central 

Mountain 

At the top of each chart forecast are the dates and times; on the left are the 

categories of information. Most data, such as cloud cover and wind speed, 
are forecast for the specific time listed at the top of each column. Other data 



(such as probability of precipitation) are forecast for a range of times as 
indicated by the dashed lines. : 

_ To see a forecast for a different station, choose Station Codes from the Select- 
Station menu, and a list of all stations for which you currently have this 
type of forecast information will be presented in a dialog box. You can 
choose another station from this list by double-clicking or by highlighting it 
and using the Select button in the dialog box. 

U.S. Summary Forecast 

The U.S. Summary Forecast is an extensive description of current — 
conditions throughout the country. It is a thorough and reliable overview 
that is updated four times per day by the National Weather Service. 

The approximate reporting schedule is as follows (add 1 hour for Daylight 
Savings Time): 

The U.S. Summary is a couple of pass in length, and includes the 
following: 

1. The date and time of the forecast, in the first line of text 
2. Adiscussion of current conditions, with emphasis on important 

weather events 
3. Adescription of the current weather map, including locations of 

lows, highs, and fronts. 
4. Adescriptive weather map forecast giving predicted locations of | 

lows, highs, and fronts. 
5. A discussion of the forecast weather conditions for various regions 

of the country. 



Forecaster 

STATION: USA--lMajor stns *DEMO* INFO: all 
DATE: Mon Jan 22, 1990 *DATA* TIME: 8:50 Pt EST 

click 40 boty! OO OOO Oe OPO OO OO 

Location [Bar |Temp |Dew |Wind |Wind | Visib|Precp|Cloud | Cloud | Fog 

(same date & time) |Pres | |Point|Dir |Spd/G| |Type | | 

deq F h i 

Base |Amt 

Th Ft]. *¥ 

Arcata, Cal-N 
Atlanta, Georg 
Atlantic City, NJer 
Rustin, Texas 
Bakersfield, Cal-S 

Charleston, WVirg 
Cheyenne, Wyom 

The List display is simply a listing of the actual weather data. In the 

example above, all available weather information is presented for one 

single hour for all stations in Connecticut. The station names are specified 

in the column on the left. The types of information and the units of measure 

are indicated at the top of each column. 

Vary One Selection Criterion at a Time 

You can look at a list in several ways: 
1. Several stations for a single date and time 
2. Several times for a single station and date 
3. Several dates for a single station and time 

The program takes care of the details when you change the criterion you use 

to select information. 



Sorting 

You can sort the list according to the values in any one of the columns of 
information. To sort, simply choose the column you want to use as a sorting 
criterion, and click on the radio button above that column. The information 

in that column will be presented in order from least or lowest to most or 
highest values, or in alphabetical order if the column contains letters 
instead of numbers. Missing values are treated as “lowest” values in 
sorting. Note that sorting does not affect the way the data are stored on your 

disk, only the way you see the data in the List display. 



GRAPHIC DISPLAYS 



Graphic Displays 

Graph Display 

em 
0) 

STATION: Windsor Locks, Conn *DEMO* INFO: temperature (deg F) 

DATE: Mon Jan 22, 1990 *DATA* TIME: all 

2:3 Aris: 62°77) 8 9 110-11 283 4535°6 7 8: 9 #10 11 42 

Change Scate At. ay Graph Overla 

The Graph display uses a line graph to show change over time, hour by hour. 
In the example above, the graph shows the barometric pressure in Windsor 
Locks, Conn., during January 22, 1990. The numbers at the bottom of the 

graph indicate the times, and the numbers at the left indicate barometric 
pressure values. Each box represents a single hourly observation. 3 
Observations from consecutive hours are connected by a line — the line is | 
broken when an observation is not available for a particular hour. 

Overlay Graphs enable you to compare up to three different types of 
information for a given station on a given date. You start with a graph of 
one type of information, then by clicking on the Overlay Graph button in the 
lower right corner, you can choose other information to display on the same 
graph. | 



Se Forecaster SSSSSS_]_=]=====—=] 

STATION: Windsor Locks, Conn.  *DEMO* INFO: wind direction (deg) 

DATE: Mon Jan 22, 1990 *DATA* TIME: all 
O = temperature 
& = barom pres 
Wind = Arrows (wind blows toward head) 

see TT 
a wo aesvee cet coseteneteee 

<i ae 

i 2:3 4.35: 6° 2-8-9 20:11 121.23 4 35°6 7 8 9.10 11-12 

Change Scale} — A. U1. Pt. Graph Overla 

In the example above, notice that squares, triangles and stars are used to 
indicate the values for the three different types of information. However, 
only one type of information at a time is labeled in the scale on the left side 
of the graph. If you want to change the labeled scale, click on the Change 
Scale button in the lower left corner of the window. 

Remove overlays by clicking on the Overlay Graph button, then choosing 
Remove Overlay in the dialog box to remove the most recent overlay. 

When you have the maximum number of scales present on the graph, 
Remove Overlay will be the only available choice in the “Select Info” dialog 
box. 

Wind direction 

On the top row of the graph, wind direction is shown as a series of arrows. 
The arrows are oriented to show the wind blowing from the tail to the head of 

the arrows (north is “up” as in a map). 



Precipitation 

In the precipitation graph, the type of precipitation is indicated by letter 
codes (e.g., S = snow) (refer to Precipitation Codes in the Reference section). 
Intensity is shown by position (higher position means greater intensity). 



STATION: USA--Major stns *DEMO* INFO: temperature (deg F) iAdd Values 
DATE: ton Jan 22, 1990 *DATA* TIME: 8:50 PM EST 

(_] -20--11 0-9 Hi 40-49 fae 60-69 
1 10-19 iss fs S0-S9 

UJ HHH THEY HHH EMH ibshiobe THs 

ality tH) HY 
vane 

Maps are the most powerful and informative displays provided by the Accu- 
Weather Forecaster. Maps can be drawn for the entire US or any selected 
region. The map display includes options for displaying the data as specific 

values or as contour regions (as explained below). 
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STATION: Map area selected *DEMO* INFO: temperature (deg F) 

DATE: Mon Jan 22, 1990 *DATA* TIME: 8:50 PM EST 



To display a map, pull down the Display menu and position the cursor on 

Maps. The following submenu will appear: 

Display 

[> Values Map 96M 
is ammnnninnnmnend Shaded Con tours #S 

Color Contours 3K 

(©0000 006 000000000 00000800000900800500000 009 000000 000200009000 

000 000 000 606 080 000 000000000060060008 00080 000 000000008 000000000 

000060 000000 000 000 00600200000000000000080 000 000000000 000000000 

TU Graphics 

As explained below, Values Map will produce a map with numeric values 

overlaid on it. The values represent whatever type of information you 

choose (from the Select menu). Contour maps interpret the information and 

‘calculate contour lines illustrating trends and areas with similar values. 

If you have a Macintosh capable of displaying color, you can choose either 

shaded contours (areas are filled with monochrome patterns) or color 

contours (areas are filled with colors). If your Macintosh can display only 

black and white, you are limited to the shaded contours selection. 

_ The various options on the Select menu work with Maps to enable you to 

produce maps of any region of the country showing any type of weather 

information. 



Maps Showing Values 

3 Forecaster : 
STATION: USA--Major stns *DEMO* INFO: temperature (deg F) 

DATE: Mon Jan 22, 1990 *DATA* TIME: 8:50 PM EST 

45 
45 

This is the standard way to display data on a map. The actual values are 
displayed directly on the map, at the exact locations of the reporting 
stations. (If two stations are extremely close together, only one value will be 
displayed). All data are displayed as numeric values except: 

e Wind direction — shown as arrows, with the wind blowing from tail of 
the arrow to the head | | 

¢ Precipitation — shown as the standard precipitation codes, as follows: 
T = Thunderstorm 
H= Hail 

Z = Freezing rain/sleet 
S = Snow 

R= Rain 



*DEMO* INFO: tempere 
DATE: Mon Jan 22, 1990 *DATAt TIME: 8:50 PM EST 
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Contour maps use shading or color bands to indicate common ranges of 

values. Contour maps provide a powerful tool to visually represent and 

interpret weather data. They really bring the numbers to life! 

The ranges used for the contour levels are based on the total range of values, 

divided into equal segments. On each contour map, the minimum and 

maximum values are shown in their proper geographic locations, and the 

scale of values is displayed above the map. Maps with shaded contours use a 

range of patterns from light to dark as the scale, while maps with color 

- contours use a series of colors. While color contours provide more visually 

exciting images, they are only available on color Macintosh systems, and 

will not print as well as shaded contours. 

Contour maps should be considered as “best approximations” because the 

calculations assume that values change smoothly from one point to the next, 

which may not always be the case. Therefore you should use some caution 

in interpreting them. Once you've displayed a contour map, click the Add 

Values button in the upper right corner to see the actual values added to the 

map. The values are overlaid upon the contours, so some of the detail in the 

contours may be lost when values are added. — : : 



Pictures display all the information available for a single hour at a single 
station. The picture shown above, for example, presents all the weather 
information reported by Windsor Locks, Conn. at 8:50 p.m. on January 22, 

STATION: Windsor Locks, Conn 
DATE: Mon Jan 22, 1990 

*DEMD* INFO: all 
*DATA* TIME: 8:50 PM EST 

HOH THI ee le 

a) eS Oconee eee ayy 1b 
aa a Ha 
OR SW ta 

omy page 
ond omge 

te ty 4 aR oe 

TEMP 

: Overcast at 1,000 £t 

Precip: light Snow 
Wind: From NE at 16 mph 

Visib: 2 miles 
: Fog is present 

1990. 

1. “Window View” (upper left) shows cloud cover and precipitation as if 

you were looking out a window: clouds are shown in varying amounts; 
any reported precipitation is shown as rain, snow or freezing rain, or 
hail; lightning and fog are also drawn in when appropriate. The | 
amount of wind is illustrated by the bending of the tree in the window. 

. Instruments (upper right) depict the temperature, dew point, and _ 
barometric pressure. Note that the scales on the instruments differ. 
The compass (lower right) indicates the direction thatthe windis — 
blowing (the wind blows from the tail to the head of the arrow — this is 
the opposite of a wind vane). 
The text area (lower left) spells out the degree of cloud cover, the level of 
the lowest clouds, the type of precipitation, the wind direction and ee 
the paeigateiai and the presence of fog. 

31° F 

DEW POINT BAR PRES, 

2885 

® 
3060 
3040 
3020 
3000 
2980 
2960 
2940 
2920 
2900 



TV Graphics 

TV Graphic satellite image 

TV Graphics are high-resolution color images that are downloaded from 
Accu-Weather, Inc. as complete images. They include manually — 
generated maps of surface conditions and forecasts, graphic displays of 
weather trivia and historical weather events, satellite photographs with 

various types of enhancements, composite radar images, and more. Many 

of these images are the same ones you see every night on televised weather 
reports — only now, you can have them first! 

o7 
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TV Graphic surface map 

TV Graphics files, because of their high resolution and the fact that they are 
stored on your disk as images, rather than data, occupy a significant  __ 
amount of space on your disk, and take more time to download from Accu- 
Weather than do hourly reports or other information. This may become a 
concern as you amass a large collection of images. Refer below to “Deleting 
TV Graphics” for information on erasing old images. ae 

TV Graphic jet stream map 



TV Graphic lightning strike map 

TV Graphics are available through two lists, “Chart 1 - Surf/Rad/Sat”, 
which lists surface maps, satellite photos, and radar composites, and “Chart 
2 - Other Images”, which lists a variety of other types of images, from upper 
air information to forecasts, a seasonal tanning index, almanac 
information, weather trivia, and a variety of maps. These charts are used 
in Define Request (under the Telecom menu) to select images to download, 
and in TV Graphics (under the Display menu) to display downloaded 
images. The charts are slightly different in each case: 



Define Request 

Chart 1 - Radar and Satellite Images 

SURFACE: [x] Current [(] 24 Hour [] 48 Hour 
3-D 

Satellite  Radar+ Radar+SIR Satellite 

Full US 

US North East 

US South East 

US North Central 

US South Central 

US North West 

US South Fest 

US East 

US Central 

US West 

Mid-Atlantic 

Caribbean 

Gulf of Mexico 

Mexico 

Pacific 

World 

Estimated Connect Time: 

8 mins 18 secs 

OOORWKOOOO OOOOOOR QOOOOOOO00 Ooonoo0o0o0 

Chart 2 - Other ik tice Ee ce a, a, ee a 

~ CURRENT +++ FORECASTS + CURRENT AM PM Eve Nite FORECASTS CURRENT AM PM Eve Nite 
Jet Stream Weather NE(Motion) Nat'l Map (Motion) [] 
West Jet Stream Weather SE(Motion) Satellite/Surface z 
Wind Chill Weather NC(Motion) 
Heat Index 
Snow Cover 
Soil Moisture 
Lightning 

Weather SC(Motion) FORECASTS 
Tom'w Map (Motion) ["] 
Tomorrow Canada Map 
48 hour Canada Map 

Weather NW(Motion) 

Weather SW(Motion) 

Tomorrow Precip 

Saturday Weather 
FORECASTS Sunday Weather 

BAND MAPS 
Tom'w Sev Wx 

Tomorrow Heat 

School Weather 

Morning Weather 

To. Plain Lang. 

Week Precipitation Current Temps 
PM Highs 

SPECIAL Night Lows 
Almanac Page Tomorrow Highs 5 He 
Today Worst 48 hour Highs 
Weather Trivia 
Today Extreme 
Yesterday Extreme 

Today Tan Index 

Tomorrow Tan Index 

Estimated Connect Time: 

2 mins 54 secs 

Wake Up NE 
Wake Up SE 
Wake Up NC 
Wake Up SC 
Wake Up NW 
Wake Up SW 

Severe Weather Week Temperatures 

cancel 

In Define Request, the TV Graphics charts (shown above) enable you to 

check the images you want to download. In Display, the TV Graphics charts 
(on following page) display information about the images available on your 
disk, and enable you to select an image to display. 



Displaying TV Graphics 

_ In the Display TV Graphics charts, the date (and time, where appropriate) of 

the latest version of each available image is shown. It’s possible to have 

several versions of a particular image — for example, you might have 

satellite maps of the US for several consecutive hours. If more than one 

version of an image is available, you'll see a “plus” sign following the date 

or time of the image: “01/22+” or “01/22/90 11p+”. : 

Chart 1 -- Image Displey 

Surface Satellite 3-D Satellite Redar Plus . Radar+ SIR 
ney 

Current 07/11/90 Lip 
sy 

[Sesh SRE SE 
48 Hour [—____ Jj as 
Full US 07/11/90°10p 

US West 

Atlantic 

Caribbean 
G. of tex. 
Mexico Sse | 
Pacific paren 
World 

Delete One Image 

Delete All Images | | Show Image | 

Chart 2 -~ Image Display 

|: Natl Motion 

Wind Chill 
Heat Index 

Snow Cover 
Soil Moist. 
Lightning Tom. Precip 
Severe Wx | — {Saturday Wx 
Tom. Sev Wx 
Tom. Heat 

School Wx 

AM Weather 

Tom. Lang. 

Wake Up NE | 
Wake Up SE | . Extreme 
Wake Up NC . Extreme 

Wake Up SC . Tan Idx 
Wake Up NW . Tan Idx 

Wake Up SW 

Delete One Image : | 
‘(Delete All Images | Show Image | 
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To select an image for display, simply click on the cell in the chart 
containing the date of the most recent version. The Show Image button will 
become active, enabling you to display the image. When you select an 
image for display that has more than one version available, however, the 
following dialog appears when you click the Show Image button: 

Satellite - Full US 

06/16/90 05p 
06/16/90 07p 
06/16/90 09p 
06/16/90 1p Delete One Image 

| Cycle 

(a SRS I AE RTD 

Cancel 
For Cycle : ("Cancel -) 

Click mouse or 

press key to see Show Image 
next picture 

Cycling Several Versions of an Image 

The name of the image appears at the top of the dialog. Under the name is a 
scrolling list of available versions of the image, followed by the word 
“Cycle.” To display a single image, simply click on the one you choose and 
then on the Show Image button. If you click on Cycle, then on Show Image, 
the available versions of the image will cycle through the TV Graphics 
window. Each time you click the mouse or press a key, the next image will 
appear — until you've seen them all. This feature enables you to see 

changes from one version of an image to the next, for example, when a 
storm system is moving across a region. 

Deleting TV Graphics 

TV Graphics images occupy a significant amount of disk space. You will 
probably find that you need to “clean up” periodically, deleting some or all 
of your old images to make room for new ones. While you can do this from 



the Finder, the names assigned to the TV Graphics files by the Accu- 
Weather Forecaster are somewhat cryptic, so it can be difficult to be sure 
that you’re deleting the right images (the system for naming TV Graphics 
files is explained in the Reference section). There is an easier way to delete 

old image files from within the program. | 

The simplest way to delete old images is to let the program do so 
automatically when downloading new images. Simply click the “Erase 
Old Data” button in the Define Request dialog to enable this feature (this is 
explained in more detail in the Define Request section of the 
Telecommunications chapter). 

TV Graphic images can also be deleted through the Chart 1 and Chart 2 
dialogs. Whenever you select an image from one of the charts, rather than 
click the Show Image button, you can click the Delete One Image button 
instead to delete that image. When you select an image with multiple 
versions (that is, when the date of the image is followed by “+”) and click 
Delete One Image, you see an additional dialog enabling you to pick a 
single version or all versions for deletion. Finally, the Delete All Images 
button will delete all the image files listed in that chart — but not the images 
listed on the other chart. 

To protect images from any possible deletion by the Accu-Weather 
Forecaster, simply move them to a different folder — the program will only 

delete images in its own folder. 

Images for which you provide the filename, including those listed under 
AMPS and those listed under Named Images, are not affected by the 
methods of deletion available within the Accu-Weather Forecaster. Since 
you provide the names for these images, they'll be easy to identify and (if 

you wish) delete from the Finder. 

Availability of TV Graphics 

Note that not all TV Graphics are available all year; there are a number of 
images that are seasonal. For example, the Radar Plus SIR (Snow, Ice, 
Rain) maps are available November 1 through April 30 — there isn’t much 
snow or ice around the rest of the time! Similarly, the Tanning Index is 
only available between May 1 and September 30. The manual you'll receive 



from Accu-Weather when you open your account will provide more details 
on the REPU of seasonal images. | ‘ 

Printing TV Graphics | 

Like any screen in the Accu-Weather Forecaster, it is possible to print the 
TV Graphics window on an ImageWriter or LaserWriter printer. Simply 
make sure the TV Graphics window is active (use the Window menu or _ 
click on a portion of the TV Graphics window to make it active), select Print 
from the File menu, and wait for it to print. Note that all of the detail you see 
on the screen may not be rendered on paper, Herticularly if you Hate a color 
monitor. | 

Saving TV Graphics Screens on Disk 

It is possible to save any TV Graphics screen on disk. If your Macintosh can 
only display black and white, the disk file will be in MacPaint format. If 
your Macintosh can display color, the disk file will be in PICT format (a 
standard Macintosh format for graphic images). This is useful if you want 
to manipulate a TV Graphics image in a painting or drawing program, or 
if you want to use an image in a word processor or page layout program. 
Simply make sure the TV Graphics window is active (use the Window © 
menu or click on a portion of the TV Graphics window to make it active) 
and select Save Screen from the File menu. The program will ask you to © 
supply a name for the file, and will save it where you specify through the 
save file dialog box. Note that the results you see when importing the file 
into a graphics program will vary according to the capabilities of the 
graphics program; sometimes you may lose some color or detail. However, — 
if you have a Macintosh capable of displaying color, and a color ase pee 
program, ig image will be displayed in full color. eS 
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AMPS Lightning Map 

Another type of high-resolution graphic available oe degiit Weather, Inc. 

is called AMPS (for Advanced Map Plotting System). AMPS graphics 

differ from TV graphics in that they are generated by Accu-Weather’s 

computers rather than produced by an artist or a camera. In effect, the 

AMPS system on the Accu-Weather computer is doing much the same thing 

a as the Accu-Weather Forecaster does on your computer when you generate 

_ graphs and maps. Through the AMPS system, though, you have access to 

additional types of information the Accu-Weather Forecaster’s mapping 

and graphing systems don’t offer — and many AMPS displays are exactly 

what professional meteorologists find particularly useful. The AMPS 

system is capable of showing you upper air maps and sounding diagrams, 

charts, maps of specific regions of the US, maps of various parts of the world, 

including Australia, Europe, and Alaska, and much more! 



Co 

Weese 
#TEMP (.1 C) 002 17-JUL-90 S00 MB 

@ ACCU-WEATHER , INC, 

AMPS map of upper air conditions 

Downloading AMPS Images 

When you specify an AMPS image to download, you are instructing the 
Accu-Weather computer to create an image according to your 
specifications; no two AMPS images are (necessarily) alike! You have a 
wide range of choices of information, maps, scales, and methods of 

presentation. Because of this nearly infinite flexibility, there is no way to 
predefine a list of images for you, as the program does with TV Graphics. 
AMPS images must be downloaded interactively, by selecting Explore 
Accu-Data from the Telecom menu. This is explained in more detail in the 
“Explore Accu-Data” section of the manual. That section, along with the 

documentation you receive from Accu-Weather, Inc. when you open your 
account, will guide you through the process of choosing and downloading 
AMPS images. For now, though, here are some more samples to whet your 

appetite! | 
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AMPS upper air sounding chart showing the relationship between 

temperature and humidity as altitude increases. 

122 17-JUL-90 EUROPEAN 24HR 
@ ACCU“WEATHER INC, . 

AMPS can produce maps beyond the U.S. — Australia, for example 

Printing AMPS Graphics | 

Like any screen in the Accu-Weather Forecaster, it is possible to print the 

AMPS window on an ImageWriter or LaserWriter printer. Simply make 



sure the AMPS window is active (use the Window menu or click on a oe 
portion of the AMPS window to make it active), select Print from the File 3 
menu, and wait for it to print. — 3 | 7 

Saving AMPS Graphics Screens on Disk _ 

It is possible to save any AMPS screen on disk. If your Macintosh can only 
display black and white, the disk file will be in MacPaint format. If your 
Macintosh can display color, the disk file will be in PICT format (a ee 
standard Macintosh format for graphic images). This is useful if you want. 

_ to manipulate the image in a painting or drawing program, or if you want to 
_ use an image in a word processor or page layout program. Simply make © 
sure the AMPS window is active (use the Window menu or click on a 
portion of the AMPS window to make it active) and select Save Screen from 
the File menu. The program will ask you to supply a name for the file, and 
will save it where you specify through the save file dialog box. Note that the 
results you see when importing the file into a graphics program may vary 
according to the capabilities of the graphics program; sometimes you may 
lose some color or detail. However, if you have a Macintosh capable of ee 
displaying color, and a color graphics program, the image will be displayed _ 
in full color. : | i oe lL oe 3 
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Telecommunications 

Background 
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The telecommunications component is the real source of power for the Accu- 
Weather Forecaster. First, some background: 

Every hour, hundreds of weather reporting stations throughout the country, 
such as the one pictured below, perform a standard set of weather 
observations. The observations, referred to as “hourlies”, are done every 
hour between 50 and 59 minutes after the hour (e.g. between 1:50 and 1:59). 
These hourly reports are the primary source of data for the Accu-Weather 
Forecaster. 

This is a sample hourly report, in its original coded form: 

BDL SA 1850 3 OVC 7S- 993/22/17/0109/948 

The hourly reports use an internationally standardized code in order to 
communicate a great deal of information in such a compact form (the codes 
are explained in the Reference section). 



These reports are immediately forwarded to the National Weather 
Service's centralized computer database. The National Weather Service in 
turn provides the information (for a fee) to Accu-Weather and other private 
and public weather agencies. 

Accu-Weather has developed a sophisticated computerized weather database 
of its own. Their database, which they call Accu-Data, incorporates the 
National Weather Service data, along with a variety of other weather data. 
Accu-Weather uses these data for their own forecasts, which they provide to 
numerous television and radio stations and newspapers, and to various 
private clients. : 

Accu-Weather has implemented a system which allows the general public 
to access the weather information in Accu-Data. For this privilege users are 
charged a modest “connect-time” fee, based on the amount of time they are 
connected. Before you can access Accu-Data, you need to initiate a 
subscription account with Accu-Weather. 

The Accu-Weather Forecaster gets its data through a direct connection to 
Accu-Data. One of the important features of this program is that it — 
automates the process of accessing the weather information. As explained 
later, you predefine your request (refer to Define Request), and then the 
program automatically logs on to Accu-Data, requests the data, receives the | 
data, saves it on disk, logs off and disconnects (refer to Get Data). The 
actual displaying of the data takes place after you have logged off from 
Accu-Data. 

Downloading data Gheally requires only 2 to 5 minutes, ihe on the 

amount of information that you request. | 

Alternatively, if you want to explore some of the many additional _ 

capabilities of Accu-Data on your own, you can use another capability of this 
program. It can dial up and log on to Accu-Data, and then leave you in 
control. This direct interactive use of Accu-Data is explained in the Explore 
Accu-Data section of this manual. You will be amazed at — vast amount of 

weather information available in Accu-Data. 
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Getting Started 

Before you can begin to use telecommunications, you need to: 

1. Activate: your account with AnsucW/cather 
2 Connect a modem to your Macintosh | 
3. Set up the Accu-Weather Forecaster for your particular equipment 

and subscription. : | 

Activating Your Accu-Weather Account 

- Accompanying this program is an Accu-Weather subscription instruction 
sheet including an account name and password for you to use. As detailed 
in the package, you only need to establish payment arrangements with | 
Accu-Weather to activate your account and receive additional material, 
including a manual with additional details about the information 
available in their database. Refer to the material on your subscription 
instruction sheet for more information about logging on to Accu-Data Oe 
the first time. | : 

If you have any questions regarding Accu-Data, contact: — 

Ascu- Weather. Inc. 
619 W. College Ave. 
State College, PA 16801 
(814) 237-0309 

Installing the Modem 

Connecting a modem to your Macintosh Srcbably involves nothing 3 more 
than plugging the modem cable into the modem port, and the phone line into 
the modem. However, the details may vary, SO refer to the manual sae 
received with your modem. | 



Setting Up for Telecommunications 

Once you have referred to your Accu-Weather Subscription Procedure (and 

once your modem is installed), you are ready to set up the Accu-Weather 

Forecaster for your particular subscription and equipment. Start by 

selecting “Telecom” from the Setup menu. 

Telecom Setup ero renmaatens ott TOT 

Modem Type: @Hayes © Bther 

Baud Rate: © 300 ©1200 ©2400 

Modem Port: © ‘@) 

Phone Type: @ Tone © Rotary 

Auto-Send Password: © Yes ONo 

When you have made the Setup/Telecommunications selection from the 

menu, the above dialog box appears. Just make sure the settings correspond 

_ to your password, phone type, modem speed, and so on. 

1. Account name — This is on the Accu-Weather Subscription Procedures 

— insert. 

a g Password — This is also on the Subscription Procedures insert. For 

security reasons, the actual password will not appear in the dialog box 

after the first time you type it in; it will be represented by dots: “e*eee”. 

Your password will also not appear on the screen when logging on the 

Accu-Weather’s computer. 

3. Phone #— This refers to Accu-Weather’s telephone number, which is 

_ provided on the Subscription Procedures insert. 
_ Some phones require extra digits or pauses in the dialing process. These 

can be included as follows: 
¢ Extra digits: If, for example, you have to dial “9” to get an outside 

line, simply put a 9 at the beginning of the number when you enter it. 
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¢ Pause: If your phone needs a pause in the dialing process, insert a 
comma at the point where the pause is required. * | 

4. Modem Type — Hayes modems (or 100% compatibles) are the only — 
acceptable modems. The Apple Personal Modem is Hayes-compatible. 

5. Baud Rate — Select 300, 1200 or 2400 depending on the speed of your cs 
modem. If you do not know which it is, refer to your modem’s manual. 

6. Modem Port — The modem can be connected to the “Modem Port” or the 
“Printer Port.” These are on the back of your Mac, and have icons to 
identify which is which. The modem is normally connected to the 
modem port. | - cen 

7. Phone Type — Your telephone line is either touch-tone or rotary (pulse). 
If you do not know which type your line is, listen as you dial. If you hear © 
“clicks”, you have a rotary phone. If you hear “beeps”, your phone is 
touch-tone. : 

8. Auto-Send Password — Set this to “Yes” to have the program 
automatically remember your password and send it to Accu-Weather 
during the log-on process. If you select “No”, the program will ask you — 
for the password before attempting to connect with Accu-Weather. This 
feature enables you to protect your account from unauthorized access 
when other people might be using your computer. 

Define Request 

Before you actually get the data from Accu-Weather, you predefine the 
information that you want to request using the Define Request Summary _— 
shown below. | | | 

This request chart is one of the most important parts of this program because 
it enables you to define your request in a visual and intuitive fashion — you 
don’t need to know anything about the specific data request formats 
required by Accu-Weather. | 

Furthermore, your request will be saved by the program, enabling you to 
enter your specifications just once if you usually request the same type of 
information. In fact, after defining your request the first time, you can skip 
the entire Define Request process if you just want to use your standard 
request. : 



- Define Request Summary 

Erase Keep Connect Disk 

Get Old Old “Time Space 

Data Data Data (mmi:ss) Required 

Hourlies/Forecasts...| K @ © 3:50 24K 

TU Graphics—Chart 1... @ 2) 0:00 OK O 

Cl ® O 0:00 OK 

- Total 3:50 24K 

UV Graphics—Chart 2 

The Define Request dialog box has three large buttons on the left: 

Hourlies/Forecasts... 

TV Graphics - Chart 1... 
TV Graphics - Chart 2... 

Each of these buttons brings up another dialog enabling you to select specific 

data or images to request. 

Get Data 

The Get Data buttons enable you to “turn on” your request for the types of 

data or images listed in each heading. If there is an “X” in the box to the 

right of the Hourlies/Forecasts... button, for example, the program will 

download the data you specified in the Hourlies/Forecasts dialog box. 

Keep or Erase Old Data 

Erase Old Data and Keep Old Data are settings you can choose for each 

category of data or images. For Hourlies and Forecast data, the Erase Old 

- Data setting will wipe out all information you've downloaded previously, 

and replace it with information from your new download. For TV 

Graphics, Erase Old Data will erase only those images that you're 

downloading again. If, for example, you previously downloaded a Full US 

Satellite Map, but you didn’t request one the next time, that map will not be 
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affected by the download. In general, Erase Old Data should be your default 
setting to save on disk space and make the program operate more quickly. 

The Keep Old Data setting, for Hourlies and Forecasts, will append new 
Hourly information to the old. Forecasts, however, are always replaced by 

_the new information. For TV Graphics, this setting simply means that no 

existing images are deleted. This can make a significant difference in the 
disk space required by the download, but will also give you the capability of 
“cycling” through the various versions you’ve downloaded of a single 
image, as explained in the TV Graphics section of the manual. _ 

Connect Time and Disk Space Calculations 

The Connect Time and Disk Space Required columns are calculations 
performed for you by the program to give you an advance notice of the 
requirements of the download. As you'll see as you experiment with 
defining requests, TV Graphics have a much larger effect than hourlies 
and forecasts on both the time and space required by a request. 



Requesting Hourlies and Forecasts 

From the Define Ramucst Summary dialog box, click on the 
Hourlies/Forecasts... button. The following dialog box will appear: 

Define Hourlies and Forecasts 

LOCAL : 

& Local Station: Windsor Locks, Conn 

bd Range = 250 miles (Set Range... %R 

ELSEWHERE 

(] Station List (Define List... 96L 

C] Map Region [Set Map Region... 3%M 

FULL US 

BJ 100 Major Stations ([]Al900+ Stations [1 | 
x] US Summary | 

Estimated Connect Time: 3 mins 50 secs POR cn! 

The dialog box has three headings: Local, Elsewhere, and Full US. The text 

boxes in the Hours column allow you to set the range of time for which you 

- want information, and the check boxes under Forecast let you choose 

_ whether or not to receive forecast data. The buttons in the middle of the box, 

Set Range..., Define List... and Set Map Region... offer ways of selecting 

information you want in the “Local” and “Elsewhere” categories. Let’s take 

a closer look at een element of the Define Hourlies and Forecasts dialog: 

isis Loual refers to reports from your own nearest NWS station, and the area 

around it: 

-¢ Windsor Locks, Conn — This is the nearest NWS station in our 

example. You should have already predefined your own nearest NWS 

station through the Setup activities (refer to: Setup). In the example, we 

are requesting hourly reports for the past 24 hours. To obtain forecasts 

from your local station, click in the first check box under “Forecast.” 

© Range — refers to all the stations surrounding your nearest NWS 
station, within a range of miles that you specify. In the example, we 

have selected all stations within 250 miles. To change the range 
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distance, simply click the Set Range... button and enter a number of 
miles. For information from stations within. your defined range, click 
in the check box to the left of “Range =. 

Elsewhere refers to stations elsewhere in the country. There | are two ways to 
specify such stations: 

° Station List — To define the station list, click the Define List button, and 
add stations according to their three-letter abbreviations (see the NWS | 
Station List section of the manual for a list of stations and their | 
abbreviations). The program will not allow you to enter invalid 
abbreviations. You can request hourly reports and/or forecasts for these 
stations by using the boxes under “Hours” and “Forecast.” 3 

e Map region — Set the Map Region by clicking in the Set Map Region... 
button. A dialog box with a U.S. map will appear. Set the region you 
want by simply drawing a rectangle on the map. The currently defined 
map region is shown on the map. You can request hourly reports, but not 
forecasts, for all stations in the map region. | 

Full US refers to reports encompassing the full éontiiental United States. 
The three options under this heading are: : 

¢ 100 Major Stations — There are approximately 900 weather reporting . 
stations in the US. One hundred of these are “major stations”. These are 
indicated by an asterisk next to the station name when you select 
stations to display in the Map, Picture, List, or Forecast functions of the 
Accu-Weather Forecaster. The NWS Station List in the manual also 
indicates which stations are major stations. You can request hourly 
reports from all 100 major stations in the US. You can specify the 
number of hours for which you want this information. 

e US Summary — This refers to a detailed description of current weather 

conditions provided 4 times a day by the National Weather Service. 

Not all stations give forecasts. The stations that do are indicated in the 
NWS Stations List in the Appendix. If, for example, you want a forecast for 
Denver, Colorado, simply look up Denver in the NWS Station List and find — 
out which station in or near Denver gives a forecast (in this case it is DEN). 
Then click on Define List and enter the station code or city name. (You can 
put as many stations as you want in the Station List). Don’t forget to click on 



the check box to the left of “Station List” (so your request will include the list) 

and on the second check box under “Forecast” (so your request will include 

forecast information). 

The “Estimated Connect Time” at the bottom of the dialog box indicates an 

estimate of the total amount of connect-time that the Hourlies/Forecasts 

portion of your request will require. This is important information because 

the fee charged by Accu-Weather is based on the length of time of your 

connection. While a normal request (at 1200 baud) might take three or four 

minutes, requesting eight hourlies for all 900 US stations would take almost 

a full hour. The program will not allow you to make a request that would 

take longer than 1 hour to download. Actual connect time may vary 

according to the time of day — some times are busier than others. 

When you finish defining your request, click on the OK button. This will 

save your selection criteria as the new default selection list. This means 

that this list will be used as the standard selection every time that you 

request new data from Accu-Weather (until you change the list). This is a 

real convenience, since you probably will want to use the same criteria each 

_ time that you get new data. 



Initiate Account 

Once you have entered all the Setup information, you need to initiate your 
account with Accu-Weather. This is done through an easy on-line 
procedure the first time you use Get Data to call Accu-Weather. Their 
computer will automatically recognize that yours is a new account, and 
take you through the steps to initiate your account, such as ask you for your 
name, address and MasterCard or Visa number. When this is done, the 
program will automatically proceed with a normal download. This 
procedure is only done once. Further details of abn your account are 
in the Accu-Weather Account Procedures insert. 

Get Data 

When you select Get Data, the Accu-Weather Forecaster will automatically 
get the data. The first steps are the only steps that require a response from 

you. The program will automatically: 
dial Accu-Weather’s telephone # © 
log-on with your account name and password 
request all the data that you specified i in “Define Reent: 
save the new data on disk 
log-off from Accu-Data 
convert the data from National Weather Service coded format to the 
format used by the Accu-Weather Forecaster 

If you want to end the call at any point during the above sequence, simply 
click the Disconnect button. 

BS Ow be Op eo 

Entering Your Password 

The Telecom dialog box, accessed through the Setup menu, allows you to set 
Auto-Enter Password to “Yes” or “No”. If you click the “Yes” button, the 
program will remember your password and send it to Accu-Weather 

automatically when you get new data. This is convenient, but it means that 
anyone using your computer can use your Accu-Weather account. If you 
need to restrict use of your account, set Auto-Enter Password to “No.” The 
program will then ask for your password each time you get data. When you 
enter the password, dots (*) will appear instead of the actual characters that 
you type. 



Explore Accu-Data 

Accu-Data (Accu-Weather’s database) has an incredible amount of weather 

information. Although the Accu-Weather Forecaster uses three of the most 
important types of data (hourly reports, forecasts, and TV Graphics), there 

are many other types of weather information available, including: 

¢ current weather reports from around the world 
¢ upper air data — 
-¢ farm weather information 
¢ aviation weather information 
¢ additional information about reporting stations 
¢ emergency weather bulletins 
¢ and more! 

When you select Explore Accu-Data™ from the Telecom menu, the Accu- 
Weather Forecaster will automatically dial-up and log-on to Accu-Data, 
and then leave you in control. Instead of doing the standard data requests, 
the program will let you make your own data requests interactively in a 
direct connection to Accu-Data. 

All the images and data that you request through “Explore Accu-Weather” 
are displayed on the screen, saved on disk and may be printed on your 

printer. (This information is not available, however, for use in the Graph, 
Map, List, or Picture displays of the Accu-Weather Forecaster). You can 
also download AMPS and TV Graphics images. In fact, Explore Accu-Data 

is the only way to download AMPS images with the Accu-Weather 
Forecaster. 

Some AMPS images are continuous — for example, you can watch 
lightning strikes occurring in real time all across the country. These 
images will stay on your screen (and you'll stay connected with Accu-Data) 

until you do something; either click the mouse or press any key. 

Accu-Data is designed for easy use, with access based on choices that you 
make from a series of menus. Here is a sample Accu-Data menu: 
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Accu-Data, Accu-Weather's Interactive Database 
Main Menu ¢(MAIN) 

17-JUL- 1990 02:28:47 GNT 

World Weather Observations 
Summaries, Discussions, Emergency Bulletins 
Forecast Products (Text and Computer ) 
Tropical Weather Information 
Historic and Climatological Data 
Miscellaneous Information 
Maps, Charts, and Color Graphics © 
Conversions 
Specialized Packages 
Exit Menu System 

1: 
2° 
3: 

4: 
bo 
6: 
oa 
8: 
9: 

QO: EXIT 1 

For Help, Type ? 
To Exit Menu and Help Files, Type <CTRL>Z 
To Exit Programs, Type <CTRL>C 
To Freeze Screen, Type <CTRL>S 
To Resume Screen Movement, Type <CTRL>Q 
To Offer Comments/Suggestions, Type FEEDBACK 

Selection: _ 

When you initiate your subscription with Accu-Weather, they will send you 
the Accu-Data User’s Manual, which describes the full set of weather : 
information that is available through Accu-Data, along with all the details | 
of how to access it. 3 : i“ | soe | 

Storing and Retrieving an Explore Accu-Data Session 

The information from your most recent “Explore Accu-Data” session is 
stored in a file called EXPLORAD. TXT. It is a standard ASCII text file, 
and may alternatively be displayed using a standard word-processing 
program. Images you select during an Explore Accu-Data session are 
saved under names you specify when you select the image from Accu-Data. 
AMPS images can be displayed using the AMPS Graphics selection from _ 
the Display - TV Graphics menu. TV Graphics images can be displayed 
using the Load Named Image selection from the Display-TV Graphics 
menu. atic , 
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Archives 

What are Archive Files? 

Archive files are for when you want to save weather information for long- 
term storage or later use. The only difference between an archive file and 
your current weather data files is that the program won’t automatically use 
the archive information when you select “Real Data.” Instead, you have to 
use the Open Archive command from the File menu. Archive files are data : 
files, and don’t contain AMPS or TV Graphics images. 

You might find archive files useful in a oiinber of situations. For example, 

you might want to save information about a pian storm or weather system 
as it passes through your area. | 

Open Archive, Save to Archive, and Erase Archive are available in the File 
menu: 

Open Archive.. 

save to Archive. a 
Erase Archive... 

/ Use Real Data 
Use Demo Data 

Save Screen... 

Page Setup... 

©00020000000000 00008000 00000000000000000000000000000000000000000000 



| Open Archive 

Pull down the File menu and select Open Archive when you want to get data 

from an archive file. The subsequent steps depend on which type of disk 

drive setup you have: : | 

If you have a single floppy disk drive, wait for the File dialog to appear, 

click on the Eject button, and insert your data disk in the drive. The name 

of that disk and its list of files will appear in the dialog, and you can select 

the file you want. The system will tell you when to reinsert the program 

disk. If you have two floppy disk drives, your archive disk can go in one 

drive while your Accu-Weather Forecaster system disk is in the other 

drive. 

If your archive data are stored on the hard disk itself, just select the proper 

folder and file in the Open Archive dialog box. 

In either case (hard disk or floppy), the program will search for all archive 

files on the selected disk. It will list those files in the Open Archive dialog 

box Here is an example: | 

Use Archive File... 

| D archive 1 <> MaciInternal 

D Archive 2 
2 Archive 3 

DO AWFArchive 



Each of the items listed is a separate archive file. Use the standard selection - 
procedures to select one of the archive files. If you decide not to use one of 
these archive files, simply click on the Cancel button. 

The archive file that you select will then become the aes data set, and all : 
subsequent displays will use data from the selected archive file. 

The fact that you are using archive data will be indicated i in the Display 
Identifier with an “Archive” label. | 

STATION: Windsor Locks, Conn *ARCHIVE* INFO: Temperature(deg F) 
DATE: Sun Jan 24, 1988 *DATA* TIME: 10:50 p.m. 

Save to Archive 

“Save to Archive” lets you cligate! new vinbliive files s containing the peer 
information you’re currently using. 

Creating an archive disk simply saves Ae current data to a Aicacais 
archive file. When you select Save to Archive, the program will present the 
standard Save File dialog box asking you to name the new archive file. The 
disk on which the file will be saved is indicated at the top of the list of files — 
and folders. Change disks, if you wish, by clicking on the Drive button. 

Files are named just like any other Macintosh files — up to 63 characters 
long, and don’t use the colon (“:”) character! 

If there is not enough space on the disk you select, you will be Prompted to 
insert another initialized disk or to cancel the archive. Once the saving is 
complete, you will be able to use this data i in the normal Open Archive 
process, as described above. 

NOTE: Forecasts can not be archived; Hea reports are the only data that 
are saved to archive files. 



Erase Archive | 

Select Erase Archive from the File menu when you no longer need a partic- 

ular archive file, and you want to permanently erase it from the archive 

disk. 

You will first be asked to select the archive file (using the same procedure 
described in Open Archive). You will then be asked to confirm: 

_ “Are you sure you want to permanently erase Filename?” 

If you click OK, the selected archive file will be erased from the disk. If you 
click Cancel, this activity will be cancelled without erasing the file. — 
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Problems & Solutions 

You aren’t likely to have any problems with the Ace Weather porecaawr, 
but just in case, here are some possible “fixes”: 

* 

The menu bar and menus don’t cirrestdad to the manual. _ 
You are probably using older versions of the System and Finder. Get 
System Software Package 6. 0. 4or higher from your eee dealer and 
install it. ar 

The modem won’t connect with Accu- Weather, fac! 
aan the following: 

Is the modem plugged into the port you indicated i in the Setup- 
Telecom dialog box? 

2. Did you select touch-tone dialing when your phone line can only 
accept pulse dialing? 

3. Did you specify the correct number for AccuWeather, Inc. in Setup: 
Telecom? 

4. Did you specify the correct baud rate for your modem in ‘Setup: 
Telecom? For example, if you select 2400 baud and you have a 1200 
baud modem, it won’t work until you select 1200 baud. 

Printing Problems | 
1. Did you use the Chooser (under the “&” comps to balou your printer? 
2. If your Macintosh can display color, your AMPS and TV Graphics 

may print more clearly if you go to the Control Panel (under the “é” 
menu) and use the Monitors control to switch your system to black 
and white only, then print. 

3. And (please excuse us for even mentioning this. . ) is your printer 
turned on? 

The program doesn’t accurately pick the “most recent date” or “most recent 
time.” 

The date and time on your Macintosh may be set incorrectly. If you 
correct the time or date a) the problem recurs, you may need a new 
battery. 



‘During an “Explore Accu-Data” session, you get “stuck” on one image. 
You have most likely encountered a continuous display (one that will 
simply stay on your screen until you cancel it). For example, the USA 
Lightning Strikes display will keep showing you lightning strikes as 
they happen until you cancel it. To cancel a continuous image, simply 
click the mouse or press any key. 
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Weather Information 

The types of weather information available through the Accu-Weather 
Forecaster are as follows: 3 : 

Barometric pressure — the “weight” of the ab which is an important 
means of monitoring weather changes. Low pressure generally means _ 
precipitation, high pressure generally means clear skies. The unit of 
measurement is “inches of mercury”; the Accu-Weather Forecaster 
leaves out the decimal point (2950 means 29. 50) 
Temperature — outdoor temperature in degrees Fahrenheit | 
Dew point — the temperature at which dew would form, which is an 
indication of the level of humidity — the higher the dowpoint the greater 
the humidity. An important consideration is the number of degrees 
separating the dew point value from the actual Se The unit of 
measurement is degrees Fahrenheit. 
Wind direction — the direction which the wind is blowing from (the 
source of the wind). Depending on the eth of display, the unit of 
measure is: | 

1. degrees (0 to 360) 
2. letters (e. g. NE for northeast) — 

3. arrows (with the wind blowing from the tail: to the head). 
Wind speed — the speed of the wind in miles per hour : 
Wind gust — the highest speed of brief gusts that are significantly 
stronger than average, reported in miles per hour 

Visibility — the ground level visibility in miles _ 
Precipitation — type of precipitation, using a simplified set of 
categories. (Amount of precipitation is indicated with a + [heavy] or - 
light]) 2 | 

Rain (R) 
Snow (S) 
Freezing Rain/Sleet (Z) 
Hail (H) 
Thunderstorm (T) 

Tornado (Tornado) : 
Cloud base — the lowest level of cloud cover (excluding thin nee) 
The unit of measurement is thousands of feet. 



° Cloud amount — the total amount of cloud cover (incorporating all 

layers into one figure, and excluding thin clouds). The unit of 

measurement is percentage. 

e Fog— the pponerce or ahebnse of fog or haze 

— Codes 

Hourly eather antes indicate precipitation and obstructions to vision 

using a standard set of about 25 symbols. The Accu-Weather Forecaster 

groups these into the following general categories (Fog is displayed 

separately from precipitation): 

Rain (R): oe ee Snow (S): 
R Rain | as S Snow 
RW _ Rain showers SG Snow Grains 

a Drizzle 3 SW Snow Showers 

| 3h SP Snow pellets 

Freezing Rain/Sleet (Z): BS Blowing snow 

ZR Freezing rain 
ZL ~=s«*Freezing drizzle MHail (H): 
IP Ice pellets A Hail 
IPW Ice pellet showers 
IC Ice crystals Thunderstorm (T): 

as | T Thunderstorm 
Fog (fF); Bes | 
F- =Fog Tornado: 
GF Ground fog TORNADO Tornado 
IF Ice fog 7 FUNNEL Funnel cld 
H Haze SPOUT Water spout 

Obstructions to vision Intensity (for all the above): 

-  K Smoke © : + Heavy 
D_ Dust - Light 
BD Blowing dust 
BS Blowing sand 



Interpreting Raw NWS Hourly Reports 

The weather information used in the Accu-Weather Forecaster comes from 
the National Weather Service hourly reports. Although this program 
automatically interprets the raw data for use in the displays, you may want 
to examine the raw data yourself. You can display the most recently 
acquired hourly reports by selecting "Examine Raw Data” from the 
“Telecommunications” menu. : 

To aid you in the interpretation of the raw data, here is an example: 

BDL SA 1850 3 OVC 7S- 993/22/17/0109/948 

Here’s what that coded report means: 

BDL = Windsor Locks, Conn. 

SA = Standard hourly report 
1850 = 18:50 GMT or 2:50 p.m. EST 
3 OVC = Overcast clouds at 300 feet 
f = 7 mile visibility 
S- = light snow 
993 = barometer reading is 999, 3 mb (29. 65 in) 
22 = temperature is 22 degrees F. 
17 = dewpoint is 17 degrees F. 
0109 = wind is from 10° (N) at 9 knots (10 mph) 
948 = altimeter reading (not used in program)) 



See Scheme: 

e Station code — a three hice station code 

¢ Type of report 
: SA=Standard hourly report 

SP=Special report indicating a significant change 
-RS=Special report that is also an hourly report 

e Time — in GMT, standard reports are done between 50 and 59 minutes 

after the hour 
* Cloud height — in hundreds of feet. Method of bs ont 3 is 

sometimes added (M=measured by instrument, E=estimated by pilot or 

balloon, W or I=indefinite). V means variable 

e Cloud amount — tenths of cloud cover (repeated for each layer of clouds), 

as follows (“—” means thin): 
CLR=clear(0) 

_ SCT = scattered (1-5) 
BKN = broken (6-9) © 
OVC = overcast (10) 

¢ Visibility — ground level visibility in miles 

© Weather — coded indication of current weather and/or obstructions to 

_-vision (refer to Precipitation Codes below) 
-e Barometric pressure — sea level pressure in millibars, omitting the 9 or 

10 and without the decimal point (255=1025. 5 mb) 
© Temperature — in Fahrenheit 
© Dew point — in Fahrenheit , 

¢ Wind direction & velocity — first two digits are direction in tens of 

degrees (e.g. 32=320°); second two digits are speed in knots 

e Altimeter setting — a barometrig pressure/altitude reading used by 

pilots 

e Remarks — speciniscnd remarks usually related to aviation and a 

description of the current weather © 



Files Created and Used by the Program 

The Accu-Weather Forecaster uses and creates a number of files. These 
files must be stored in the same folder as the Accu-Weather Forecaster — 

Program. These are the standard files ee by the program, not 
including TV Graphics images: 

SampObs hourly observations 
SampObs. Key a key to observation data 
SampObs.Txt hourly observations in raw text form 

SampFC.Txt forecast data : 

AllObs current hourly observations _ 
AllObs.Key key to current hourly observations 
ExploreAD.Txt raw text from most recent Explore Accu-Data 

session | 

FCast.Txt current forecast ifsifiition 

Newtel.Txt latest downloaded raw data 

TV Graphics image files downloaded automatically by the Accu-Weather 
Forecaster are assigned filenames according to image type, date, and time. 
This information is encoded into ASCII characters, resulting in filenames 
with seven letters such as “AAAHBBN”. Appended to these letters is an 
extension, either “.TV1” or “.TV2”, mae the association of the image 
with TV Graphics Chart 1 or Chart 2. : 

AMPS and TV Graphics image files downloaded during an Explore Accu- 
Data session are assigned filenames by the user. Any legal Macintosh 
filename can be used (maximum length is 63 characters including folder 
names; the colon character is not allowed). = 



Command Keys in the Accu-Weather Forecaster 

The following command key combinations are available in the program. 

To use any of them, press the Command key and the key indicated: 

Command Key Menu Effect 
Q File Quit 

D Telecom Define Request 
G Display Graph Display 

M Display Values Map 

S Display | Shaded Contour Map 

K Display Color Contour Map 

P Display Picture Display 

L Display List Display 

F Display Station Text Forecast 

T Display TV Graphics Chart 1 

+ Display TV Graphics Chart 2 

W Display AMPS Images 

1 Select Barometric Pressure 

2 Select Temperature 

3 Select Dew Point 

4 Select Wind Direction 

5 Select Wind Speed 

6 Select Wind Gust 

7 Select Visibility 

8 Select Precipitation 

9 Select Cloud Base 

0 Select Cloud Amount 

- Select Fog 

N Select Nearest Station 

A Select USA Major Stations 

R Select Range 

: Select Previous Date 

° Select Next Date 

; Select Previous Hour 

Select Next Hour 
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Pe 
A, 
A, 
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NATIONAL WEATHER SERVICE STATIONS 

Map of Major NWS Stations 

Forecaster 

STATION: USA--Major stns *DEMD* INFO: temperature (deg F) 
DATE: Mon Jan 22, 1990 *DATA* TIME: 8:50 PM EST 

GGH” MOT “INL 

MLS___BIS__FAR /JODLH ras 
BIL ‘S sMsP 

RAP HON. \ pe 
ALO-MSN /GRR b X ROC 

OFK DSM/ es 
cvs te Pa PIA FHA 

GUT DEN ACY 
OCA 

LDAY PITS: 
ee. RSL cou doy" X CR" 

DDC SGF_ (PAH _JKL___ 
BNA _L~TRI 

“PY 

ORL 

MIA 

Whenever you select “USA Majors”, the stations shown above are used. To 
see this map on your screen, select Demo Data from the File menu, hold 
down the Command and Shift keys, and press the “/” key. 

Also, whenever you select more than 100 stations, your station selection list 
is automatically reduced to eliminate stations that are not “major” stations. 
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List of all Stations 

Key to Column Labels 

National Weather Service station code 
City name | 
“Y” means one of the 100 “USA Major stations” 
“Y” means reports 24 hours 
“Y” means produces “Chart” forecasts 
“Y” means produces “Text” forecasts 
Latitude of station 
Longitude of station 

Alabama 

31°54 | 86°00 
33°12 | 87°36 
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| City | Maj] 24 [Cht| Txt] Lat | Long | 
Alameda | | YJ] 37°48 J 122718 
Ll) es ad ae aaa See oS ee a 
fArcata | Va Y_[ YD 1 41°00: [124°06 
Bishop SY red ited 

BNY.| Burney | | | | | 40°48 |121°42 
(CIC. -hChicg 1 39°54 421°64 
|CCR[Concord so] | Ct | 98°00 1122°30_ 
_ CEC |[CrescentCity | | | | __—*4. 41°48 1124°12 
NRC |CrowsLanding | | | | 37°24. 1121°06 
| BLU [EmigrantGap | | | | _.39°18|120°42 

: 40°47 
| SUU-| Fairtield | | 98218 121°6 4 

HWD|Hayward | 87°36 [22°12 
LLVK-| Livermore =. [|p 37°42 1121248 

[MMH |MamothLakes [| [| | |. 37°24] 119°00__ 
[BAB |Marysville/Beal_ | | Y | |_|. 39°06 |121°24 

_ LMYV [MarysvillefYuba_| | | 39°06 1121°36 
_ [:MER-[ Merced. 5] | -¥ |---| 1 97°24 1120536 

[-MOD-| Modesto: a= f= 4 = 97°42 112094 
| SIY -| Montague = | |} | 41°48 1 122°30 
MHS [MtShasta | | | CY «41°18 J 122018 

(LAPC-[ Napa. | fe 8c 2 ees. | 
OAK {Oakland | TY 37°48 122°12 
RBI. Red-Blutt an eae 
RODD [Redding | | || YY 1 40°30 [122978 = 

= Sacramento/Mthr| | Y [| |_| 38°36|121°18 _ 

[SOL PSanCarlos— = 4} i 280 4229418 

California (North) 

Sacramento/Exec 38°30 |121°30 

Sacramento/Met | [| | | __[ 38°42]121°36 __ 

Sacramento/Mcin| | Y | |. |38°42|121°24 

| SFO |SanFrancisco | Y | Y | Y | Y_137°36|122°24 | 
| SJC.[San-Jose |]. | 
| STS.[Sta Rosa. }-4-—fJ | 38°30 
| 087 |ShelterCove | {| | 
LTVt [SouthLk Tahoe | [| 

8 
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Idaho (cont.) 
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Massachusetts (cont.) 
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Nevada (cont.) 
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New York (cont.) 
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North Carolina (cont.) 
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Ohio (cont.) 
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Pennsylvania (cont.) 

[Harrisburg | | Y | T4093 | 76°51 
‘Harrisburg __|_Text Forecast Only _| 40°13] 76°51 __| 

LLNS [Lancaster | So] S| ST 40°08 | 
LLBE |Latrobe | SC] TT 40°17] 79°24 | 
_AOO|Martinsburg | | S| 40°18 | 78°19 
| MDT {Middletown ss | | S| ST 40°12 | 76°46 | 
_ PHL [Philadelphia | | Y_ | Y [| Y | 40°05] 75°01 __ 
_PNE [PhiladelphiyN [| | Y | | _—i}. 39°53] 75°15 | 
LAGC {Pittsburgh | | S| 40°21 | 79°56 | 

_RDG {Reading ss |_ | S| Tf 40°23 | 75°58 | 
_UNV [State College [| {| | | 40°48 | 77°52 | 
_AVP [Wilkes-Barre | | Y_ | Y | _Y_ [41°14] 75°53 | 
_IPT_|Williamspot_ [| | Y_| Y_ | Y [41°15] 76°55 __ 
LNXX [WillowGrove | | Y | [40°11] 75°08 | 

Rhode Island | 

[Code [Citys [ Maj] 24 [Cht[ Txt] Lat [Long 
| BID _| Block Island Fae (es Ed Pe Fa ee ke 
_PVD [Providence | =| Y | Y | Y [41°44] 71°26 _ 
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South Carolina (cont.) 
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Tennessee (cont.) 
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Texas (cont.) 

_GVT {Greenville | =| =r TT 33°00 96°00 
GDP |Guadalupe Pass [| [| | 31°48 [104248 
WHAL [Harlingen s| | 26°12 7 97°42 

HDOTHondo | | | pegsa4]_geci2 
_EFD |Houston/EIngtn | | Y [ [29°36] 95°12 
HOU |Houston/Hobby | | Y [| Y [29°42] 95°18 
LIAH_|Houston/int_ [| [| Y | Y [| [29°54] 95°24 
JCT |Junction ss | rT CT 30°30] 99°48 

_GRK |KilleerGray [| Y [| [31°06] 97°48 
LHLR |Killeen/Hood [ [| Y | | [31°00] 97°48 
OO ingevilecs fe |e 780g 87 754- | 
LAD |Eareda | 27830) 09724 

GGG [Longview ss | [32°48 7 94°42 
.LBB [Lubbock Ss | dT Y ‘| Y JY [33°42[101°48 
REE |Lubbock/Reese |_| Y [| [33°36 ]102°06 
SEER UEuiine | | EN es 3172] aaa 
SMARE [Mara 2. T0824 [104700 
EMER [McAllen 20 | eT e6eied 98712 
PE MAES Midian jp | | YY | Y [rb iaperiay 
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Wheelina 

isconsin W 

| City” | Maj 24 [Cht 
Appleton 

Camp Douglas 
Eau Claire 

sh 
O
l
o
m
N
n
i
s
 

l
e
 

O
j
i
r
i
s
t
 
i
l
o
 

© 
fo 

fo 
fo 

©
 

O
i
o
k
i
 is
 

pa | 
c
o
 

G
>
}
 
00} 

CO} 00} 
C
O
 

( 

+
i
O
i
C
O
l
 
+
1
1
]
 

C
1
 
O
/
O
l
o
;
l
o
 

©
/
0
0
 

hand 
L
O
I
M
I
M
M
L
M
I
 
C
h
o
l
 
y
t
l
O
o
r
m
o
l
i
a
r
i
o
 

o
i
s
 

a
 

SISleuleolololslololsitiiolsis 

x 
>| 

[>| 
[>f 

[> 
_
 L
P
P
L
P
L
E
E
L
P
L
E
L
E
L
L
 

L
P
P
E
P
L
P
L
P
L
E
L
L
L
L
 

L
E
P
L
E
L
 
P
E
E
L
E
 
L
E
E
 

slE 

Jamesville 

Milwaukee/Mtc 

Rhinelander 

LSE [LaCrosse 

Green Ba 

WC | Milwaukee/Tm 

L 

NR | Lone Rock 

S
B
E
 
M
E
I
 

(er: ee 
[Cheyenne ___ 

OD [Comyn 
VW {Evanston ___| 

Gcc {Gillette 

C 
C 
3 

Appendix 133 



Wyoming (cont.) 

Appendix 134 





Accu-Weather Account 72 
Initiating Account 80 

AMPS Graphics 65-68 
Downloading 66 | 
MacPaint Files 68 
PICT Files 68 
Printing 67 

Archive Data 33 
Archives 84-87 

Erase 87 
Open 85 
Save 86 

Command Keys 97 Ss 
Data in the Accu-Weather Forecaster 32 
Daylight Savings Time 6, 39 
Deleting TV Graphics 62 
Demo Data 32 

Display Identifier 12 
Displays 

Graphics 48 

AMPS Graphics 65 
Graphs 48 
Maps 51 

Picture 56 

TV Graphics 57 
Text 42 

Forecasts 42 

Lists 45 . 
_ Easy Guided Tour 10-30 

AMPS Graphics 28 
Demo Data 10 
Forecasts 24 

Graphs 12 
Maps 15 

Named Images 29 
Picture View 20 
TV Graphics 26 _ 

Equipment Requirements 3 
Explore Accu-Data 81 

Index 136 

Filenames used by software 96 
Forecasts 42 ‘ 

Chart 43 
Text 42 

Graphs 48 

Overlays 48 
Remove Overlays 49 
Special Characters 49 

Installing the Program 4 
Lists 45 

Sorting 45 
Maps 51 

Contours 17, 55 | 
NWS Major Sations 100 
NWS Major Stations 

on screen 35, 100 

Values 17, 54 
Modem 

Installation 72 
Modem Port 7 | 
Special characters 7 
Type 3,7 — 

National Weather Service 
Major Stations Map 100 
Station codes 101-134 

NWS Reports 94 
Codes 95 

NWS Stations 13 
Chart Forecast 6 
Nearest 5 

Text Forecast 5 
Password 7 

Auto-Send 7 
Picture Display 56 
Precipitation Codes 93 
Printers 3 

Real Data 33 

Selecting Data 34-39 
Dates 37 _ 



Info 36 

Stations 34 — 
Times 38 

Seup5 
Station Info 5 
Telecom Info 6 

Starting your Accu-Data Account 80 
Stations | 

NWS station codes 101-134 
System and Finder 3 
Telecommunications 70-82 

Connect Time 76 
Define Request 74. 
Explore Accu-Data 81 
Initiate Account 80 
Old Data 75 
Setup 72 

Troubleshooting 90 
TV Graphics 57-64 

Cycle 62 
Deleting 62 
MacPaint files 64 
PICT Files 64 
Printing 64 

Weather Information 92-9 
Codes95 : 
NWS Reports 94 

Index 137 | 



ate 
— Pe 



a
a
y
 

: 
Hes 

¥ 



VACATIONS FARMING COMMODITIES SPORTS EVENTS FLYING 
BUSINESS TRIPS GARDENING INDUSTRY OUTDOOR CONCERTS CONSTRUCTION 

PICNICS SAILING TEACHING INSURANCE UTILITIES 

2190020-016001 

Now, you can log on to the 
“world’s largest on-line 
_ weather service— 
‘Aecu-Weather®...the weather 

service ‘sed by network TV stations, radio 
forecasters and major U.S. newspapers. 
The Accu-Weather Forecaster™ includes 

ih 

a customized account name and password. 

Access all the information the weather 
pros utilize displayed exactly as they use 
it or in our “Home Use” mode for easier 

_viewing. Hourly weather conditions from 
thousands of locations around the world. 
All official forecasts, warnings, watches, 
and advisories and live lightning strikes, 
satellite pictures and radar displays. Plus 

over 25,000 other products, off-line 
analysis mapping and graphic of data. 

FUN 
Get a forecast from the pros or create 
your own! Watch storms as they move 
across the country toward you. Create 
your own customized Color Contour Maps. 
Choose the weather stations you would 
like to view and select temperature, baro- 
metric pressure, visibility, or any one of a 
dozen different data types. You may also 
zoom in on your maps and zoom out 
again—ALL-OFF-LINE! 

THE SOFTWARE TOOLWORKS 

60 Leveroni Ct. * Novato CA 94949 

(415) 883-3000 FAX (415) 883-3303 

Cotor,Lantours 

Fully automated telecommunications and 
access. Menus let you select the informa- 
tion you want, then sit back and watch 
the information roll in. Use Graph View to 
analyze data with ease, as you plot dew 
point versus time over the last 24 hours 
and overlay a plot of cloud base on the 
same graph. 

EXCITING 

See the location of lightning strikes even 
before you hear the thunder! Access dam- 
age reports from tornadoes, hail, severe 
thunderstorms exactly as reported by 

Actual unretouched screen shots 

police and other emergency response 
agencies. Get the inside scoop on 
National Weather Service internal 
discussions! 

What does it look like out the window? 
Let the Accu-Weather Forecaster show 
you with the Picture View. Where are the 
hottest and coldest places right now? 
Find out with List View. Sort the weather 
stations from highest to lowest pressures, 
from windiest to dead calm, or by any 
other data type. 

Full color graphics in rich detail, sophisti- 
cated graphs and charts, and Accu- 
Weather’s proprietary high resolution 

Advanced Map Plotting System™ 
(AMPS™ give you unlimited display 
capabilities). 

You predefine your request; get the data 
and graphics, then disconnect—all further 
graphic display and analysis is done with 
no additional connect time. And Accu- 
Weather provides discount rates to users 
of this software. ) 

Copyright © 1990 Metacomet Software, Inc. Copyright © 1990 The Software Toolworks, Inc. All rights reserved. Accu-Weather 
is a registered trademark. Accu-Weather Forecaster and Advanced Map Plotting System are trademarks of 

Accu-Weather Inc. 
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This Forecasting Guidebook is designed for use with the AccuWeather 
Forecaster, a computer program which uses telecommunications to access 
and display live weather data. 

The Accu-Weather Forecaster is a product of Metacomet Software, Inc., in 
cooperation with Accu-Weather, Inc. Copies of the program are available 
through software dealers and directly from Metacomet Software. 

The screen images shown in this book are from the IBM® version of the 
program. The Apple® Macintosh® version is similar, although there are 
some variations. Refer to the User’s Manual for detailed instructions in the 
use of the program. 

Metacomet Software, Inc. Accu-Weather, Inc. The Software Toolworks, Inc. 
~ P.O. Box 31337 619 W. college Ave. 60 Leveroni Court 

Hartford, Connicticut 06103 State College, PA Novato, CA 94949 
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Trademarks 
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IBM is a registered trademark of International Business Machines Corpora- 
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Inc. : 

THE TRADEMARKS OF ACCU-WEATHER, INC. AND THE ACCU-WEATHER 
NAME SHALL NOT BE USED BY PURCHASERS OR USERS OF THE 
SOFTWARE IN ANY WAY, ESPECIALLY NOT AS A MEANS OF IDENTIFY- 
ING THE SOURCE OF THE UNDERLYING DATA SERVICE TO PUBLIC 
AUDIENCES OF CLIENTELE, AS THESE ARE THE SOLE AND EXCLUSIVE 
PROPERTY OF ACCU-WEATHER, INC. 



THE SOFTWARE TOOLWORKS LICENSE AGREEMENT 

This is a legal agreement between you, the end user, and The Software Toolworks, Inc. ("Toolworks"). BY OPENING THE , 
SEALED DISK PACKAGE CONTAINING THE rape YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS 
AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, PROMPTLY RETURN THE UNOPENED 
ENVELOPE WHICH CONTAINS THE aiahone DOCUMENTATION, PACKAGING AND ALL OTHER ITEMS INCLUDED WITH 
THE SOFTWARE ("TOOLWORKS PACKAGE") TO THE TOOLWORKS AT THE ADDRESS INDICATED BELOW. 

TECHNICAL SUPPORT. If you are having any problems with the Toolworks Package, or if Pb have any questions 
Se this agreement, contact the Software Toolworks’ Sales and Service at 60 Leveroni Court, Novato, CA 94949, 
or call (415) 883-3000. 

THE TOOLWORKS SOFTWARE LICENSE 

1. GRANT OF LICENSE. Toolworks and its suppliers grant to you the right to use one copy of the software program 
("Program") which is included with the Toolworks Package. You may not network the Program or otherwise use it on more 
than one computer or computer terminal at the same time. 

2. COPYRIGHT. The Program included with the Toolworks Package is owned by the Toolworks or its suppliers as set. 
forth in the Program or associated documentation and is protected by United States copyright laws and international 
treaty provisions. You may not copy the Program except as provided in this Agreement. You must treat the Program like 
any other copyrighted material (e.g. a book or musical recording) except that you may either (a) make one copy of the 
floppy disks, if any, on which the Program is recorded solely for backup or archival purposes, or (b) transfer the Program 
on floppy disk to a single hard disk, provided that you keep the original floppy disk solely for backup or archival purposes. 
You may not copy the written materials accompanying the Program. 

3. OTHERRESTRICTIONS. You may not rent or lease the Program, but you may transfer the complete Toolworks Package 
ona permanent basis, provided that you retain no copies and the recipient agrees in writing to the terms of this Agreement. 
You may not reverse engineer, decompile or disassemble the Program. 

4. DUAL MEDIA SOFTWARE. If the Software Package contains both 3 1/2" and 5 1/4" disks, then you may use on the 
disks appropriate for your single-user computer. You may not use the other disks on another computer or loan, rent, 
see or transfer them to another user except as part of the permanent transfer (as provided above) of the entire Toolworks 
ackage. 

5. YOU MAY NOT USE, COPY, MODIFY, OR TRANSFER THE PROGRAM OR ANY COPY IN WHOLE OR IN PART, EXCEPT 
AS EXPRESSLY PROVIDED IN THIS LICENSE. ALL RIGHTS NOT EXPRESSLY GRANTED ARE RESERVED BY THE 
TOOLWORKS OR ITS SUPPLIERS. 
LIMITED WARRANTY 

LIMITED WARRANTY. The Toolworks warrants that with respect to the Program contained in the Toolworks Package, the 
media upon which the Program is recorded shall be free from defects and workmanship under normal use and service 
for a period of thirty (30) ee from the date of purchase. Any implied warranties on any Program is limited to thirty (30) 
days. Some states do not allow limitations on duration of an implied warranty, so the above limitation may not apply to 
you. 

CUSTOMER REMEDIES. Toolworks’ entire liability and your exclusive remedy shall be, at Toolworks’ option, either (a) 
the repair or replacement of the specific Program and diskette that does not meet Toolworks’ Limited Warranty and which 
is returned to the Toolworks witha ld A your receipt; or 6) arefund of the price, if any, which you paid for the individual 
Program and diskette. This Limited Warranty is void if failure of the Program has resulted from accident, abuse, or 
misapplication. Any replacement Program will be warranted for the remainder of the original warranty period or thirty 
(30) days, whichever is longer. 

NO OTHER WARRANTIES. WITH RESPECT TO THE PROGRAM AND THE ACCOMPANYING WRITTEN MATERIALS, THE 
TOOLWORKS, METACOMET SOFTWARE INC. ("METACOMET") AND ACCU-WEATHER, INC. ("ACCU-WEATHER’) DIS- — 
CLAIM ALL WARRANTIES, OTHER THAN THE ABOVE WARRANTY BY THE TOOLWORKS, EITHER EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. THE SOFTWARE TOOLWORKS, METACOMET AND ACCU-WEATHER MAKE NO EXPRESS OR IMPLIED 
WARRANTIES, GUARANTIES OR AFFIRMATIONS THAT WEATHER WILL OCCUR OR HAS OCCURRED AS THE REPORTS, 
FORECASTS, GRAPHICS, DATA OR INFORMATION ACCESSED AND/OR DISPLAYED BY THIS PROGRAM REPRESENT 
OR DEPICT AND THEY SHALL HAVE NO RESPONSIBILITY OR LIABILITY WHATSOEVER TO USERS OF THIS PROGRAM 
OR TO ANY OTHER PERSON OR ENTITY, PARTIES AND NON-PARTIES ALIKE, FOR ANY INCONSISTENCY, INAC- 
CURACY OR OMISSION FOR WEATHER OR EVENTS PREDICTED OR DEPICTED, REPORTED, OCCURRING OR 
OCCURRED. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHERS, WHICH VARY 
FROM STATE TO STATE. 

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. IN NO EVENT SHALL THE TOOLWORKS OR THE PUBLISHER OR 
OWNER OF THE PROGRAM BE LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, 
DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION, LOSS OF INFORMATION, OR OTHER PECUNIARY 
LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE PROGRAM, EVEN IF THE TOOLWORKS, METACOMET 
OR ACCU-WEATHER HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO 
NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE 
ABOVE LIMITATION MAY NOT APPLY TO YOU. 

U.S. GOVERNMENT RESTRICTED RIGHTS 
The Program and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the 
Government is subject to restrictions as set forth in subparagraph (c)(1) (ii) of The Rights in Technical Data and Computer 
Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software Restricted 
Rights at 48 CFR 52.227-19, as applicable. The Contractor/manufacturer is The Software Toolworks, Inc., 60 Leveroni 
Court, Novato, CA 94949. 

This Agreement is governed by the laws of the State of California. 

THE TRADEMARKS OF ACCU-WEATHER, INC. AND THE ACCU-WEATHER NAME SHALL NOT BE USED BY PUR- 
CHASERS OR USERS OF THE SOFTWARE IN ANY WAY, ESPECIALLY NOT AS A MEANS OF IDENTIFYING THE SOURCE 
OF THE UNDERLYING DATA SERVICE TO PUBLIC AUDIENCES OR CLIENTELE, AS THESE ARE THE SOLE AND 
EXCLUSIVE PROPERTY OF ACCU-WEATHER, INC. 
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Using This Guidebook 

The purpose of this book is to guide you through the 
process of forecasting the weather, using The Accu- 
Weather Forecaster and live weather data from 
Accu-Weather. The activities lead you to view the 
atmosphere in a number of different ways. Each view 
contains its own clues about the weather--now and in 
the future. 

Accompanying this book you will find a Forecast 
Worksheet. Use this worksheet to record your 
observations, comments, thoughts, etc., as you 
proceed through the activities. Having all the data in 
one place is a great help at forecast time. 

Also accompanying this book is the 24 Hour 
Weather Forecast form. Enter your forecast on this 
page. 

It is not necessary to complete each activity, every time 
you make a forecast! As you will see, there is no one 
right way to come up with a forecast. You probably will 
develop your own favorite method, which may include 
only a few of the activities presented in this book, and 
others not mentioned here at all. 

_ Of course, the more you know about the weather, the 
better your forecast is likely to be. Thus, the more 
activities you do, the better. However, if you want to 
skip some activities, here is some advice: 

1) 

2) 

3) 

Local weather (Activities 2 and 4) is important for 
every forecaster, no matter where you live. Always 
do these two activities. : 

The large-scale picture (Activities 6 and 7) also 
is essential for nearly every area. (But see the next 
item!) 

If you live in the very southernmost U.S., the large- 
scale weather map often will be less important - 
especially in summer. Regional weather (Activity 
5) will be more important to you. (But don't ignore 
the large scale picture entirely--you don't want to 
miss a hurricane!) 
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Some General Thoughts About Weather 
Forecasting 

There are two things the weather can do: 

(1) stay the same, or (2) change. 

If you think it is going to stay the same, you issue a 
“persistence” forecast: You say that tomorrow's 
weather will be like today's. 

Of course, eventually the weather will change. 
There are two basic ways the weather changes at a 
given place: 

1) weather patterns move, bringing in fronts, 
highs, lows, etc., from elsewhere (these are 
known as “advective changes"). 

2) weather patterns themselves change and 
develop, so that, for example, today's weak 
front may intensify and cause thunderstorms 
tomorrow (these changes are known as "local 
changes"). 

Thus, even if your local weather has been constant for a 
week, you must be sure that some weather system isn't 
going to blow in from elsewhere, before you select a 
persistence forecast (advective change). 

And, even if there are no signs of a weather system 
bearing down on you, remember that your weather still 
may change, as all the air around you gradually becomes 
warmer or more humid or whatever (local change). 
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Activity 1 
Getting the Data from Accu-Weather 

Several of the activities described in this activity guide 
require you to analyze current weather data from Accu- 
Weather. The procedure for getting data is detailed in 
the User's Manual. 

There are two ways for you to get the data required in 
these activities. You can either: 

1) request the data needed for all the sections all at 
once 

2) request the data for each section, one section at a 
time 

We recommend the first choice, since you will usually 
need to use the full range of data, and it is simpler to get 
it all at once. 

it Use arrows to move reverse color--<Return) to change value--<ESC) when done 
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Sample telecommunications data request 

The sample request chart shown above would enable 
you to get all the information that you need for these 
activities. The example is for someone living in central 
Connecticut - in your own case the nearest National 
Weather Service (NWS) station will be your own (as 
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originally defined by you in the Setup section of the 
- program). 

Notice that the sample request above will provide you 
with the following information: 

1) The past 24 hourly reports for the nearest NWS 
station 

2) Forecast information for the nearest NWS forecast 
station 

3) The most recent hourly reports from all stations 
within 250 miles of your home base 

4) The most recent hourly reports from 100 major 
stations around the country 

5) National weather summary discussion 

a: 

Activity 1-Getting the Data 6 



Activity 2 
The Weather at Your Doorstep 
Observing Local Weather 

If you were to make a trip around the world, where would 
you begin? At your own doorstep, of course. Similarly, 
to make a forecast of tomorrow's weather you begin with 
the weather on your own doorstep - the weather 
conditions right here, right now. Making a careful 
weather observation is the first step in forecasting the 
weather. In fact the easiest and sometimes the best 
forecast is simply to say that the weather will stay the 
same. Thus, if itis sunny today, you forecast sunny for 
tomorrow; if it is cloudy, then forecast cloudy. This is 
known as "persistence forecasting". Using only 
persistence forecasting you can be accurate some of 
the time; how often depends on where you live and the 
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time of year - and luck! So, first you need to observe 
your own weather. 

Observe weather conditions at your location now. 
Observe as many of these items as possible. Most of 
the items do not require special instruments. Record 
them on the Forecast Worksheet which 
accompanies this book. 

Clouds: 
Total cloud amt (in 10ths of sky covered) 
Cloud types observed 

Wind: 
Wind direction 
Wind speed 

Precipitation: 
Current 
Past 3 hours 

Barometric pressure: 
Current pressure 
3-hour pressure change 

Temperature: 
Air temperature 
Dew point temperature 

Other information: 
Visibility 
Relative humidity 

Examine your report carefully. Think about what each 
piece of information means. Now you have begun your 
forecast journey, in a most important way: you know 
your starting point! 
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Activity 3 
Checking Your Observation 
Is It Correct and Representative? 

It is a good idea to compare your observation with those 
at nearby stations. Observation errors can be caught 
this way. 

*DEMO* INFO: all 
*DATA* TIME: 8:50 Pi EST 

31° F 2885 1° 

DEW POINT BAR PRES, 

> Fog is present 

Sample display using Picture format 

1) 

2) 

Using the Picture format, display the latest 
weather information from two or three stations near 

you. 

Compare the data displayed with the data you just 
observed in Activity 2. (Some types of data, such as 
cloud types, are not provided in the hourly reports). 

Do the data look consistent? We don't expect the 
reports to match exactly, but they should be similar. 
Here are some ranges; normally we would expect 
the reports to match within these ranges: 

Total cloud cover: within 2/10. 
Wind direction: within 45 degrees 
Wind speed: within 10 miles per hour 
Precipitation: same 
Barom. pressure: within 0.05 inches 
Air temperature: within 5 degrees F 
Dew point temp: within 5 degrees F 
Visibility: both stns more than 5 mi 

(or both less than 5 mi) 
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Of course, if the “nearest station” is quite a distance , 
away, Or lies in a different setting (it's on the coast 
while you are inland, for example), items like winds, 
clouds, temperature and precipitation may differ 
more than the values shown above. Consider this 
as you compare values. As you compare, choose 
one of these three: 

a) Match--The data for this item match, within the 
ranges listed. 

b) Different setting--The data don't match, 
probably because of differences in the stations' 
settings (e.g you live inland but the reporting 
Station is on the shore). 

c) Unknown--The data don't match, and you 
don't know why. 

3) Look at the data for each station, comparing them 
with your own observation and indicating for each 
item whether it is a "match", “different setting” or 
"unknown". When finished, look back at the items 
you marked "unknown". There are two possible 
reasons for unknown: 

a) Mistake--You or the other observer made a 
mistake; 

b) Real difference--There is a real difference 
between the weather at your location and that at 
the other station, and it is not caused by 
differences in topographical setting. 

Check your own observation for each "unknown" 
you assigned; then make your own judgement 
whether each is an error or a real difference in the 
weather. 

4) Correct your observation if necessary as a result of 
step 3 above. 
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5) Now your observation is as reliable as possible, and 
you know about the weather at the stations 
immediately surrounding your station. Record your 
findings on your Forecast Worksheet, in the 
space provided. 
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caret for Trends in the Local Weather 

Sometimes you can spot weather changes by looking 
into the distance: you might see a line of thunderstorms 
moving in from the west, for example. 

In this activity you will try to spot weather changes by 
looking into the past. You will prepare plots of local 
weather conditions over the past few hours, and look for 
trends. This type of trend analysis is an important 
ingredient in any weather forecast. 

Of course, much of the hour-to-hour change in the 
weather is due to "diurnal variations". Diurnal 
variations are the daily rhythms of temperature, air 
pressure, etc. On a typical day the temperature will rise 
through the morning, reach a maximum in the 
afternoon, and cool throughout the night, reaching a 
minimum value around daybreak. Air pressure also 
shows a Slight daily rhythm, with highest values at 10 
a.m. and 10 p.m. local time, and low values at 4 a.m. and 
4p.m. Wind speeds tend to be lightest at sunrise and 
strongest in the afternoon. Even clouds show diurnal 
variations: stratiform clouds are most common in early 
morning, cumuliform in the afternoon. When you 
observe a trend in the local weather, be sure to consider 
it in the context of these normal daily variations. 

This activity uses the Graph display, in order to see 
changes over the past 24 hours. 

SS 
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Sample graph of barometric pressure changes 

1) Choose the Graph format, and change the station 
selection to the "Nearest NWS Station". 

2) Display the data for each type of weather | 
information. For each item (barometric pressure, for 
example), see if there seems to be: 

a) a trend toward higher values 
b) atrend toward lower values 
Cc) adaily up-and-down cycle (diurnal variation) 
d) acombination of the above 
e) no trend at all: values remain about the same 

throughout the day. 

3) Record your finding for each weather element on 
your Forecast Worksheet. 
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Activity 5 
Moving Outward - Observing Weather in Your 
Region 

Now we move a little farther away from home, 
and examine the weather within several 
hundred miles. To do this we will use The Accu- 
Weather Forecaster's Map format. 

We will focus on two types of weather 
information: cloud base and precipitation. 

Preparation: 

Choose the Map function, and change the 
station selection to a Range of 250 miles. (This 
will get data from all stations within 250 miles of 
your location.) 

Precipitation: 
STATION: USA--Major stns *DEMO* IKFO: precipitation (codes) 

DATE: ton Jan 22, 1990 *DATA* TIME: 8:50 PM EST 
F-] Light Heavy 
«| Moderate 

Rerein Sesnow Zafreezing rain/sleet T=thunderstorm Hxheil +=zheevy -zlight 

Sample map of precipitation 

1) Now choose a contour map for Precipitation (and 
ask for a display of values) ! 
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2) Print the map and study it, noting which stations are 
reporting precipitation. 

3) What patterns do you see on the map? Enter your 
observations onto the Forecast Worksheet. 

4) Ifyou have the appropriate weather data, repeat 
steps 1-4 for the previous hour. Compare the sizes 

_ and positions of the areas of precipitation on the 
_ Current map and the map from the previous hour. 
Are they growing? Moving? Record your 
observations on the Forecast Worksheet. 

Cloud Base: 

STATION: USA--Major stns INFO: cloud base (Th Ft) 
DATE: We d Dec 16, 1987 TIME: 9:5@ PM EST 

— 

Sample map of cloud bases, with values under 5,000 circled 

1) Display the values of Cloud Base for the region. 

2) Print the map. 

3) Forecasters are particularly interested in tracking low 
clouds (because most precipitation falls when low 
Clouds are present). With a pencil, draw a loop 
around the groups of stations which report cloud 

_ bases at or below 5,000 feet (indicated as 0 through 
5 on the map). 

4) Your map now shows you a detailed picture of the 
cloud bases in your region. 
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Activity6 
Highs, Lows & Fronts - Where Are They Now? 

H 
Wa 

| ao’ 

STATIONARY FRONT ao 
“e- BD, C G 

Typical US map with highs, lows and fronts plotted by hand 

Now you know the weather at your doorstep and in your 
neighborhood; the next step is to learn about the 
weather patterns farther away from home. If you were 
planning to travel across the United States on foot, you 
would want to study the topography of the country very 
Closely. You would want to locate mountain ranges too 
high to cross, valleys with rivers too deep to wade or too 
wide to swim, and places where the terrain would be too 
steep or rough to pass through. 

Similarly, if you're interested in travelling through the 
weather into tomorrow, you need to learn its 
topography. You need to “see” the lows and highs, the 
regions where steep pressure slopes cause strong 
winds, and fronts where sudden weather changes 
occur. Such highs, lows and fronts often are called 
“synoptic scale features". A typical synoptic scale 
feature covers a region hundreds of miles across, and 
has a lifetime of several days. Synoptic scale features 
are important because they control most weather 
events in the regions they cover. Synoptic scale 
patterns show the weather's topography. 

In this activity you will find the highs, lows and fronts of a 
typical weather map. , 
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A meteorologist could spend a week analyzing the 
synoptic scale patterns that prevailed at a single 
moment. This is not because meteorologists are 
especially slow, but because of the great richness of 
detail accompanying a typical high, low, or front. In the 
case of a low pressure system, for example, the 
meteorologist will want to know the location of the 
center, in what direction it is traveling and how fast, how 
large its cloud shield is, what kinds of clouds prevail in it, 
how the temperature and humidity vary across it, what it 
looks like at various heights above the ground, etc., etc. 

We don't suggest you spend a week on this activity. 
Instead, we will show you a number of ways of studying 
synoptic weather patterns. You certainly don't have to 
do all of them to come up with a forecast! But the more 
you know about the weather's topography, the better. 

Finding Highs, Lows, and Fronts - The Easy Way 

This activity tells you where professional meteorologists 
have located synoptic scale features for the present 
weather situation. This information is available every 6 
hours. 

Activity 6-Highs, Lows & Fronts--Now 17 



STATION: Full US INFO: Summary and Forecast 
DATE: see below TIME: see below 
AAARAKKARKRARRAAKCRRAKARRKKARKAKKAEKKRRRKLARAKARRAAKRARARRARRARARRRARRERE 

MAJOR MAP FEATURES AT 7 PM EST THURSDAY...A COLD FRONT CURVED 
FROM A LOW OVER SOUTHWEST MANITOBA /29.08/ ACROSS EASTERN NORTH 

‘ DAKOTA. ..-SOUTH CENTRAL SOUTH DAKOTA...THE NEBRASKA PANHANDLE... 
SOUTHWEST WYOMING...NORTHERN UTAH...WEST CENTRAL NEVADA AND 
.CENTRAL CALIFORNIA INTO THE PACIFIC OCEAN. A WARM FRONT REACHED 
FROM THE COLD FRONT OVER NORTHEASTERN SOUTH DAKOTA TO SOUTHWEST 
“IOWA. A COLD FRONT CURVED FROM A LOW OVER THE WESTERN SHORES OF 
NOVA SCOTIA /29.76/ ACROSS THE ATLANTIC OCEAN...THROUGH A LOW 
OVER EAST CENTRAL NORTH CAROLINA /29.70/...THEN CONTINUED THROUGH 
NORTHEAST GEORGIA AND THE CENTRAL FLORIDA PANHANDLE INTO THE 
NORTH CENTRAL GULF OF MEXICO. A LOW WAS OVER THE SOUTHERN TIP OF 
JAMES BAY /29.35/. HIGHS WERE OVER NORTHWEST NEW MEXICO /30.15/ 
AND THE NORTHWEST GULF OF MEXICO /36.00/. 

Portion of a sample "US Summary” report. 

1) Request "US Summary” from the Forecast 
menu. This gives the latest (every 6 hours) National 
Weather Service summary of highs, lows, and fronts 
across the United States. 

2) Plot the positions of the highs, lows and fronts onto 
a blank map. 

Finding Highs, Lows and Fronts - Do It Yourself 

Here you work with raw data to locate highs, lows and 
fronts. Although this is more work than the method 
above, it is your own work; and you can do it every hour, 
not just every 6 hours. 

SMIDATE: Fri Aug 24, 1990 Tr, 3:90 MET 
Elias Elva Elana [lamcom Baswosee 

mee] Ainoas ae i 

Sample shaded map of barometric pressure 

1) Choose the Accu-Weather Forecaster Map display. 
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2) 

3) 

4) 

9) 

6) 

1) 

8) 

Change the station selection to "USA Majors”. 
This provides data from 100 major weather reporting 
Stations throughout the country. 

Choose Barometric Pressure, and ask for 
contours with values. 

Print the map and study the isobar pattern carefully. — 
Notice that only the highest high and the lowest low 
will have labeled values. Look for any additional 
high and low centers, and label them “High” or 
“Low". 

The next step is to find the fronts - if any. Fronts lie 
through low pressure regions, on the boundary 
between a warm mass and a cold mass. Use the 
"Model Storm System" figure (pages 20, 21) to 
help you know what to look for. But remember: 
finding fronts on a map often is difficult; don't be 
discouraged if you have trouble. The remaining 
steps provide additional information to help you find 
the fronts. 

Request and print the following maps (still using 
"USA Major” stations): 

a) temperature (shaded) 
b) wind direction (arrows) 
c) cloud base (shaded) 
d) precipitation (shaded ) 

Study your maps of barometric pressure, 
temperature, wind direction, cloud base, and 
precipitation. Compare them with the model frontal 
system. Do you find evidence for fronts? If so, mark 
the fronts’ locations onto your isobar map. If not, 
perhaps there are no fronts on this map! And 
remember - actual weather conditions rarely are a 
perfect match with the ideal model. 

As you practice finding fronts by yourself, you may 
want to compare your findings with those of the 
NWS experts (refer to "The Easy Way" above). 
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The low _ pressure center 

(large L) is the center of activity 
for this storm system. Winds 
circulate around it in a counter- 
clockwise direction. There also 
is an extended area of 
precipitation and cloud cover. 

In the two high centers (large 

H's) skies are generally clear, 
with no precipitation. Winds 
circulate in a clock-wise direction 
around the highs. The high 
center on the left corresponds 
to a cold air mass. The high 
center on the lower right 
corresponds to a warm mass. 

Model Storm System 20 

A cold front (line with 

triangles) extends out from the 
Low center. This is the leading 
edge of a cold air mass moving 
in from the west, bringing in 
colder temperatures and 
northwest winds. Along the 
front, there is precipitation, 
inlcuding a thunderstorm. 

A warm front (line with half 

circles) extends out from the 
Low center. The warm mass 
south of the low center is 
moving northward, around the 
low center. There is an 
extended band of cloud cover 
and steady precipitation north of 
the warm front. 



How To READ A PLOTTED 
WEATHER REPORT 

Sample Station Model 

Temp or amt a Pressure 

“A 
us -hour Pres. 
symbol | Changes 

Wind eek Wind 
Direction ——Speed 

Clouds: Barometric Pressure: 

O Clear Numeric value is in millibars 
Go Partly cloudy e.g. 1018.2 —> 182 

OD Mostly cloudy 3-hour changes: 

@ Overcast / ~ Rising, then falling 

Precipitation: / Rising, then steady 
° Very light rain ff Rising steadily 

e° Light rain \/ Falling, then rising 

ee Moderate rain —— Steady 
Vv Rain shower Wy, Falling, then rising 

Tg Thunderstorm SS Falling, then steady 
| \ Falling steadily 

as “\ Rising, then falling 

Winds blow into the circle, 
along the wind arrow 

Wind: 

Short feather means 5 knots; 
long feather means 10 knots 
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Activity 7 
Highs, Lows & Fronts - Where Are They Going? 

As you know, weather systems don't tend to stay put. 
Highs, lows and fronts often move considerable 
distances from day to day. Thus, to make a forecast you 
need to know where the present weather systems are 
headed. 

Forecasters use a number of methods to predict how 
weather systems are likely to move. Many modem 
methods are very sophisticated, requiring detailed 
computer analysis of the atmosphere at many different 
levels. Here we will introduce two straightforward, 
uncomplicated methods: using continuity, and using 
upper air winds. 

Forecasting Using Continuity 

A girl went to the doctor complaining of a pain in her little 
toe. The doctor (who was not too smart) could not find 
anything wrong with the toe. Finally he asked the girl 
“Have you ever had this problem before?" "Yes, twice," 
the patient replied. "Well," the doctor answered, “you 
have it again.” What does this story have to do with 
weather forecasting? Not much, and a lot. Often, a 
meteorologist, wanting to know how fast a front or a low 
is moving, will ask “How fast has it been moving in the 
past?" When he finds the answer, he will likely say 
"Well, it will do it again.” 

How do you find out how fast a front has been moving? 
By sketching its changing position on a weather map 
every three hours or so. Once you have a collection of 
plotted past positions on your map, it's easy to predict 
the front's future movement. 

1) Take a blank map, and plot the position of each high 
center, low center, and front. Plot all of these 
features with a pencil of one color. In one corner of 
your map, label the date and time for all these 
features. 

2) Repeat this process for as many past maps as 
possible (back to 24 hours ago). Plot each set of 
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highs, lows and fronts onto the same map; use a 
different color for each time. A three hour time 
interval between maps is best. 

3) Now you can sketch future positions of each 
weather feature you have been following. Just draw 
them in, one more step in the direction they are 
moving. You can continue this process for up to 12 
hours or so into the future. This "continuity 
forecast" will be an important tool in making your 
final forecast. | 

Forecasting Using Upper Air Winds 

Picture an iceberg, floating low in the water. 
You know that much of the iceberg lies beneath 
the water's surface. How will the iceberg move? 
It will drift with the currents in which it is floating. 
Since the iceberg extends far below the 
surface, its motion will be influenced by deep 
currents. 

Like an iceberg, the highs, lows and fronts on a 
weather map are not flat. From earth's surface, 
weather systems extend thousands of feet 
upward into the atmosphere. And, like the 
iceberg, the weather systems are steered by 
the currents in which they are embedded. 
Thus, forecasters use "winds aloft", or “upper 
air", information to predict how highs, lows and 
fronts will move. 

Upper air observations are made twice daily, at 
7:00 a.m. and 7:00 p.m. EST. The data are 
collected by radiosonde balloons at about sixty 
stations nationwide. The radiosondes measure 
and transmit data on air pressure, temperature, 
humidity, and wind direction and speed, at 
many altitudes from earth's surface to the 
stratosphere. 

Forecasters have found that winds at approximately 
35,000 feet above the earth's surface have a strong 
influence over the motion of highs, lows and fronts 
across the earth's surface. Since jets often fly at this 
level, the winds at 35,000 ft. are called "jet stream 
winds" or “steering winds”. 
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Here is how to use the upper air jet stream winds: 

1) Fromthe TV Graphics--Chart 2 menu, select 
"JetStream". This will give you the latest 35,000 
ft. wind pattern across the United States. 

2) Examine the jet stream. wind flow. The graphic 
shows a band or bands of the strongest jet stream 
flow. These are the places where the jet stream 
winds will have the greatest effect. 

3) Compare the upper air map with the corresponding 
surface weather map. Imagine the steering winds to 
be "pushing" highs, lows and fronts across the map. 

4) Take a blank map, and plot the present positions of 
highs, lows and fronts. Then, using the steering 
winds, plot your estimated locations of these 
features 6 hours from map time. Then repeat the 
process for a 12-hour forecast. Here are some 
rough guidelines: 

a) Lows tend to follow steering winds better than 
highs do. A typical low will move in the direction 
of the steering winds, at about one-half the 
steering winds’ speed. Thus if the 35,000 ft. 
winds above a low are blowing at 60 mph, you 
can expect the surface-low to move at 30 mph - 
or about 180 miles in six hours. 

Sometimes, a low at the jet stream level will lie 
directly above a surface low. This happens 
most often at the end of a low's life span, as it is 
weakening. In such a case, the circular steering 
winds imply that the surface low will show little or 
no movement. This stagnation of weakening 
lows is a fairly common event. 

b) Fronts also follow jet stream winds; but 
generally the winds blow along as well as across 
the front. Only the portion of the wind blowing 
across the front will move it forward. A front 
lying parallel to the upper wind flow may show 
little or no motion. 

As a general rule, cold fronts move more 
consistently, and more in response to the 
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steering winds, than warm fronts. Surface warm 
fronts often seem to misbehave, dawdling too 
long in one spot and then jumping forward great 
distances in no time at all. 

c) Some highs follow steering winds tolerably well. 
Others do not. Warm surface highs often lie 
beneath highs aloft, which means the steering 
winds are circular and the high will be more or 
less stationary. Cold highs rarely reach as high 
in the atmosphere as 35,000 ft; nonetheless, 
these upper air winds often give a good 

indication of the surface high's motion. 

You can see from the above guidelines that forecasting 
using upper air winds is an imperfect science! Don't let 
that discourage you, however. Steering winds do give 
useful information about weather systems’ movements. 
Like many other forecasting techniques, however, you 
must use this one with caution and judgement. It is not 
"guaranteed to give perfect results every time"--which is 
the sort of thing that makes weather forecasting the 
challenge we all enjoy. 
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Activity 8 
Listening to What the Pros Are Saying 

Until now, you have been on your own for the most part: 
you have taken your own observations, made your own 
graphs and maps, found fronts and lows yourself, 
interpreted the weather patterns yourself. Here's your 
chance to see what others are thinking about the 
weather you have been studying so carefully. 

There are a number of interesting discussions and 
forecasts available through Accu-Weather and The 
Accu-Weather Forecaster. These include a summary of 
current weather conditions, and local and national 
forecasts. 

Of course you might not want to read them yet! At this 
point, reading someone else's summary of current 
conditions or forecast is a little like peeking at the 
solution to a crossword puzzle while you're still working 
onit. Perhaps you would rather wait until you have 
completed your forecast on your own? Then you can 
see what the others think. 
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But if you want to look, go ahead; after all, those other 
people don't necessarily have the right answers either! 

1) 

2) 

3) 

4) 

9) 

Choose the Forecast activity from The Accu- 
Weather Forecaster. 

Select "US Summary", and read the information. 
This summary is several pages long and has a lot of 
important information. It begins with an overview of 
important weather events throughout the nation. 
‘Then there is a description of the current weather 
map, specifying the locations of highs, lows and 
fronts. This is followed by a forecast for general 
regions of the country, and concludes with the 
predicted map positions for the following day. 

Select the "Text" forecast for your location. This is 
a brief text forecast for your local region. 

Select the "Chart" forecast for your location. This 
forecast is prepared by a powerful computer of the 
National Weather Service. It uses a special 
computerized model of weather patterns and 
current conditions to create a detailed “chart” of 
forecast conditions over the next 36 hours. 
Remember, the fact that this is based on a computer 
model does not necessarily mean that it will be more 
accurate than a “"human-basecd" forecast. 

After you have examined the above mentioned 
discussions and forecasts, enter on your Forecast 
Worksheet any information you feel might be 
helpful to you in making your forecast. 
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Determining Typical Local Weather 

Do you know the average daily high and low 
temperatures for this month in your area? How many 
days per month experience precipitation? What is the 
prevailing wind direction? What air masses are most 
common? Before attempting to forecast the weather, 
you should know the answers to questions like these. 
Such information is known as climatological data. 
You can think of climatological data as hints that nature 
gives to the forecaster. Forecasters always keep 
Climatology in the back of their minds when preparing 
forecasts. A forecast that differs greatly from the 
climatological odds for the region should be founded on 
very strong reasons! 

You can find out climatological data for your region 
through several sources: 

1) published reference books (such as [he Worid 
Weather Guide by E A Pearce and C G Smith, 
Hutchinson, London, 1984, or 

Book of Facts, Pharos Books, New York, 1987) 

2) local or state government agencies (such as the 
Department of Environmental Protection or the 
Department of Agriculture) 

3) Accu-Weather's on-line data base of 
"Daily/Monthly Tabulated City Summaries" 
(refer to the Telecommunications, Explore Accu- 
Data, and Incredible Weather Data Base sections of 
the Accu-Weather Forecaster Manual). 
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Making Your Forecast 

Now comes the most interesting, but also the most 
difficult, activity: making your forecast! You probably are 
looking forward to that last list of steps, which will guide 
you through making a professional weather prediction. 

Well, here's the bad news: there's no such list. Just 
when you could use the most help, help evaporates, 
like moming dew. The reason is that there is no single 
recipe for making a weather forecast. Items that are 
important one time don't seem to matter the next; rules 
that work perfectly today don't always work tomorrow. 

The problem is that the weather is too creative to be 
captured by any one recipe. Millions and millions of 
factors affect the weather, resulting in so many 
possibilities for tomorrow's forecast that we can't even 
list them all. 

However, we don't mean to be totally uncooperative. 
Below is a scheme for arriving at a 24-hour forecast. If 
you follow it conscientiously, and practice, most of your 
forecasts should be fairly accurate. 

But please do not consider this the only way, or even 
the best! When you're starting with a specific weather 
pattern and struggling to predict how it will behave, your 
own personal experience and common sense are more 
important than any step-by-step forecast guide. 

And that, of course, is what makes it all so much fun! 

1) Review Present Weather Conditions 

Most meteorologists begin a forecast by reviewing the 
present weather and its causes. What is it doing outside 

now, and why? You have the answers to these 
questions on your worksheet, in the sections for 
Activities 2 and 6. Review these sections now. 
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2) Will Weather Patterns Stay the Same? : 

in the next 24 hours? Remember they can change 
either by moving, by changing strength, or both. 
Consider the evidence for change: this includes your 
Worksheet comments about continuity (Activity 7), and 
the professionals’ discussions (Activity 8). 

If you feel satisfied the patterns will not change, then 
issue a persistence forecast: tomorrow will be like 
today. This is the easiest forecast to make - and overall 
the least accurate. Use your observations for the past 
24 hours to predict cloud cover, temperatures, etc., for 
the next 24 hours. But if you feel that the patterns will 
change, as they usually do, then you need to continue 
to step 3. 

3) What Will Weather Patterns be in 24 Hours? 

Next, deci i ike i 
hours. You have a number of aids for this: your © 
continuity forecast in Activity 7, and the discussions of 
Activity 8. If all these sources suggest the weather 
patterns will behave in the same way (a miracle), your job 
is easy: you make a map showing the predicted weather 
patterns 24 hours in the future. Then you can proceed 
to step 4. 

But if your information from Activities 7 and 8 suggests 
different futures, then you have to make a decision. 
You must decide which evidence to accept and which to 
ignore. One hint might be found in the regional weather 
you observed in Activity 5. These observations might 
give advance notice that the weather patterns are 
following continuity, or the steering winds, or whatever. 

Remember you must forecast changes in the intensity 
of weather patterns, as well as their changes of position. 
Forecasting changes in intensity is difficult. As a 
general rule, lows intensify when their air becomes less 
stable. In fact, stability is lessened whenever the air 
near the ground is warmed, or when the air high aloft is 
cooled. So if you expect a low to move from cold land to 
warm water, you can expect its stability to lessen, and 
the low to strengthen. Similarly, colder air flowing in aloft 
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will de-stabilize the air, and lead to strengthening of a 
low (or front). The rules for highs are just the opposite: 
cooling at the surface, and/or warming high aloft, will 
cause stronger high cells. 

After you have weighed all the evidence, prepare a map 
showing your prediction of the synoptic pattern for 24 
hours hence. Sketch your map in the space provided at 
the top of the Forecast Form which accompanies this 
book. 

4) Major Changes in the Next 24 Hours 

Now you are ready to complete the "Background" 
section of your forecast. In a couple of sentences, write 
down 
you see them. For example, "The high pressure that 
has controlled our weather for the past two days will 
continue to do so”. "Little change is expected from 
yesterday.” Or, "Our current warm, humid weather will 
change due to the passage of a cold front sometime this 
evening. The front will bring a period of showers; then 
the weather will become cooler and drier." 

Now, turn to the Detailed Forecast section of the 
Forecast Form, and put on your thinking cap. Based 
on the above analysis, you are ready to put more details 
into your forecast. 
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5) Forecasting Cloud Conditions 

To predict cloud conditions, compare 
the present map with your forecast 
map. Is awarm front on the way? Willa 
high pressure cell be in your region 
tomorrow? - or what? If the warm front 
or high pressure cell arrives 
unchanged, you can expect its present 
cloud patterns to prevail in your region 
tomorrow. But if the feature is changing 
in strength, you will have to modify this 
estimate of cloud conditions. 

Here are three general rules about 
cloud cover: 

e Clouds become both thicker and lower as lows (or 
fronts) intensify, higher and thinner as lows weaken. 

e Stratus cloud types are more common in the late 
night and morning, whereas cumulus clouds are 
more common and thicker in the afternoon. 

e Large cloud masses often move at steady rates. 
Your regional and synoptic cloud maps might help 
you follow cloud movements and decide when 
clouds might arrive. 

So, looking at tomorrow's map and considering the 
three cloud rules, write down the cloud cover you 
expect as today's weather changes to tomorrow's. 
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6) Forecasting Precipitation 

When you forecast precipitation, here are some things 
to remember: 

Precipitation comes from clouds! - usually low 
clouds, sometimes middle clouds. If you are not 
forecasting middle or low clouds, don't worry about 
precipitation. 

Precipitation areas often move at a steady rate (like 
the clouds mentioned on the previous page). Look 
at past maps to see if a precipitation zone is moving 
steadily toward you. 

Steady precipitation tends to fall from stratiform 
clouds. Showers fall from cumuliform clouds. 

Discussions and computer-made forecasts can be 
very helpful. (But don't use this information if you 
feel it is cheating!) 
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7) Forecasting Wind Speed and Direction 

Unless you are expecting a gale or hurricane or other 
strong wind, you probably don't have to worry about 
forecasting wind speed. The reason is that deciding 
whether the wind will be 10 mph or 15 is difficult, and 
most people don't care. More important is wind 
direction: you should predict it each day, partly as an aid 
in forecasting temperature. 

Wind direction is rather easy to forecast, once you have 
completed your weather forecast map. Just remember 
how the winds flow around high and low pressure 
centers: 

e Highs—clockwise and away from the center 

a Lows-counter-clockwise and towards the center 

Also, remember that there often are sudden wind shifts 
when a front passes (for example shifting from 
southwest to northwest with the passage of a cold 
front). 
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8) Forecasting Temperature 

A good starting point for the temperature 
forecast is the Accu-Weather Forecasters 
graph of temperature at your station for the past 
24 hours (see Activity 4). If you are not 
expecting important changes in the weather 
patterns, then forecast temperatures like the 
ones on the graph. But if the patterns are 
changing, your temperature forecast will differ 
from yesterday's graph. Here are some rules of 
thumb: 

For most places, south or southwest winds mean 
warmer weather; north to west winds, colder _ 
weather. (If you live on the coastline, this may not 
apply to you.) 

Fronts can bring sudden changes in temperature. 

Look "upstream" from your station, to see what 
temperatures are reported. For example, if your 
wind is from the northwest, look at the temperatures 
of stations to the northwest. Often those 
temperatures are a hint of what is to come. 

The temperature changes more from day to night 
when the air is drier. So if you are predicting that the 
air will become more humid and cloudy, then also 
expect to see less change from day to night 
temperatures. With heavy clouds and precipitation, 
there may be no day-to-night changes at all. 

In windy weather, the temperature shows less daily 
up-and-down change than on calm days. 

Know the average and the record for the region at 
this time of year. When in doubt about forecasting 
the temperature, adjust toward the average, and 
avoid forecasting new records. 
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Activity 11 
Verifying Your Forecast 

Once you have made your forecast, you now have the 
fun of watching the weather and checking your 
forecast's accuracy: this is known as "verifying" your 
forecast. 

The simplest way to verify your forecast is to record the 
actual cloud cover, precipitation, wind and temperature 
conditions in the same boxes on your forecast sheet, 
using a different color of pen. Then it's easy to check 
your accuracy. If you want to grade yourself and watch 
your improvement as a forecaster, you will need a 
grading scheme. Here is one such system. It is scored 
like golf: | 

score. 

Use the following point system for each forecast period 
(such as "This Afternoon", or “Tomorrow"): 

1) 

2) 

3) 

4) 

Clouds: For every tenth of cloud cover difference 
between forecast and observed, give yourself 2 
points. (Thus if you predicted cloud cover of seven- 
tenths, and it actually was five tenths, give yourself 
4 points). 

Precipitation: 
If you predicted precip and it occurred -10 
If you predicted precip but it did not +15 
If you predicted no precip and none occurred - 5 
If you predicted no precip but it did occur +15 

Wind Direction: 
If your direction was perfect: 0 
If you missed by 45 degrees: +2 
If you missed by 90 degrees: + 6 
If you missed by 135 degrees: +10 
If you missed by 180 degrees: +15 

Temperature: Subtract your predicted 
temperature extreme from that actually observed. 
For every degree of difference, give yourself 1 
point. (Thus if you predicted an afternoon high of 
36 and it actually was 31, you get 5 points. 
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Add all of your points (and subtract negative points) for 
each time period, then add together your points for all 
time periods, to give yourself a final score. 

By scoring yourself in this fashion, you can watch your 
progress in forecasting the weather! 

And if your forecasts are real good, you might want to try 
getting a job at Accu-Weather! 
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PLEASE READ FIRST! 
THE SOFTWARE TOOLWORKS LICENSE AGREEMENT 

This is a legal agreement between you, the end user, and The Software Toolworks, Inc. ("Toolworks"). BY OPENING THE SEALED DISK PACKAGE 
CONTAINING THE De wey YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS 
OF THIS AGREEMENT, PROMPTLY RETURN THE UNOPENED PACKAGE WHICH CONTAINS THE DISK(S), DOCUMENTATION, PACKAGING AND 
ALL OTHER ITEMS INCLUDED WITH THE SOFTWARE ("TOOLWORKS PACKAGE") TO THE TOOLWORKS AT THE ADDRESS INDICATED BELOW. 

TECHNICAL SUPPORT. If you are having any problems with the Toolworks Bae or if you have any questions concerning this agreement, 
contact the Software Toolworks’ Sales and Service at 60 Leveroni Court, Novato, CA 94949, or call (415) 883-3000. 

THE TOOLWORKS SOFTWARE LICENSE 
1. GRANT OF LICENSE. Toolworks and its suppliers grant to you the right to use one copy of the software program ("Program") which is included 
with the Toolworks Package. You may not network the Program or otherwise use it on more than one computer or computer terminal at the same 
time. 

2. COPYRIGHT. The Program included with the Toolworks Package is owned by the Toolworks or its suppliers as set forth in the Program or 
associated documentation and is protected by United States copyright laws and international treaty provisions. You may not copy the Program 
except as provided in this Agreement. You must treat the Program like any other copyrighted material (e.g. a book or musical recording) except 
that you may either (a) make one copy of the floppy disks, if any, on which the Program is recorded solely tor backup or archival purposes, or (5) 
transfer the Program on floppy disk to a single hard disk, provided that you keep the original floppy disk solely for backup or archival purposes. 
You may not copy the written materials accompanying the Program. | 

3. OTHER RESTRICTIONS. You may not rent or lease the Program, but you may transfer the complete Toolworks Package on a permanent basis, 
provided that you retain no copies and the recipient agrees in writing to the terms of this Agreement. You may not reverse engineer, decompile 
or disassemble the Program. 

4. DUAL MEDIA SOFTWARE. If the Software Package contains both 3 1/2" and 5 1/4" disks, then you may use on the disks appropriate for your 
eae ae computer. You may not use the other disks on another computer or loan, rent, lease, or transfer them to another user except as part 
of the permanent transfer (as provided above) of the entire Toolworks Package. 

5. YOU MAY NOT USE, COPY, MODIFY, OR TRANSFER THE PROGRAM OR ANY COPY IN WHOLE OR IN PART, EXCEPT AS EXPRESSLY 
PROVIDED IN THIS LICENSE. ALL RIGHTS NOT EXPRESSLY GRANTED ARE RESERVED BY THE TOOLWORKS OR ITS SUPPLIERS. 

LIMITED WARRANTY | 
LIMITED WARRANTY. The Toolworks warrants that with respect to the Program contained in the Toolworks Package, the media upon which the 
Program is recorded shall be free from defects and workmanship under normal use and service for a period of thirty (30) days from the date of 
purchase. Any implied warranties on any Program is limited to thirty (30) days. Some states do not allow limitations on duration of an implied 
warranty, so the above limitation may not apply to you. ) 

CUSTOMER REMEDIES. Toolworks’ entire liability and eur exclusive remedy shall be, at Toolworks’ option, either (a) the repair or replacement 
of the media upon which the Program is recorded that does not meet Toolworks’ Limited Warranty and which is returned to the Toolworks with a 
copy of your receipt; or (b) a refund of the price which you paid for the Toolworks Package. This Limited Warranty is void if failure of the Program 
has resulted from accident, abuse, or misapplication. Any replacement Program will be warranted for the remainder of the original warranty period 
or thirty (30) days, whichever is longer. | 

oY eae Aen es WITH RESPECT TO THE PROGRAM AND THE ACCOMPANYING WRITTEN MATERIALS, THE TOOLWORKS, 
MET SOFTWARE INC. ("METACOMET") AND ACCU-WEATHER, INC. ("ACCU-WEATHER") DISCLAIM ALL WARRANTIES, OTHER THAN 

THE ABOVE WARRANTY BY THE TOOLWORKS, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FORA PARTICULAR PURPOSE. THE TOOLWORKS, METACOMET AND ACCU-WEATHER MAKE NO EXPRESS 
OR_IMPLIED WARRANTIES, GUARANTIES OR AFFIRMATIONS THAT WEATHER WILL OCCUR OR HAS OCCURRED AS THE REPORTS, 
FORECASTS, GRAPHICS, DATA OR INFORMATION ACCESSED AND/OR DISPLAYED BY THIS PROGRAM REPRESENT OR DEPICT AND THEY 
SHALL HAVE NO RESPONSIBILITY OR LIABILITY WHATSOEVER TO USERS OF THIS PROGRAM OR TO ANY OTHER PERSON OR ENTITY, 
PARTIES AND NON-PARTIES ALIKE, FOR ANY INCONSISTENCY, INACCURACY OR OMISSION FOR WEATHER OR EVENTS PREDICTED OR 
DEPICTED, REPORTED, OCCURRING OR OCCURRED. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE 
OTHERS, WHICH VARY FROM STATE TO STATE. 

IABILITY F NSE NTIAL DAMAGES. IN NO EVENT SHALL THE TOOLWORKS, METACOMET, OR ACCU-WEATHER BE LIABLE FOR 
Y DAMA WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION, LOSS OF 

INFORMATION, OR OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE PROGRAM, EVEN IF THE TOOLWORKS, 
METACOMET OR ACCU-WEATHER HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW 
al aaa OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY 

U.S. GOVERNMENT RESTRICTED RIGHTS 
The Program and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to 
restrictions as set forth in fied lies Mlad (c) (1a) of The Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or 
subparagraphs (c)(1) and (2) of the Commercial Computer Software Restricted Rights at 48 CFR 52.227-19, as applicable. The Contractor/manufac- 
turer is The Software Toolworks, Inc., 60 Leveroni Court, Novato, CA 94949. 

This Agreement is governed by the laws of the State of California. 
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Accu-Weather Forecaster" (Mac) 
Subscription Procedures 

The Accu-Weather Forecaster is used in conjunction with Accu-Data™: Accu-Weather’s’ complete dial-in weather database. 
Accu-Data provides exciting, up-to-the-minute data and color graphics for use with the Accu-Weather Forecaster. 

As a special offer to you as a purchaser of the Accu-Weather Forecaster, you can subscribe to Accu-Data at substantially 
discounted rates... as low as 10¢ per minute. | 

Account Number and Password 

Your Accu-Data account number and password are shown on the sticker to the 
right of this paragraph. This account provides one hour of free access time | Accu-Weather Forecaster™ 
and enables you to explore the database free of charge before your subscrip-_ | _ Mac Version 
tion is established. This free access time must be used within 30 days of your: Acct #: AWFM11F3B 
initial log-in. : Password: BGZWPLV 

2190020-670001 
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Setting Up Modem Parameters 

Before the Accu-Weather Forecaster can communicate with Accu-Data, you 
need to provide some information to the program. Activate the Telecom Accu-Data Access Number 
selection under the Setup menu. The Telecom Setup dialog box will appear. : 
Enter your account number and password into the spaces provided. For the 
phone number, enter the Accu-Data Access Number listed in the adjoining box. 
Once you have established your Accu-Data account, you may elect to use a 
toll-free number instead. This toll-free number will be given to you on-line. 
A usage charge of 19¢/minute is assessed when you use the 800 number. For more information on configuring the Modem 
for use, consult the Accu-Weather Forecaster Users Guide. 

(814) 237-0652 
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Establishing Your Account _ 
The first time you activate the Get Data or Explore Accu-Data command, the program will enter an interactive mode with the 
Accu-Data database. At this time you may to choose your subscription package and billing options. Alternatively, you may 
postpone choosing a subscription package until you become more familiar with the Accu-Weather forecaster and its features. 
You are not required to select a subscription package to receive your hour of demo time, but you can receive additional 
demo time by selecting a subscription option early in your demo usage. 

Connect Time Rates 

There are two classes of service available: Personal 
and Commercial/Institutional. A personal user is Personal Commercial/ 
given discounts of up to 60% over standard Institutional 
Commercial/Institutional rates. Your personal use 

cannot be for commercial, business, institutional or || Night Rate (Midnight to 5 AM) } 10e/minute | 10e/minute | 
» employment purposes. The connect time rates for | 

both service classes are shown in the adjoining 

eS pe 
1200 baud access. 2400 baud access is subject to 
a 50% surcharge. 

Telephone Numbers 

For questions regarding the Accu-Weather Forecaster program, contact The Software Toolworks Technical Support at (415) 
883-3000. For information regarding subscription to the Accu-Data database, contact an Accu-Weather Marketing 
Representative at (814) 234-9601 x400. (continued over) : 
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Subscription Options , 

There are three subscription options: One Month Sampler, Three Month Special, and Super Saver. The features of each 
option are described in the following tables: 

Personal One Month Sampler Three-Month Special 

One-Time Subscription Charge | $39.95 $49.95 $99.95 : 

Free Demo Time (to be used 1 hour* 1 hour” 1 hour’ 
within 30 days of first log-in) | 

Minimum Monthly Connect No monthly minimum for | No monthly minimum for | No monthly minimum for 
Time Charge 1 month, $9.95 after 3 months, $9.95 after 12 months, $9.95 after 

First $15 of actual usage First $10 of actual usage First $10 of actual usage 
during first month is free during each of the first 3 during each of the first 

months is free 12 months is free 

Business /Institutional One Month Sampler Three-Month Special 

One-Time Subscription Charge | $79.95 $99.95 : $199.95 

Free Demo Time (to be used 1 hour’ 1 hour” 1 hour" 
within 30 days of first log-in) . 

Minimum Monthly Connect No monthly minimum for | No monthly minimum for | No monthly minimum for 
Time Charge 7 1 month, $24.95 after 3 months, $24.95 after 12 months, $24.95 after 

First $25 of actual usage 
during each of the first 
12 months is free 

Free monthly time | 

First $25 of actual usage 
during first month is free 

First $25 of actual usage 
during each of the first 3 

months is free 

Free monthly time 

“If you sign up for any of these subscription packages at the beginning of your first log-in you will receive a second free demo 
hour. If you sign up at the beginning of your second or subsequent log-in you will receive additional free demo time equal 
to the amount of your free demo hour remaining unused at the time of sign-up. The sooner you sign up, the more free time 
you will receive. 

Billin 

. MasterCard, Visa, or Discover Card will be billed directly for all charges. 

To keep your account active, Accu-Weather, Inc. will bill you the Minimum Monthly Billing each month. This represents a 
minimum payment and will be used as a credit against your usage. Your monthly usage of system connect time will be offset 
against the minimum monthly billing and then the charge will be forwarded to your card issuer. You may cancel your account 
at any time on 30 days notice. Closed accounts will be subject to a new subscription charge to reopen. 

For Business/Institutional users, volume discounts and bundled toll-free access accounts are available on annual term 
agreements. Multiple site discounts are also available. In addition to credit card payment, Business/Institutional users may 
establish a credit account directly with Accu-Weather, Inc. Contact an Accu-Weather Marketing Representative at (814) 234- 
9601, x400. 

Rates are subject to change without notice. 

Accu-Weather is a registered trademarks of Accu-Weather, Inc. 
Accu-Weather Forecaster and Accu-Data are trademarks of Accu-Weather, Inc. 
Copyright ¢ 1990 The Software Toolworks, Inc. 
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~—ACCUNEATHER 
24 Hour Weather Forecast 

Preparation: 

Weather Forecaster (name): 

Forecast for (location): 

Prepared on (date): at (time): 

1. National Forecast Map: 

Map forecast to occur on (date): » _at (time): 

2. Background: (summary of the major features affecting today’s and tommorrow’s weather) 

3. Detailed Forecast: 

Toda Tonight Tomorrow 

Winds ee 
Temperature range 7 ee 

4. General Forecast: (summary of the conditions you predicted in the table above) 

Copyright © 1988 Metacomet Software — Reproduction rights granted for use with Accu-Weather Forecaster™ Accu-Weather is a registered trademark and Accu-Weather Forecaster is a trademark of 

Accu-Weather, Inc. 

2190020-305001 



AUUWEALH AN 
FORECASTER 

Forecast Worksheet 

Forecaster: Location: 

Date: | Time: 

Activity 2: PRESENT WEATHER 

Clouds: 
Total Cloud Amt: __ Cloud Types: 

Wind: | 
Wind Direction: Wind Speed: 

Precipitation: 
Present: Past 3 Hours: 

Barometric Pressure: 

Current Pressure: 3-Hour Pressure Change:. 

Temperature: 
Air Temperature: Dew Point Temperature: 

Other Information: _ 
Visibility: Relative Humidity: 

Activity 3: CHECKING YOUR OBSERVATION 
The weather reported at near-by stations differs from local observations in these ways: 

Activity 4: LOCAL WEATHER TRENDS 
Comment on trends you observe in each of these: 

Clouds: 

Wind: 

Precipitation: 

Barometric pressure: 

Temperature: 

_ Other Information: 
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SERVICE TERMS AND CONDITIONS 

Access Codes. Access codes and information furnished by Accu-Weather, Inc. to Subscriber are intended for Subscriber’s 
sole and exclusive use and shall be considered proprietary information, ownership of which shall remain with Accu-Weather, 
Inc. Subscriber shall be fully responsible for maintaining confidentiality of account access information and for all charges 
made to subscriber's account. 

Use of Service. Subscriber agrees that the service is furnished and shall be used solely for personal, educational or 
commercial use as accurately represented by Subscriber. Subscriber agrees to truthfully represent the nature of 
Subscriber's use. Subscriber shall not directly or indirectly transmit, broadcast, redistribute, forward or deliver the Service 
or any part of the data, information, images or other products which constitute the Service to any other person or entity, in 
any format, or by any means. 

Subscription Fees. Subscriber agrees to pay to Accu-Weather, Inc. the fees stated. Charges will generally be invoiced 
each month. Failure of payment shall render due and payable all sums plus a late payment charge of one and one-half 
percent per month. 

Terms. This Agreement shall remain in effect beginning on sign-up and it shall remain and continue in effect unless 30 
days written notice of termination is received by one party from the other party. The prices and terms are subject to change 
upon 30 days notice by Accu-Weather, Inc. to Subscriber. Posting of notice on the System shall constitute notice. 

Trademarks. REGARDLESS OF ANY OTHER PROVISION HEREIN, THE TRADEMARKS OF ACCU-WEATHER, INC. AND 
THE ACCU-WEATHER NAME SHALL NOT BE USED BY SUBSCRIBER IN ANY WAY, ESPECIALLY NOT AS A MEANS OF 
IDENTIFYING THE SOURCE OF THE SERVICE TO PUBLIC AUDIENCES OR CLIENTELE. THE ONLY PERSON(S) WHO 
MAY USE THE TRADEMARKS OF ACCU-WEATHER, INC. OR THE ACCU-WEATHER NAME IS ONE WHO HOLDS A 
SEPARATE WRITTEN TRADEMARK LICENSE AGREEMENT WITH ACCU-WEATHER, INC. 

Copyright, Storage and Ownership of Service. All information, data, images, and other things comprising the Service 
are to be considered copyrighted by Accu-Weather, Inc. and they remain the sole and exclusive property of Accu-Weather, 
Inc. Subscriber is authorized to use such for the purposes stated herein and to store such information during the time of 
the Agreement. Subscriber may not store for future use such information beyond that period, nor develop a library of such 
information. 

Events Beyond Accu-Weather’s Control. Accu-Weather, Inc., Metacomet Software, Inc. ("Metacomet"), and The Software 
Toolworks, Inc. ("Toolworks") shall not be held responsible for any failure or malfunction in power or communications nor 
the failure or refusal of third party transmission intermediaries to perform, continue or renew their contractual arrangements 
with Accu-Weather, Inc., nor inability to perform occationed by such or by labor strife, war, riot or other events beyond the 
control of Accu-Weahter, Inc. If the Service or delivery thereof is disrupted by any such event(s), Accu-Weather, Inc.’s 
obligations hereunder shall be suspended during the period of occurrence for such disrupting event(s). Accu-Weather, 
Inc.’s failure to perform this Agreement, resulting from any event(s) not specified above, shall cause it, Metacomet or the 
Toolworks to be liable to Subscriber in a maximum aggregate amount not to exceed the cost of service paid for by 
Subscriber at the time of failure, if any ,and still unused by Subscriber. This shall be the exclusive remedy hereunder. 
SUBSCRIBER IS ADVISED AND INFORMED THAT THE GOVERNMENT ISSUES OFFICIAL WATCHES, WARNINGS, AD- 
VISORIES, BULLETINS AND OTHER COMMUNICATIONS. SUBSCRIBER SHOULD KEEP ADVISED OF SAME. SUB- 
SCRIBER AND THIRD PARTIES ARE SOLELY RESPONSIBLE FOR ACTION OR LACK OF ACTION TAKEN TO PRESERVE 
LIFE OR PROPERTY. The Accu-Weather Forecaster is a product of Metacoment Software, Inc. and The Software Toolworks, 
Inc. Accu-Weather, Inc. has no reponsibility or liability for the performance or non-performance thereof. Subscriber agrees 
to indemnify and hold harmless Accu-Weather, Inc., Metacomet, and the Toolworks for any and all claims arising out of 
Subscriber’s use of this service. : 

Warranties. Accu-Weather, Inc., Metacomet, and the Toolworks make no express or implied warranties or affirmations 
that weather will occur or has occurred as the reports, forcasts, graphics, data or information comprising the Service state, 
represent or depict and it shall have no reponsibility or liability whatsoever to Subscriber or any other person or entity, 
parties and non-parties alike, for any inconsistency, inaccuracy or omission for weather or events predicted or depicted, 



® 

reported, occuring or occurred. ACCU-WEATHER, INC., METACOMET, AND THE TOOLWORKS MAKE NO WARRANTIES 
HEREUNDER, AND THIS DISCLAIMER OF WARRANTIES INCLUDES, BUT IS NOT LIMITED TO, THE WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Choice of Laws. The parties agree to submit to the Pennsylvania Courts only, any dispute arising out of this Agreement 
or related thereto, and consent to the jurisdiction of said Courts and further agree that any and all matters of dispute shall 
be adjudicated, governed and controlled under and by Pennsylvania law. 

Non-Assignability. Neither this Agreement nor any rights or obligation hereunder may be assigned by Subscriber. 

Performance. Subscriber hereby agrees that it will well and truly indemnify and save harmless Accu-Weather, Inc., - 
Metacomet, and the Toolworks from all manners of suit, actions, damages, charges and expenses, including attorney and 
counsel fees, which in the case of failure of payment by Subscriber shall equal twenty-five percent of such payment due 
but not paid, that Accu-Weather, Inc., Metacomet, or the Toolworks may sustain by reason of Subscriber’s failure to perform 
this Agreement, Subscriber’s breach of any of the terms, covenants or conditions of the Agreement, or other claims against 
Accu-Weather Inc., Metacomet, or the Toolworks arising from this Agreement. 

Manuals. Users Guides, manuals and other supplies and equipment supplied to Subscriber by or through Accu-Weather, 
Inc. (unless the subject of separate written lease or purchase agreements) remain the property of Accu-Weather, Inc. 
Subscriber agrees to return them to Accu-Weahter, Inc. at the end of the contract term hereof. Subscriber is responsible 
for damages other than normal wear and tear and for return shipping. Retention of User’s Guides, manuals or other supplies 
and equipment beyond 30 days after the expiration date will render Subscriber liable for the Minimum Monthly Billing until 
such are returned to Accu-weather, Inc. 

BEFORE USING THE ACCU-WEATHER SOFTWARE PACKAGE, YOU MUST READ, UNDERSTAND AND ACCEPT THE 
TERMS AND CONDITIONS OF THE END USER LICENSE AGREEMENT INCLUDED WITH YOUR SOFTWARE AND IN THE 
USER MANUAL. 

Copyright © 1988 Accu-Weather/B.L. Myers. 

2190020-505001 



REGISTRATION CARD 
Complete And Return This Card For Immediate Information On Upgrades And Technical Support! 

Product Purchased_ 

Name 

Company : 
Street Address_ ire . 

‘i Cig ete en 

: Covntry. 2 Telephone 

: Date purchased_____Serial Fo Version # 

So that:we may better serve you, please fill out the Rae tea: 

: On what type of computer are you using this program? 

: a IBM PC or compatible _ EJ Macintosh L} Apple II series/I GS a Other. 

oe Where was this program purchased? 

oe Please rate the following on a scale from, 1 to 10; 10 being the highest rating: 

Ease of Learning___ Performance___. Documentation___ Value 

_ Ease of Use_________ User Support___ Packaging________. Overall Satisfaction___ 

Comments:. = | | | 

Please send me information on your other products. L] 



BUSINESS REPLY MAIL 
FIRST CLASS PERMIT NO. 363 CHATSWORTH, CALIFORNIA 

POSTAGE WILL BE PAID BY ADDRESSEE 

THE SOFTWARE TOOLWORKS, INC 
19808 Nordhoff Place 
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NO POSTAGE 
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Now YOU'RE PLAYING TO LEARN — 

INSTEAD OF 

LEARNING TO PLAY. 

Isn’t it great when technology comes 

along and solves a problem for people 

Teaching System is all about. All of a 
e 

sudden f thi S -——— 

Finger Ni 

e The Mirace will ploy four notes: E, E, F, G 

Maj or The note F is a step up from E. The last note G is a Step up from F. 

Notice how the finger numbers are written above the notes. 

technological 

breakthrough - 
BC Follow the notes as they are played. 

makes AANA 
learning to 

play the piano 

fun. Maybe you thought the jo 

making music was beyond ye 

The Miracle Piano Teachir 

changes everything! 

This flexible, dynamic s 

the best of traditional tea 

and recent innovations no 

Posture at the Keyboard 

Great playing starts wilh good posture: 

Let your arms hang down irom your shoulders 

Curve your fingers like yours holding a dai 

Sit on the edge of your bench 

reward Play with the tips of your fingers 

Play on the alde of your thumb 

musical ex- 

perience for 
{9 continue... 

Everything you need to make music. everyone. The 

next generation 

of musical genius may be students of 

The Miracle! 

The minute you touch it, you’re makin 

music. And through a unique interacti 

system, The Miracle creates a custom 



f 
approach to 

learning the 

keyboard that is 

Play as you learn, at your own pace and 

at your own level. 

ou play. At 

our own pace, at your own level, 
a 

_ whenever you want. 

_ Do You Want To Rock or Bacu? 

EITHER Way, You’VE GoT 

GREAT BACKUP. 

One of the greatest satisfactions of 

} making music is playing with other 

musicians. And for the first time | 

contemporary, clas- 

azz, and country. By the 

computer screen, and you’ll 

by actual 

2s, not just 

Learn to play familiar songs at 
play your own pace. | 



BASIC TRAINING HAS NEVER 

BEEN SO MUCH FUN 

The Miracle Piano Teaching System is 

designed to work with a variety of system 

including: Nintend 

Entertainment Syst 

Super Nintendo 

Entertainment Syste 

IBM PC & Compati 

computers, Commodo 
Learn chords the fun way. 

Amiga com- 

puters, Macintosh* computers. Typ | 

Written by professional music 

educators, this program makes IS A DE: 

learning the basics a pleasure., aPC 

It is the ideal system for beg 

ners, or even for those wh 

need to brush up on basi 

skills. It doesn’t matter | 

youre six or ninety-six 

Miracle brings the joy 

Using Artificial Intelligence Tech 

monitors each 

lesson and builds a 

series of personal- 

ized exercises just 

for you, based on 

your individual 

needs. And by 



A PROFESSIONAL INSTRUMENT THAT 

Grows WITH YOu 

The Miracle is not 

nly an ideal tool for 

ring, it delivers 

ting value as a 

h-quality, 

( phisticated musical = _ Learn to recognize melody patterns 
and fingering techniques. 

instrument. The 

professional keyboard features full-sized, 

pressure sensitive keys that 

respond to your touch just like a 

piano. With over 100 other 

instruments available at a single 

keystroke, and a built-in stereo 

sound system, you can make an 

: entire orchestra come to life 

MUSIC...” whenever you play. As you 

; grow asa 

Martin Canin 
school o 

just for fun. 

sizers through built-in MIDI 

ections. (That’s Musical Instrument 

cital Interface, the world-wide standard 
Sy, 

omputerized music.) 

or information please call 

(800) 234-3088 

@ 
IRACLE 

P IAN O TEACH IN G S Y S T E M 



THE MIRACLE PIANO TE 

¢ The Miracle Orchestra ; 
Learn to play your favorite songs with full orchestral accompaniment 

« Note Practice 
Learn how to read notes 

RS 

a 

‘ Ripchord 
Video game teaches chords 

ae oy a 

‘ Shooting Gallery | 
Video game teaches note reading 

¢ Improved Accompaniment 
Piano demonstrates melody along with accompaniment 

ere e Ses 7 7 

Ms 

«Progress Tracking - 
Automatically tracks the progress of multiple students 

¢ Volume Control 
Control volume for orchestration, melody, and sound effects 

¢ Certificates 
Prints achievement certificates 

¢ Adjustable Metronome 
Set metronome tempo to your own speed for easier learning 

oe 298 scone 

¢ Add-on Song Collections 
Available to teach you to play more of your favorite songs using The Miracle Piano 

Teaching System 

e 
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TS A MIRACLE! 
THE MIRACLE PIANO TEACHING SYSTEM 

‘This major technological 

breakthrough makes piano 

lessons fun! Because you’re 

playing to learn...not just 
learning to play. ‘he minute 

you touch The Miracle Piano 

Teaching System, youre making 

music. And through a unique 

Exciting, arcade-quality video 
games...learn while you play! 

inter—active system, /he Miracle 

creates a custom approach to 

learning the keyboard that is 

completely personalized. You 

play — and learn — at your own 

pace, at your own level, 

whenever you want. 

Hundreds of lessons teach 

you all styles of music: classical, 

rock, jazz, contemporary and 

country. By the end of the first 

lesson, you won’t just be 

playing, you'll be playing along 

with the built-in Miracle 

Orchestra. (Imagine a jazz guitar 

— or saxophone — accompanying 

your tune.) 

Over 200 lessons and from 40 to 100 
musical pieces included. 

Before long, you'll be able to 

read music, play songs in 

rhythm, and perform two- 

handed piano pieces. Using 

Artificial Intelligence 

‘Technology, /4e Miracle 



monitors each lesson and builds a series of 

personalized exercises just for you. And by 

borrowing the fun of video games, it 

makes kids (even grown-up kids) want to 

learn. It doesn’t matter whether you’re 6 

or 96 — The Miracle brings the joy of music 

to everyone. 

Learn at your own pace, and at 
your own level. 

As a stand-alone instrument, 7/e Miracle 

rivals the music industry’s most sophis- 

ticated MIDI consoles, with over 128 

digital instrument sounds and effects, 

49 full-sized velocity sensitive keys, foot 

pedal, 4" speakers, and stereo earphones. 

It’s designed to work with your Nintendo 

Entertainment System, Super Nintendo 

Entertainment System, IBM PC 

Compatible, or Commodore Amiga. 

802041 

802108 

$479.95 

$479.95 

$379.95 |ES| 802044 
$479.95 WW 302028 

SONG COLLECTIONS 
VOLUMES | AND II 
Expand your repertoire! 

The Miracle Song 

Collection: Volume I 

adds 40 popular 

titles to your 

The Miracle Piano 

Leaching System, including: 

“La Bamba,” by Richie Valens; 

“Sara,” by Stevie Nicks; and “This 

Masquerade,” by Leon Russell. Vo/ume IT 

adds 40 MORE titles, including: “Eleanor 

Rigby,” by John Lennon and Paul 

McCartney; “Faith,” by George Michael; 

“The Girl Is Mine,” by Michael Jackson; 

and “People Get Ready,” by Curtis 

Mayfield. Each song includes two levels of 

playing difficulty and is fully arranged 

with complete accompaniments for a truly 

impressive sound. 

802211 



THE CHESSMASTER® 
No matter what your level of 

play, here’s the perfect chess 

opponent...patient, crafty, and 

willing to teach you some new 

techniques. Sixteen levels of 

play, from Newcomer to Grand 

Master, 3-D board designs, and 

dazzling animation. 

MARBLE MADNESS” 
‘The ultimate test of nerves and 

reflex. Roll down 3-D raceways 

to beat the clock or the other 

guy's marble. But watch out for 

sneaky Steelies, hounding 

Hammers and merciless Marble 

Munchers as you go! A 

blockbuster game of skull, 

speed, and split-second timing, 

for one or two nimble players. 

9 111004 $34.95 

CAPTAIN PLANET” 
AND THE 
PLANETEERS” 
Leap into the 

action of the 

top-rated kids 

‘TV show to 

help foil 

the 

Earth’s 

worst 

eco- 

villains. 

Fire up 

your Eco- 

Copter to 

airlift an 3 

elephant...face a radioactive 

showdown with Duke 

Nukem...and become Captain 

Planet’s #1 eco-ally. 

Colored tiles are coming at you... 

slowly at first, then faster and 

faster and FASTER. Your job? 

Stack ‘em up in piles of 3, 

vertically, horizontally, or 

diagonally. Kind of like tic-tac- 

tile. Sounds easy but it isn’t. No 

matter how tough it gets, 

though, the hardest part 1s 

pulling yourself away from this 

totally addictive game! 



DOK QUT! IT’S PAPERBOY® 2! 
AND IT’S AVAILABLE IN SUPER NES, NES & GAME BOY FORMATS 

5) | PAPERBOY’ 2  PAPERBOY® 
Hop on your bike ‘The original hit 

for a brand new, game, with over 

free-wheeling 1% million sold! 

@ tideupanddown Paperboy is the 

s the avenues of classic adventure 

suburbia. You'll through a suburban 

have to move neighborhood: into 

quickly, as you flowerbeds, past 

maneuver around yapping dogs, over 

tricycles, lawn- curbs. Unending 

mowers, not-so- thrills, spills, 

domesticated challenge and 

@ animals and other excitement. 

hazards in your 

efforts to flawlessly 

deliver to subscrib- 

ers (and break 

windows of non- 

subscribers). More enemies, more 

obstacles, more houses, different 

challenges, and twice the fun. 

$49.95 
S Hop. $34.95 
EN] in1010 $64.95 



DAYS OF 
THUNDER" 
You're a rookie 

stock car driver, 

sitting on eight 

cylinders of 

mean machine 

that’s packed 

with horse- 

power and 

ready to jam. Now 

experience all the 

tire-screeching 

stock car action of 

the movie Days of 

Thunder. You'll 

have to think fast, move faster and use real 

racing strategies to win! | 

110502 $29.95 

parry DIRTY HARRY” 
ory You’re Detective Harry 

: Callahan, out to get 

a ruthless drug- 

smuggling ring. 

Crack the case and 

face the kingpin 

himself in a 

blazing showdown 

on Alcatraz. 

LOOPZ™ 
It seems so simple — 
just connect pieces 

of different sizes 

and shapes to form 

complete loops. 

But it’s not as 

easy as it looks, 

and it may be 

the most addictive 

game ever! ‘T’en tortuous levels. 

PI 110485 $29.95 

WORLD LEAGUE SOCCER” 
@ bully scaled, 

action pits you 

against the 

Py best teams in 

the world, 

‘and hund- 

FLIGHT OF THE INTRUDER™ 
Relive the thrill of the 

movie l/ght of the 

[ntruder...Fight for your 

life, flying either an 

A-6 Intruder bomber 

or an F-4 Phantom 

fighter in twelve 

different missions, 

including intense 

night sequences “5 @aae 5 
and over 50 combat << 

rounds. Feel the heat as your 

weapons detonate with incredible realism. 

GAUNTLET?® Ii 
‘Technical wizardry 

delivers all the action 

of the popular Gauntlet 

arcade game! Search for 

magical treasures... 

explore 106 different Dark ' 

Dungeon mazes...battle 

ghosts, demons, dragons 

and other deadly foes...as 

you live the fantasy of Uhor, 

‘Thyra, Questor and Merlin. Up to four 

can play at once, each assuming a different 

character role! 



TS YOUR MOVE... 
THE JOY OF CHESS - BETTER THAN EVER 

THE CHESSMASTER® -- THE CHESSMASTER® 
3000 3 R 2100 
The ultimate | | CES The classic Chessmaster- 
Chessmaster with a loved by critics and 
a turbocharged — players alike. 
chess engine and \ 

enhanced graphics. 

lLeara mules: 

strategies, and omer 

intricacies of the ne 
game. Then play 

a wide variety of 

chess personalities 

each with his or her 

own quirks. Or create your own opponents! 

An infinite number of game levels and new 

features make learning easy for the novice, 

as well as challenging for even the most 

expert player. 

$49.95 

$59.95 

Stunning 2-D and 

3-D graphics, 

a mammoth 

opening library, 

and unlimited levels of play. 

Over a million copies sold! 

wort 
jn 

$49.95 103313 $49.95 

$49.95 [IES} 103301 $49.95 
$39.95 

Se 



GIN 
KING/ 
CRIBBAGE 
KING® 
For the 

beginner 

or true 

card 

shark... 

hone 

f your Gin 

and 

Cribbage 

skills to 

razor 

perfection. 

Seven 

Artificial Intelligence computer 

personalities — each with his or 

Play cribbage like a king. 

her own playing style — await 

you. You can even ask for hints. 

Excellent full-color, high- 

resolution graphics. 

GIN KING /CRIBBAGE KING 

IBM| 103493 $24.95 |[MI| 103495 $39.95 
NW 103499. $49.95 fIES| 103497 $49.95 

THE GAMES 
PEOPLE PLAY” 

Artificial Intelligence trans- 

forms your favorite board and 

card games, and gives you a 

different challenge every time 

you play. Includes Backgammon, 

Checkers, Gin, and Cribbage, 

with multiple levels of play for 

each. Lifelike graphics and color 

add to the fun. 

THE GAMES PEOPLE PLAY 
IBM| 104118 $39.95 | 

ENTERTAINMENT 

D/GENERATION™ 
Action adventure meets virtual 

reality! Some- 

thing is 

definitely 

wrong at the 

Genoq 

corporate 

head- 

quarters, 

and things 

are not 

what they 

seem. 

Within this 

graphically 

innovative 

environment, search for clues 

and solve puzzles that reveal 

your mission as you race against 

time (and fate) through a 

security system run amok. 

D/GENERATION 
IBM) 106067 

Ph, 

CAPTIVE™ 
Held captive for 200 years in an 

orbiting space prison (for a crime 

you didn’t commit!), your only 

hope of escape is a briefcase 

computer and the droids who 

respond to your frantic calls 
for help. ‘The run away smash- 

hit of European game players! 

CAPTIVE 
NW 104350 $44.95 

ORDER TOLL FREE 1°800°234°3088 



ENTERTAINMENT 

SUTURE...SPONGE!! SCALPE 
LIFE & DEATH® 
Not for the faint of 

heart — or clumsy of 

wrist. You hold a 

human life in your 

hands as you cut 

into living flesh. 

Your skill with the 

scalpel while 

monitoring on- 

screen EKG, 

pulse, blood 

pressure and other 

vital signs will 

determine 

whether your 

patient goes to recovery...or the morgue. 

Watch where you make that incision! 

It’s time for the cut...but 
which of these things is 
the scalpel? 

LIFE & DEATH 
IBM] 101663 $34.95 | [MI] 101664 $49.95 
hW 101665 $39.95 ILS} 103352 $49.95 

ipEey THE PUZZLE GALLERY” 
‘eget M\ 140 of your favorite puzzles — 

word searches, crosswords, 

Jigsaws, jumbles, codes, 

mazes, and more — in the 

Chaziest Carmival ever. 

Collect your wits and dive on in! 

THE PUZZLE GALLERY 
IBM| 104347 $39.95 

LOOPZ" 
‘The can’t-put-it-down 

classic. Form loops out 

of different sizes and 

shapes. It sounds easy... 

but perhaps youll just have 

to see for yourself! ‘en tortuous levels. 

Og 
IBM} 110490 $39.95 JW 110487 $49.95 

LIFE & DEATH¢® Il 
- THE BRAIN 
Welcome to the 

Neurosurgery 

Wing, Doctor. 

It’s the ultimate 

medical adven- 

ture into the 

depths and 
mysteries of the 

human brain! Your 

hectic day begins 

with x-rays, CAT 

scans, Ultra-sound 

and MRIs, with 

stunning color graphics and digitized 

sound. Only you can decide — does your 

patient need ‘The Knife? Warning — 

operate in Nightmare Mode and things 

could get completely out of hand! 

LIFE & DEATH II-THE BRAIN 
IBM] (3.5") 104344 $49.95 [IBM] (5.25") 104114 $49.95 

THE HUNT FOR 
RED OCTOBER™ 

' Test your brilliance in 

stealth, evasion and naviga- 

tion as Commander of the 

Red October, in the ultimate 

submarine simulation game. 

You make life and death 
decisions on the 

Neurosurgery ward. 

116204 $29.95 

116202 $29.95 

$29.95 

$29.95 

DAYS OF THUNDER” 
Experience all the tire- 

screeching stock-car action 

MI] 116207 
116200 
116209 

$29.95 

$29.95 

$29.95 

of the movie Days of 

Thunder. Yow \l have to 

ee think fast and use real 

racing strategies to win! 

DAYS OF THUNDER 
IBM| 104168 7 $34.95 



THE WORLD'S PREMIER 
TYPING PROGRAM 

MAVIS 
BEACON 
TEACHES 
TYPING!® 

perfect 

EM Time re 1 Ct in 

: Kepner Fees Fun Paots t me 8 

all, eet doing wall! The pest teacher: 

coy, abead” ae E 3 

tireless, 

attentive, 

and best 

Lessons are tailored to your of all, 
unique level of ability. fun. 

Over 1.5 million people have 

learned to type with Mavis 

Beacon. But now it’s better than 

ever! This new release adds 

some hot features to the best- 

selling classic...like new EGA/ 

VGA graphics support, a 10-key 

teaching mode, and a frustration 

sensor to help pace new typists. 

‘The classes are tailored to your 

unique strengths and weaknesses. 

PRODUCTIVITY 

First, 

you ll 

Start at 

the 

Chalk- 

board 

to outline your lesson; next it’s 

on to the Classroom where you 

actually begin typing. (On- 

screen ghost hands mimic your 

actual movements so you don’t 

need to watch your hands.) 

Then it’s back to the Chalk- 

board for Mavis to critique your 

performance. Finally, in the 

Workshop, you work on your 

weaknesses with the help of a 

clock, metronome, and three 

typing speeds. Every lesson is 

made interesting with quotes 

from history’s greatest writings, 

rhymes and jokes, and 

fascinating facts from the 

Guinness Book of World Records. 

You get time out for recess and 

skill-building in the arcade with 

a classic driving game, plus two 

irresistible new games as well! 

MAVIS BEACON TEACHES TYPING! V2.0 
IBM| 106102 $49.95 |\A] 106103 $59.95 

MAVIS 
BEACON 

) TEACHES 
TYPING!® 
Join the 

hundreds 

of thou- 

sands of 

happy 
typists who’ve learned 

from Mavis! And discover why 

this classic Artificial Intelligence 

Software System has won rave 

reviews from the critics: “...my 

first choice among typing pro- 

erams” (MacWorld); “...that rare 

kind of 

program 

that’s even 

better than 

the copy- 

writers say 

it 1s...” (Computer Shopper); 

“ ...one of the most visually 

exciting programs I’ve ever seen...” 

(PCM); “...the best dollar value 

around...” (PC Magazine). 

101657 $49.95 MAW 101616 $49.95 

101609 $39.95 (IES| 101610 $49.95 
101619 $49.95 [HEI 101612 $39.95 
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THE BOTTOM NE 
MAKE YOUR DOLLARS COUNT 

DOLLARS AND 
SENSE® 
Why go through the 

agony of balancing 

your budget every 

month when you 

can have a personal 

financial adviser 

do it instead? 

Dollars and Sense 

does that once 

abhorred job with 

ease. Since 1984, 

Dollars and Sense 

has been a leading 

financial 

management application for hundreds 

of thousands of home and small business 

budgets. With its icon interface, pull-down 

menus, and command keys, it gives you 

three ways to interact with the program — 

you can even create your own icon-based 

commands! 

Dollars and Sense manages all your 

accounts — bank accounts, credit cards, 

loans, investment accounts, even IRAs. 

Your computer can generate checks, 

automatically record income and 

expenses, help balance your check- 

book, and produce 

professional financial 

Graphical interface 1s easy 
— even fun — to use. 

statements. At tax 

time, prepare your 

finances quickly 

and easily with 

data conveniently 

accumulated by 

Dollars and Sense. 

Features include user-created icons, 

interactive running balances, custom 

check layout, a “set start-up” feature, 

adjustable fonts 

and column widths 

in reports, auto- 

matic double-entry 

accounting, a nine- 

level accounting 

hierarchy, sorting capability, and on-line 

help. ‘There are also new reports and 

eraphs, support of world and European 

date and amount formats, and quick and 

easy account reconciliation. 

DOLLARS AND SENSE 
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AROUND THE WORLD! 
THE SOFTWARE 
TOOLWORKS*® 
WORLD ATLAS 
Quick! Where’s 

Bhutan? What’s the 

population of Italy? 

he numberonc 

import of Iran? Or 

the military budget of 

Peru? Get fast answers with World 

Atlas — the almanac, world factbook and 

atlas in one. 
Designed for travelers, teachers, 

business people, and other curious minds, 

only World At/as gives you instant access to 

more than 200 fully detailed maps — 

including regions, countries, even oceans! 

—in the highest-resolution graphics 

available on an electronic atlas. Plus, a 

huge database of international information 
offers valuable facts on hundreds of topics. 

Now, in moments, 

you can research 

facts on: 

government, 

demographics, 

2 — climate, environ- 

ment, economic indicators and more! 

Explore the world. Get to know any 

country. It’s easy — and it’s fun. A single 

keystroke moves you from country to 

country, and a handy on-screen index 

offers a world of other fascinating facts. 

‘There’s even a CD-ROM version! 

“Compared to other packages in this 

category, Lhe Software Toolworks World 

Atlas is the winner.” — BYTE Magazine. 

(3.5") 106097 $69.95 |IBM] (5.25") 106073 $69.95 
$79.95 

$79.95 



TIME TABLE 
OF HISTORY: 
SCIENCE AND 
INNOVATION 
A complete multi- 

media chronology 

of scientific 

achievement, 

culled from 

over /) 

rererence 

works, all ona 

single compact 

disc! More than 

6000 fascinating 

stories, with key 

words linked for 

speedy naviga- 

tion. No search 

takes more than 

two seconds. 

110514 $129.95 

A fascinating timeline of 
scientific history. 

A multimedia encyclopedia of 
mammals of the world. 

MAMMALS 
It’s like walking through the best zoo on 
Earth, and it’s on CD-ROM. More than 

200 animals move across the screen 

includes 700 full-screen National 

Geographic photos, 150 worldwide regional 

maps, fascinating essays, 45 full-motion 

movie clips, and more. 

$149.95 

ENPLORE THE USA 
~. THE 
* SOFTWARE 

TOOLWORKS® 
U.S. ATLAS 
‘Travel from 

New York to 

Alaska to Paris, 

‘Texas, in the blink 

. of an eye (actually, 

the touch of a Key). 

U.S. Atlas puts the 

country at your 

fingertips, with 

a vast array of 

detailed reference 

maps. Plus every- 

thing you ever wanted to know about city, 

state, and U.S. geography, as well as 

people, education, health, government, 

economy, crime, agriculture, communica- 

tions, and travel. What’s more, both maps 

and text files can be exported to your 

desktop publishing or word processing 

documents. 

Roam from state to state 

until you know all 50! 

wnl ioaiie $5995 eliiosis 57995 

EAPLORE TT ALL! 
ATL 4 Sip ge 

ATLAS PACK ~~ 
Get both the U.S. 

Atlas and the 

World Atlas ina 

single package. 
For the true 

lover of information 

or geographile, this is a must! 

IBM] (3.5")104345 $109.95 [IBM (5.25") 104306 $109.95 

110507 $109.95 



TOOLWORKS" 
REFERENCE 

_ LIBRARY 
ET THE FACTS — ALL ThE FACTS 

THE NEW _ The world’s best 

GROLIER _ reference library 

ELECTRONIC now on one CD! 
ENCYCLOPEDIA” 

Whether you’re 

writing a paper, 

researching a topic, 

or simply curious, 

One keystroke 

gives you access 

to: The New York 

Public Library” 

Desk Reference, 

The New Groher 3 Webster’s New 

| Electronic Encyclopedia a peal § World” Thesaurus, 
sets a new standard mane : : Webster’s New 

forrescarch tools, World” Guide to 
On a single CD- and thousands of entries at_ Concise Writing, 

ROM disc you’ll ee: Webster’s New 

find more than cn World” Dictionary 

33,000 articles and as Ss s eee 1 hird College 

a see ep 2200 vivid color — Edition, The 
oving graphics an ; ane 

audio create a stirring graphics — Just Dictionary of 20th 

learning experience. light-speed away. : 2 Century History, 

oo 1K | asser’s™ Legal 
You may never have to and Corporation 
ask the reference e J; 

= librarian a question again. orms for t € 

TOOLWORKS Smaller Business, 15 

eofa DESK REFERENCE Webster's New World” Dictionary of Quotable 

A collection of the Definitions, and the National Directory of 

most frequently Addresses and Telephone Numbers®. 
sought information 

at the New York 

Public Library”. 

From who won the 

Oscar for Best 
say tinea Actress in 1933 

(Katherine Hepburn) 

to how many 

calories are burned 

in an hour of typing 

(110), it’s the ultimate, instant reference 

| for ideas, advice, details and discoveries. 

‘Twenty six subject areas and thousands of 

entries; and you don’t have to leaf through 

thousands of pages — you get your answer 

in a flash. 

110505 $69.95 

—— 

MOS21 379 95 
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SAVE MONEY 
WITH VA 

thrills: 

Life & Death, 

Bruce Lee Lives, Beyond the 

Black Hole, The Chessmaster 

2000 and Gin King/Cribbage 

King. For IBM CD or disk. 

100118 
10111 

A retail 

value of 

over $190! 

Mavts 

Beacon 

Teaches 

Typing! 

DOS Tutor, 

U.S. Atlas, and the Evelyn 

Wood Dynamic Reader: 

UE PACKS 

SEGA" 
ARCADE SMASH HITS 
Up to a $190 value! Our Run, 
After Burner, Shinobi, Thunder 

Blade and Alen Syndrome for 

IBM, Amiga or C64. 

GAME PAK | 
Buckle up for: 
Chuck Yeager’s 

Advanced 

Ehght Trainer, , 

Airplane i 

Factory, The 

Hunt for 

Red October, 

Chessmaster 2000, Life & 
Death. A $205 value. 


